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Bevezet?
A könyv célja, hogy segítsen megtenni a kezd? lépéseket kezd? tervez?knek, akik most ismerkednek csak a Chief Architect programmal. Nem az volt a
célunk, hogy a Súgó tartalmát másoljuk össze egy könyvbe, hanem hogy összefüggéseiben mutassuk be a Chief Architect (röviden CA) alapvet?
eszközeinek a használatát és alap filozófiáját. Ugyan rengetek valóban remek CA oktató videó érhet? el publikusan a különböz? videómegosztókon és
a CA saját weboldalán is, és tényleg nagyon magas min?ség? beépített súgó található a CA-ban, mégis összefüggéseiben megérteni a CA grafikus
interfészének és különböz? alap eszközeinek a m?ködését nem magától értet?d?. Az els? lépések megtételéhez kívánunk mankót nyújtani a kezd? CA
felhasználóknak a legfontosabb eszközök bemutatásával, összetett modellek elkészítésnek a leírásával, valamint tipikus hibajelenségek
magyarázatával.

A CA-ban az alapkoncepció teljesen más mint az AutoCAD-ben. A CA szoftvert arra találták ki, hogy lakóépületeket tervezzünk benne, nem egy
univerzális CAD tervez? program. (Computer-Aided Design). Nagy különbség az AutoCAD programhoz képest, hogy a renderelt, mozgatható 3D modell
alapértelmezetten el?áll, nem úgy mint AutoCAD-ben, ahol a modellr?l külön tudunk 2D-s renderelt képeket el?állítani. A szoftver minden porcikája
épület tervezésre van kitalálva. Nem épületeket hanem pl. mechanikus gépeket, járm?veket nem lenne lehetetlen benn tervezni, de nagyon nem lenne
praktikus.
F?bb jellemz?k:

BIM (Building Information Modelling) alapú építészeti tervez? program.• 
A 3D modell alapértelmezetten el?áll• 
A szokványos tervrajz formák el?állításra van kihegyezve: floor plan, elevations, sections, site plan, roof plan, ceiling plan, framing plan.• 
Nagyon gazdag a beépített kiegészít?k könyvtára. Nagyon sokféle épít?anyag, bútor, és egyéb kiegészít?k is megtalálhatók benne.• 
El?állítja kapásból a tet?, a födém és a falak váztervét is favázas illetve fémvázas épületek estében.• 
Képes kiszámolni pontosan és tételesen, hogy mennyi épít?anyagra van szükség az utolsó kilincsig.• 

Véleményem szerint a CA egy fantasztikus családi ház tervez? szoftver, aminek a tanulási görbéje messze nem olyan meredek, mint a
versenytársainak (Autodesk-Revit, IBM-Archicad, AutoCAD-Architecture), ugyanakkor családi ház, és egy két szintes kereskedelmi épületek
tervezésében verhetetlen!

A Chief Architect programcsaládnak három változata létezik, melyek nagyban hasonlítanak egymáshoz:

Chief Architect Premier: A Premier szoftver a zászlóshajója a CA termékeknek, ez a teljes érték? tervez? szoftver, mely a CA teljes
funkcionalitását tartalmazza. Els?sorban építészmérnököknek készült professzionális felhasználásra.

• 

Chief Architect Interior: A CA termékcsalád egy olyan változata, ami kifejezetten a bels? design elkészítéséhez szükséges eszközkészletet
tartalmazza csak. Els?sorban bels? építészek számára készült.

• 

Home designer: A Premier egy egyszer?sített változata, ami els?sorban a "Csináld Magad Mozgalom" (DIY) tagjainak készült, olyan lelkes
amat?röknek, akik maguk szeretnénk megtervezni a házukat, de nincs szükségük a Premier teljes funkcionalitására. A Premier és a Home
Designer között van átjárás, kompatibilisek egymással a fájlformátumaik.

• 

Ebben a könyvben kizárólag a Chief Architect Premier szoftvercsomag X12 és X13-as változatával fogunk foglalkozni. (A könyv írásának
befejezésekor jelent meg az X13-as verzió) Ett?l újabb és régebbi változatok használatának megismerését is nagyban támogathatja könyv, hiszen az
egyes verziók között az eltérés sosem fundamentális, az alapkoncepció nem változik.

BIM vagy CAD
https://www.youtube.com/watch?v=bEwLTYN56zE

A BIM és a CAD rövidítésekkel gyakran találkozunk számítógépes tervez? programok esetén. El?járóban elmondhatjuk, hogy a Chief Architect, a
versenytársaihoz hasonlóan egy CAD alapú BIM tervez?program. De mit is jelentenek ezek a kifejezések:

https://www.youtube.com/watch?v=bEwLTYN56zE


CAD (Computer-Aided Design): 2D vagy 3D számítógépes modellezést támogató rendszer. A tér vonalakból, és egyszer? geometriai
formákból épül fel (téglatest, kocka, kúp, háromszög, stb.). Az egyes elemek a modellben nem épít?ipari épít?kockák, nem rendelkeznek
specifikus építészeti tulajdonságokkal és paraméterekkel, pusztán geometriai tulajdonságaik vannak. Pl. egy ablakot reprezentáló modell
téglatestekb?l és téglalapokból épül fel, de ezen geometriai formák összességét nem tekinti a program ablaknak, nem rendelkezik egy ablak
paramétereivel, mint pl az ablakkeret anyaga, az ablak üvegezése, U értéke, vagy gyártója. Tehát a program számára az ablak nem jelenik
meg mint építészeti épít?kocka.

• 

BIM (Building Information Modelling): A BIM a CAD-re épül? épít?ipari rendszer. A CAD-el ellentétben, a BIM tervez?programokban
minden a modell térbe helyezett tárgy építészeti tulajdonsággal van felruházva. Pl egy ablakról tudja a program hogy az egy ablak,
rendelkezik egy ablak összes paraméterével és tulajdonságágával. Pl. az üvegesé fajtája, a plafontól való távolsága, az ablak gyártója,
párkány típusa, és így tovább. Ha az egész modellt BIM komponensekb?l állítjuk össze, akkor a program automatikusan ki tudja nekünk
generálni az anyaglistát, és egy olyan részletes terv dokumentációt, ami alapján az épület már megépíthet?. Egy BIM szoftverben minden
speciális tulajdonságokkal bír. Pl. a CA-ban egy konyhának megjelölt helyiség esetében a CA tudni fogja, hogy az aktuális szabványoknak
megfelel?en pontosan milyen magasra és a szoba milyen pontjaira kell konnektorokat és villanykapcsolókat kiosztania.

• 

Tekintsük az alábbi két alaprajzot:

A bal oldali alaprajz CAD vonalakból készült terv. A program számára az alaprajz pusztán vonalak összessége, amik egy téglalapot alkotnak. Ha
megnyitjuk a falat alkotó vonalak tulajdonságait, láthatjuk, hogy azok pusztán geometriai vonalak:

Ha viszont most megnyitjuk a baloldali alaprajzon egy falszakasz beállításait, akkor láthatjuk, hogy a CA tudja, hogy ez egy fal típusú objektum, ami
100-as nagyságrend? beállítással rendelkezik, kezdve a magasságtól, a rétegrenden át a felette lév? tet? tulajdonságáig.

CA-ban minden BIM komponens nagyon széleskör? beállításokkal rendelkezik. Minden BIM komponensb?l készült tárgy meg fog jelenni a részletes
anyag listában az anyagnak megfelel? mértékegységben, ami lehet tábla, négyzetméter, köbméter, stb. Tárgyakat el?állíthatunk "hagyományos"
módodon is 3D-s geometriai formákból, azonban ezek nem fognak értelemszer?en megjelenni az anyag listában.

A CA-ban van egy beépített CAD menü, ami a 2D CAD eszköztárat tartalmazza.
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Ezen eszközök segítségével els?sorban 2D-s részletrajzokat készíthetni, illetve a metszetekb?l készült 2D-s rajzokat fejleszthetjük velük tovább, ahogy
ezt majd látni fogjuk kés?bbi fejezetekben.

Ismerkedés a Chief Architect-el
Ebben a fejezetben röviden át fogjuk tekinteni a CA felületi elemeit, alap fogalmait, aminek az alapszint? ismerete elengedhetetlen a program
gördülékeny használatához. Fontos, hogy többek között megértsük a CA-ban használt 'View' (nézet), 'Layer' (réteg) és 'Layer set' (réteg csoport)
fogalmakat, melyek némiképp különböznek a "tradicionálisnak" mondható AutoCAD terminológiától. Ezen fejezet elolvasása után már a CA oldalán
elérhet? oktató videók is sokkal könnyebben megérthet?k lesznek, ha már érteni fogjuk a különböz? komponensek közötti összefüggéseket.

GUI áttekintése
A kezel? felület els? ránézésre sokkal egyszer?bbnek t?nhet, mint amit az AutoCad-ben vagy más CAD tervez? programokban megszokhattunk. De ez
ne tántorítson el minket. Ennek ellenére egy nagyon kifinomult, sokoldalú lakóház és kisebb, pár szintes kereskedelmi épülettervez? programmal állunk
szemben. A tanulási görbéje lényegesen laposabb, mint a konkurens tervez?programoké, így sokkal kisebb id?befektetéssel már el? tudunk állítani
egyszer?bb terveket. Persze az ördög itt is a részletekben rejlik, a bonyoult, összetett modellek készítése már a CA-ban sem magától érthetöd? feladat,
gördülékenyen akkor fogunk csak tudni dolgozni a kezel?felületen, ha megismerjük a programban rejl? összes lehet?séget. Ahogy más tervez?
programokban, úgy a CA-ban sincs mindenre beépített megoldás. Viszont ha ismerjük a GUI összes csiníját bínját, akkor már csípöb?l tudhatjuk a
kerül? megoldásokat, limitációkat, anélkül, hogy értékes órákat veszítenénk a keresgéléssel.

Modellt?l a tervrajzig

CA-ban minden projekt alapja a 'plan', vagyis a terv, amiket a *.plan kiterjesztés? fájlokban tárol a program. Egy plan fájl egy épületnek a komplett 3D
modellje, tehát nem tartalmazza a kinyomtatható tervdokumentációt. Egy *.plan fájl felfogható a modelltérnek az AutoCad-ben. Amikor a 3D-s modellünk
elkészült, akkor annak a kiválasztott nézeteib?l létre tudjuk hozni a kinyomtatható, méretarányos tervdokumentációt, CA terminológiával a 'layout'-ot
(elrendezést). A tervdokumentációkat (annak minden oldalával és borítójával együtt) a *.layout kiterjesztés? fájlokban tárolja a CA. A 'layout'
(elrendezés) az AutoCAD-ben a papírtérnek feleltethet? meg. Egyszerre mindig egy adott *.plan fájlon dolgozunk (modell tér). Ha kész vagyunk a model
elkészítésével, akkor a modellb?l képezett 2D-s vagy 2D-re vetített nézeteit el tudjuk küldeni az éppen aktív méretarányos tervdokumentáció (layout) a
megfelel? oldalára, vagyis a 3D modellt leképezzük két dimenzióra a tervrajzon, ahol a modell már nem szerkeszthet?, kvázi képként kezeli a layout.
Azért csak kvázi kép, mert ha a modellen módosítunk a *.plan-ben, akkor képes frissíteni automatikusan a nézetet is a *.layout -ban, ahogy ezt majd
látni fogjuk. A plan fájl a 3d-s modellen kívül tartalmaz még 2 dimenziós metszeteket, homlokzati nézeteket, 3D-s kamera képeket és CAD
részletrajzokat is.

https://www.youtube.com/watch?v=8B9VBrObzqs Az alábbi ábrán a 'plan' és a 'layout' fájlok kapcsolata látható:
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A plan fájl tartalmazza a modelltér összes elmentett nézetét (kés?bb ezeket részletesen tárgyaljuk), tartalmazza a modellhez készített CAD
részletrajzokat, metszeteket, azonban a tervdokumentációs fájllal (layout) csak lazán csatol kapcsolata van.

Egyszerre több plan és több layout fájl is nyitva lehet a CA-ban (Chief Architect), ekkor egyikr?l tudunk a másikra másolni. Ezek mind külön fülön fognak
megjelenni a programban, ahogy ezt az alábbi képerny?képen is láthatjuk (pirossal bekeretezve).

Egy plan-b?l több layout-ba is küldhetünk "képeket" (nézeteket), ábrákat, és egy layout-ot több plan-b?l is összeállíthatunk, de tipikusan egy plan-hez
egy layout-ot szoktunk gyártani, különben nagyon hamar el lehet veszíteni a fonalat, hogy melyik layout oldal pontosan melyik tervb?l jött. A layout és a
hozzá tartozó plan fájlok között lazán csatolt kapcsolat van. Ha a tervdokumentációban (layout) rákattintunk egy olyan ábrára/nézetre ami egy plan
fájlból lett a 'layout'-ba küldve, akkor a CA meg fogja nyitni az ábrához/nézethez tartozó 'plan' fájlt, és azon belül a kiválasztott nézetet/ábrát. A
kapcsolat visszafelé is él, ha egy olyan nézetet/ábrát módosítunk egy 'plan' fájlban, amit már elküldtünk egy 'layout'-ba (vagyis már szerepel egy
tervdokumentáció valamelyik oldalán), akkor a nézet/ábra a 'layout' fájlban is módosulni fog (ez nem kötelez?en van így, beállítás kérdése).

A könyv nagyon nagy részében (egy fejezetet leszámítva) a 3D modell, vagyis a 'plan' létrehozásával fogunk részletesen foglalkozni. A
tervdokumentáció (layout) elkészítésének (csak) egy dedikált fejezetet szenteltünk. Ugyanis a munka nagy része a modell létrehozása, a kész modellb?l
már nagyon gyorsan lehet ábrákat készíteni a tervdokumentációhoz. Ennek megfelel?en a CA-ban az eszközök túlnyomó többsége a modell
kialakításához, manipulációjához készült. Ez nem jelenti azt, hogy ne lehetne jelent?s id?t eltölteni a tervdokumentáció (layout) szövegezésével,
részletes leírások készítésével, de ez nem igényel különösebb CA specifikus ismereteket.

A grafikus interfész elemeit

View vagyis nézet választó. Az alapértelmezett munkatér, ahol az épületet els?sorban me kell rajzolni, a Workin Plan View. A nézet választó
valójában el?re definiált módon ki be kapcsolja, illetve átdefiniálja a különböz? réteg beállításokat.

1. 

F?menü Eszköztár. Ezekben vannak a beépített épít? eszközök. Mindegyik tartalmaz almenüket is, lásd lentebb2. 
Egy kiválasztott f?menü eszköztárban található eszközök. Pl ha a képen a falak eszközök vannak kiválasztva, itt választhatunk a különböz?
fal alkategóriák közül.

3. 

A munkaterületen már létrehozott és kiválasztott objektum manipulációs eszközei. Vannak alap manipulációs eszközök, amik minden
objektum típusnál megjelennek és vannak amik csak egy adott objektum típusra jellemz?ek, pl falak esetében falakat kapcsolhatunk össze a
"Connect Walls" eszközzel.

4. 

Szintek kiválasztása. Bármilyen view-ban vagy 3D-s nézetben is legyünk, itt lehet kiválasztani, hogy melyik szintet lássuk. Alapértelmezetten
az 1-es szinten vagyunk. Az "A" (Attic) a padlás, míg a 0-ás szint az alaksor.

5. 

Project browser: Az összes megnyitott plan és layout itt látható és azok épít?elemei, pl layout estén az oldalak, vagy pl. plan esetén a CAD
rajzok és view-k.

6. 

7. 
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Nézetek a CA-ban

A CA-ban a tervezés központja nem egy központi 3D-s nézete a modellnek, ahogy azt más tervez?programokban, mint pl. az AutoCAD-ben
megszokhattuk. AutoCAD esetében valójában egy nézet van, és mi csak néz?pontot választunk egy néz?pont választó kocka segítségével. A nézetek
nem különülnek el egymástól, a modellt mindig egy bizonyos oldalról, 2D-ben vagy 3D-ben látjuk, az aktuálisan kiválasztott megjelenítési módon
(drótváz, részletes modell, stb). Ezzel ellentétben a CA-ban úgynevezett nézetek (View) vannak. A beépített nézet típusok közül kell kiválasztani, hogy
milyen módon szeretnénk megjeleníteni/szerkeszteni a modellt. Vannak 2D-s és 3D-s nézetek is, mindegyik típus speciális feladatot lát el. A 2D-s
nézetek között a legfontosabb a tervez?i alaprajz nézet, ahol az épület alaprajza jelenik meg felülnézetben (Plan veiw). Ez az alapértelmezett
megjelenítése a modellnek. Mikor megnyitunk egy 'plan' fájlt, akkor az épület 2D-s alaprajzi nézete nyílik meg azon a szinten ahol a tervezést
befejeztük. A 2D-s tervez?i nézet (Plan view) nem egy metszeti képe a modellnek, ami a padlószintre van pozicionálva, nem tudjuk le-fell mozgatni
vertikálisan a kamerát. Ezek ténylegesen alaprajzi nézetei az épület különböz? szintjeinek, ahol a tervezés nagy része történik. Léteznek speciális 3D-s
kamera nézetek is, ahol a modellt mozgatható 3D-s térben jeleníti meg a CA (a nézetnek megfelel? megjelenítési móddal). Minden nézet egy külön
fülön nyílik meg a CA-ban, tehát az AutoCAD-el ellentétben nem csak néz?pontot váltunk. A fülön megjelen? ikon jelzi hogy, milyen típusú nézetet
nyitottunk meg. Tekintsük át röviden, hogy milyen 2D és 3D nézetei érhet?k el a CA-ban egy modellnek:

Plan view• 
3D Camera view• 
Cross Section• 
CAD Detail• 
Wall Detail• 
Truss Detail• 
Reference Display• 
Schedules• 
Material List• 

Az itt leírt nézetek mind a 'plan' fájl részét alkotják (modell tér). A 'layout' fájl, ami a méretarányos tervdokumentációt jelképezi (papír tér) csak egy
nézetet tartalmaz, nem tartoznak hozzá speciális nézetek, a layout fájlban mindig a tervdokumentáció egyes oldalait tudjuk szerkeszteni.

plan veiw: Az úgynevezett tervrajz nézet (plan view) a tervezés alap nézete. Ennek az ikonja minden fülön az alábbi:  Ebben fogjuk a legtöbb id?t
tölteni a terv elkészítése során. Ez egy hagyományos 2D felülnézeti tervrajz nézet, ahogy ezt a neve is mutatja. Egy 'plan' fájl megnyitása után
automatikusan a tervraj nézet (plan view) jelenik meg. A tervraj nagy részét ezekben a 2D-s felülnézeti tervraj nézetekben készítjük el.
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Láthatjuk, hogy külön füleken egy tervrajz több nézete is nyitva lehet. Akár különböz? 'plan view'-k, és különböz? 3D-s nézetek és kamera képek is. A
'plan view'-kat el lehet menteni a CA-ban. Az elmentett 'plan veiw'-k koncepciójának megértése és hatékony kezelése nagyon fontos a hatékony
munkavégzéshez a CA-ban. Az elmentett 'plan view'-kkal (saved plan veiw) részletesen fogunk foglalkozni a könyvben.

3D Camera view A 2D-s 'plan view'-ban elkészített modellt meg tudjuk tekinteni különböz? 3 dimenziós nézetekben is. 3D-s kamere képet többféle
képen is készíthetünk. Léteznek ortografikus és perspektívikus 3 dimenziós nézetek. Az ortografikus nézetek nem életh?ek, de cserébe sokkal kisebb a
számításigényük, komplex és nagy 3d-s modelleket könnyebben tudunk forgatni, mozgatni ortografikus nézetekben. A 3 dimenziós nézeteket a
legegyszer?bben a '3D' f?menü 'Create Orthographic View' és 'Create perspectivic view' menüpontjaiban készíthetünk.

A 3D-s nézetek ikonja a fels? füleken mindig egy kis fényképez?gép: 

Az alábbi képen a 'Perspective full overview' nézetet láthatjuk. A 3D-s nézetek létrehozásakor automatikusan megnyílik a 'Move camera with Mouse'
eszközkészelt, ami a baloldali eszközsávban jelenik meg. Az itt található eszközök segítségével tudjuk forgatni a 3D-s nézeteket.
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A 3D-s nézetek is a 2D tervez? nézetekhez hasonlóan BIM (Building Information Modelling) képesek. Tehát itt is meg tudjuk nyitni az építészeti
objektumok beállításait és újakat is el tudunk helyezni a modelltérbe. A 3D-s kamera nézeteknek speciális esetei a 'Framing overview' és a 'Floor
overview', ahol a modell egyes elemei el vannak tüntetve. 'Framing overview'-ban csak a kigenerált vázszerkezet látszik, míg a 'Floor overview'-ban
csak az egyes szintek látszanak födém nélkül. Ezek léteznek mint ortografikus, mind perspektivikus nézetekben is. A 3D-s kamera nézetek közül
bizonyosakat csak a 2D-s tervez? nézetekben (plan view) tudunk elindítani, mint pl. a 'Full camera view'.

Cross Section Metszeteket (cross section) a 2D tervez? nézetekben hozhatunk létre a 'Create Orthographic View' -> 'Cross section/Elevation'

eszközzel. A metszeti és homlokzati nézetek ikonja a füleken mindig egy kis házikó:  A metszetek olyan speciális 2D nézetek, ahol BIM (Building
Information Modelling) szintén értelmezett, tehát a metszeten akár teljes egészében, akár elmetszve megjelen? építészeti objektumokat ki tudjuk jelölni,
azok tulajdonságait tudjuk módosítani.

A metszeteknek sokféle változata létezik. Korlátozhatjuk mélységben és szélességben is a vágást, ráadásul nem kell hogy egy síkban legyen a teljes
metszeti vonal. A metszetekr?l is részletesen olvashatunk kés?bbi fejezetekben.

Elevation view A homlokzati nézetek (Elevation) speciális metszetek a CA-ban. Ugyan úgy a 'Create Orthographic View' -> 'Cross section/Elevation'
eszközzel kell ?ket el?állítani mint a metszeteket azzal a különbséggel, hogy a metszeti vonal párhuzamos valamelyik homlokzattal, és nem metszi

sehol az épületet. A fülön megjelen? kis ikon megegyezik a metszeteknél látott kis kék házikóval: 
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A homlokzati nézeteknek van egy speciális típusa, az úgynevezett fali homlokzati nézet (Wall Elevation).

A fali homlokzati nézetet szintén a 2D-s 'plan-view'-n tudjuk létrehozni, de kizárólag bels? helyiségek falaira, olyan helyiségekben, amit egy plafon és
egy padló határol:
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A fali homlokzati nézet nagyon hasznos a bútorok elhelyezése közben. Mivel minden homlokzati nézet a metszeti nézet speciális esetei, ezért
természetesen itt is értelmezett a BIM (Building Information Modelling)

CAD Detail A CAD részletrajzok (Computer-Aided Design) a CA-ban olyan 2 dimenziós ábrák, amiket 2 dimenziós nézetekb?l hozhatunk létre, vagy

nulláról magunk is elkészíthetjük ?ket. A CAD rajzok ikonja a füleken egy kék tet? metszet:  A CAD rajzok a tervel nincsenek összeköttetésben, itt a
BIM (Building Information Modelling) nem értelmezett, miden alap geometriai formákból épül fel, ha egy olyan tervrajz nézet módosul, amib?l a CAD
rajzot létrehoztuk, az nem lesz hatással a CAD rajzra. CAD rajzokat a tervrajz olyan pontjaihoz szoktunk készíteni, amik extra magyarázatot kívánnak,
olyan részleteket, amiket a BIM modellek már nem tartalmaznak.
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A CAD rajzok készítéséhez külön 2 dimenziós eszközkészletet biztosít a CA, ahol az alap geometria primitíveken ívül néhány építészeti jelölést is
automatikusan el tudunk készíteni, mint pl. különböz? sraffozások és szigetelések jelölése. A CAD részletrajzokon elhelyezhetünk a CA 'library'-ban
el?regyártott CAD rajzokat is, amiket tetszés szerint módosíthatunk. A beépített CA könyvtárban több tucat tipikus CAD részletrajz közül válogathatunk:

CAD kiegészítéseket elhelyezhetünk a 2 dimenziós metszeti és homlokzati nézeteken is. Ezek a CAD blokkok csak az adott metszeten fognak
megjelenni, a 3D-s modellben nem.
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Wall Detail A fal részetek nézet (Wall details) egy olyan speciális nézet, amit kifejezetten vázszerkezetes épületekhez használhatunk a CA-ban. A 'Wall
detail' nézetben az egyes falak részletes váz tervét nézhetjük meg. A fal részletrajzokat a CA minden falhoz automatikusan legenerálja mikor elkészítjük

az épület vázszerkezetét. A fal részlet jajzok ikonja az alábbi:  A fal részletrajzok olyan speciális nézetek, ahol mindig csak az éppen kiválasztott
fal vázszerkezetét tekinthetjük meg, szerkeszthetjük vagy helyezhetünk el rajta dimenzió vonalakat.

A fal részletrajzok az úgynevezett 'Project Browser'-ben is külön kategóriaként megjelennek, é A fal részletrajzokat meg lehet nyitni a 2D-s tervez?
nézetekb?l is a kiválasztott falszakaszhoz tartozó almenübeb?l, vagy a 'Project Browser'-b?l is, ahol a fal részletjrazok emeletre lebontva vannak
felsorolva:
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Truss Detail A 'Truss detail' vagyis rácsos tartó részletes nézet a fal részletek nézethez nagyon hasonló részletrajz, kifejezetten a tet? rácsos tartóinak
megjelenítésére. A CA a fal vázszerkezethez hasonlóan ki tudja generálni a tet?höz szükséges összes rácsos tartót is félig meddig automatikusan. A
CA magától képes meghatározni a rácsos tartó formáját és vázszerkezetét a tet? egy adott pontján, de a megfelel? kiosztásról már nekünk kell
gondoskodni. Amennyiben a tervrajz nem tartalmaz rácsos tartókat, ez a nézet nem lesz el?hívható. A fal részletrajzokkal szemben, ahol minden egyes
fal szakaszhoz külön 'Wall Detail' tartozik, a rácsos tartó (Truss Detail) részletrajzokkal csak egyetlen egy van minden egyes tervrajzban, amire az
összes a tervben el?forduló 'truss' megjelenik beszámozva.

Reference Display A Referencia nézet (Reference display) nem egy valódi nézet az el?z?ekben bemutatott nézetekt?l elér?en, pusztán egy segéd
nézet, aminek a segítségével a 2D tervrajz nézetre rá tudunk vetíteni alsó vagy fels? szintek kontúrjait, vagy akár más tervrajzoktól átemelt részleteket.
A Referencia nézet megkönnyíti az aktuális szint tervezését, mivel tervezés közben láthatjuk hogy pontosan mi van az adott szint alatt vagy felett.
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A fenti ábrán az alsó szint referencia nézete van bekapcsolva (piros vonalakkal megjelenítve), így láthatjuk, hogy az 'Office' névvel megjelölt szoba alatt
egy mosdó található. A referencia nézet meglév? épületek átalakításánál is nagyon hasznos lehet, ha az új tervrajzra rávetítjük a jelenlegi épület
korvonalait.

Schedules ...TODO...

Material List ...TODO...

Project Browser

A tervezési folyamatnak fontos sarokköve az úgynevezett 'Project Browser' vagyis a projekt áttekint?. A 'Project Browser'-ben egy fa szerkezetben
láthatjuk a 'Plan'-ek (tervrajzok) és a 'Layout'-ok (elrendezések) összes elemét. A 'Project Browser'-t a jobboldali

Egyszerre több 'plan' és 'layout' is meg lehet nyitva a CA-ban és a 'Project Browser'-ban az összes megnyitott 'plan' és 'layout' látható. Mind a
'plan'-eknek és 'layout'-okank megvan a saját mappa struktúrája.

Fontos, hogy a 'Project Browser-ben' felsorolt mappák az operációs rendszer fájlrendszer szintjén nem léteznek, ezek a 'plan' illetve a 'layout' fájlok
részei. Ezekbe a virtuális mappákba a CA automatikusan, típus szerint rakja be az elmentett nézeteket, táblázatokat, fal és tet? vázszerkezet rajzokat,
valamint a különböz? CAD részletrajzokat, nem mi döntjük el, hogy mi hova kerül. Minden plan be az alábbi virtuális mappa rendszer található meg.

CAD details• 
Cameras: A CA-bn több féle kamera kép• 
Cross sections:• 
Floor levels:• 
Plan views:• 
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Schedules: Ide kerül az ablak, ajtó, szoba és más schedul-ok, amiket automatikusan legenárlunk a programmal.• 
Wall details: Ha már van framing terv is az épülethez (lásd lentebb) akkor itt egyenként minden egyes fal framing tervét meg tudjuk nézni, és
módosítani tudjuk.

• 

Készítsünk egy egyszer? tervrajzot
Már tudunk annyit, hogy készíthessünk egy egyszer? 3D-s modellt és megnézzük rajta, amiket már megtanultunk. ...

Alapm?veletek objektumokon
Miel?tt nagyon belemennénk a CA méllyére, tekintsük át a CA legfontosabb alapm?veleteit. Aki most kezdi az simserekdeést annak sokkal nagyobb
szüksége lesz erre az els? napokban mint sem, hgoy értes hogy mi az a 'saved view'. Azt ráér megtanulni. De mozgatás, forgatás, átméretez a legels?
amire szükésgünk lehet. 2D-ben rajzoljuk meg amit csak lehet és ha kell metszeti képeken mozgatjuk a helyére vagy 3D-ben.

Elemek mozgatása, átméretezése
TODO: mindig diemnziók -al lehet mozgatni. Vagy van olyna mi automatica jeó nekünk, vagy mi veszünk fel újat. B megoldás: point to point move.

C: temporary point: https://www.chiefarchitect.com/support/article/KB-01031/positioning-a-cad-block-with-accuracy.html

Objektum rajzolás pontos mérettel

Miközben valamelyik nézetben rajzoljuk az objektumot, amíg lenyomva tartjuk a bal egérgombot, nyomjuk meg a TAB-ot:

Ekkor meg fog jelenni az Enter coordinates dialógus.

Itt pontosan be lehet írni az adott objektum méretét relatív és abszolút is.

Objektum szabad mozgatása két tengely mentén

Bármilyen nézetben is vagyunk, ha a mozgatás megkezdésekor, vagyis mikor az egeret a kijelölt objektum közepén lév? négyzet fölé visszük, és az
egér négy nyíllá változik és bal egérrel elkezdjük mozgatni:

Akkor ha lenyomjuk mellé a Ctrl-t is akkor szabadon mozoghat minden irányban annak ellenére hogy mindenféle 'Snap' be lehet kapcsolva.
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Objektum átméretezése pontos méretre

Ha van kijelölt objektumot elkezdünk átméretezni, amíg az egér le van nyomva, ha megnyomjuk a TAB-ot, akkor akár csak az új rajzolásakor megnyílik
az 'Enter coordinates' dialógus:

Deck mozgatása falhoz képest

Az alábbi képen van egy deck egy fal mellett és a deck-et akarjuk a falhoz képest kijjebb mozgatni:

Ehhez zummoljunk plan view-ban a fal-deck találkozásra, majd húzzunk be egy 'Point to Point dimension'-t:

Majd jelöljük ki a deck-et alkotó 'Room divider' típusú odalát a deck-nek. Mozgassuk az egeret a dimension száma fölé, ekkor kis kezecskévé változik,
jelezve, hogy át lehet írni. Ha ezt itt átírjuk 10-re, akkor a falhoz képest fogja a deck falát elmozgatni. Tehát mindig az aktív elemet mozgatja el a nem
aktív elemhez képest, amik között a dimension vonal van.

Elem másolása és mozgatása

Minden elemet ha ki van jelölve, akkor az alsó menüben lév? 'Transform / Replicate object' ( ) eszközzel másolhatunk le illetve mozgathatunk el az
összes tengely mentén pontos számokat megadva.
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A megnyíló dialógusban egyszerre tudjuk másolni mozgatni, átméretezni és tükrözni az objektumot, attól függ melyik lehet?ségeket pipáljuk be, akár
mindet lehet egyszerre akár több példányban is.

A fenti téglalap esetében bejelöltük hogy 3 másolatot csináljon amiket mozdítson el mindig az el?z?höz képest 400mm-el. A végeredmény az alábbi:

Többszöri másolat készítése (Multiple copy)

Van egy külön eszköz is ami kifejezetten a többszöri másolat készítésére szolgál, ez szintén az alsó menüben érhet? el az elem kijelölése után.

'Multiple copy' ( )

Ha rákattintunk és a kiválasztott objektum fölé visszük az egeret, akkor megjelenik a 'Multiple copy' ikonja a tárgy fölött jelezve, hogy indulhat a tömeges
másolás. A kattintás után amelyik tengely mentén (akár átlóban is) elkezdjük húzni az egeret úgy hogy lenyomva tartjuk elkezdi egyenletes
távolságokban a beállításoknak megfelel?en a másolatok legyártását.

A kiosztási távolságot a Multiple Copy alsó almenüjében nyithatjuk meg a középs? ikonnal: 

Ez annyival több mint a 'Transform/Replicate object' hogy itt külön objektum típusonként be tudunk állítani távolságokat (mondjuk egyszer a projekt
elején) és attól függ?en hogy milyen elemr?l csinálunk egyenletesen elosztott másolatokat, a beállításoknak megfelel?en fogja kiosztani a másolatok
közti távolságot.
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Láthatjuk, hogy van egy általános (General object) típus, ami nagyjából megegyezik a 'Transform/Replicate object' eszköz 'Copy' funkciójával, csak így
gyorsabb. Ezen felül külön van Truss, rafter, beam és wall studs.

Az 'Alternate behavior / Secondary offset ) nem túl fontos. Bizonyos funkcióknak vannak alternatív beállításai, és ha alternatív módba kapcsolunk akkor
mindig az alternatív beállítások lépnek életbe, nem hiszem hogy ennek sok értelme van. Az alternatív üzemmódot az 'Edit -> Edit behaviors -> Alternate'
menüpontjában kapcsolhatjuk ki és be.

Point to Point Move

Egy objektumot úgy tudunk egy adott síkon elmozdítani, hogy pontját precízen egy másik objektum pontjához mozgatjuk. Ehhez válasszuk kijelölt

objektum esetében a 'Point to point move' ( ) eszközt az alsó menüb?l. Ekkor ki tudjuk választani a mozgatni kívánt objektum egy pontját (A
jelölés), majd kattintsunk:

Ezután ki kell választani egy küls? objektum egy pontját (B jelölés)

Majd kattintsunk. Ekkor a kiválasztott pont mentén fogja elmozdítani az els? objektumot:
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Rotate around custom point

Elemeket el lehet forgatni a mellettük lév? kis háromszöggel, ahol ha felé visszük az egeret, akkor kör nyíllá változik:

Vagy el tudjuk forgatni ?ket a pontos fokot megadva az alsó menü 'Transform/Replica object' ( ) eszközzel:

Bármelyik módszert is használnánk, alapértelmezés szerint a CAD objektum középpontját fogja tengelynek használni. Lehet?ség van custom pont
megadására is a forgatáshoz. A custom középpont használatát az 'Edit -> Edit behaviour -> Rotate/Resize around current point' menüpontban lehet
bekapcsolni. Ha be van kapcsolva, akkor az egérmutató megváltozik egy kis dobozra nyíllal, jelezve, hogy be van kapcsolva a funkció:

Custom pontot a fels? toolbar 'Point tools' ( ) -ban lév? 'Place Point'-al adhatunk hozzá

( )

Rakjuk le valahova a pontot, ekkor ott meg fog jelenni egy kis X. Innent?l kezdve minden objektum ekörül fog elforogni. Ha több ilyen is van, akkor az
fog számítani, ami közelebb van hozzá:

Point to point resize

Képek (Picture típus) esetén lehet?ség van két pont mentén átméretezni a képet. Mikor beszúrunk egy képet akkor annak a modellhez képest véletlen a
mérete, attól függ mennyire vagyunk bele-zummolva a nézetbe. Ha van a képen két biztos pont, aminek a távolságát ismerjük (pl alaprajzok esetén
ismerjük a rajzon lév? oldalak hosszát) akkor azok mentén át lehet méretezni a képet akkorára, hogy tökéletesen illeszkedjen a modell térbe. CSAK
PICTURE TÍPUSRA M?KÖDIK!! Kijelölünk két tetsz?leges pontot a képen, és megmondjuk a CA-nak hogy az a két pont milyen messze legyen
egymástól, majd arányosan módosítani fogja a kép méretet.

Warning
Fontos, hogy a 'Point to point resize'-t csak addig lehet elvégezni, amíg nem változtatunk a kép méretén vagy nem forgatjuk el, utána már fals méreteket
ad

Szúrjunk be COPY-PAST -al egy képet valamelyik plan view-ba. A képen egy telek térkép részlet látható. Válasszuk az 'Picture' típust:
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Láthatjuk, hogy az összes oldal mérete ismert. Most jelöljük ki a képet, majd az alsó menüben válasszuk ki a 'Point to Point resize' ( ) eszközt.
Ekkor az egér mutató egy 'A' bet?re változik, amivel ki kell jelölni az átméretezésre használt szakasz els? pontját.

 Ez lehet a képen rajza, de egy tetsz?leges vonal valamelyik vége is lehet. Viszont csak
derékszögbe tud mozogni ez az átméretez? vonal, így ha a képen a két pont nem egy vonalban van, ahogy a fenti képen is, akkor els?re készíteni kell
egy segéd vonalat, ami a referenciát fogja adni.

Rajzoljunk a telek rajz valamelyik két sara között egy CAD vonalat:

Majd nyissuk meg a vonal beállításait, és a 'Line' fülön az 'Angle'-t állítsuk 0-ra, hogy ezzel vízszintes vonalat kapjunk, amin már jó referencia lesz az
átméretezésre:
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Most jelöljük ki a képet, és kattintsunk a 'Point to point resize' eszközre és az 'A' jellel kattintsunk a vonal egyik végére, ekkor 'B'-er módosul az
egérmutató, kattintsunk a vízszintes vonal másik végére, ekkor el?áll a referencia vonal és megnyílik a méretet beállító abalak:

Itt írjuk be a pontos, kívánt távolságát a két pontnak. A tervrajzról tudjuk, hogy ez pontosan 34.06 méter. Írjuk be hogy: '34.06 m', majd pipáljuk be hogy
'Retain aspect ratio', és OK. Ekkor a kép pont akkora lesz, hogy a két pont között a kívánt távolság lesz:

El?re/hátra mozgatás 2D nézetben (Draw order)

Attól függetlenül, hogy egy tárgy 3D-ben (fizikailag) mélyebben mint egy másik tárgy, 2D felülnézetben (Plan view) el?fordulhat, hogy kitakar egy
valójában felett lév? tárgyat. Az egy rajzolási csoportban vannak (Drawing Group) lév? objektumok abban a sorrendben kerülnek megjelenítésre 2D
nézetben, ahogy rajzoljuk ?ket.

Lejeb mozgatni egy objektumot 2D nézetben a "View Draw order edit tool"-al lehet, amit az objektum kijelölése után az alsó menüben találunk:

Ay eszköz kiválasztása után a jobb alsó sarokban megnyíló eszköztárral tudjuk lefelé illetve felfelé mozgatni az objektumot. (Send Backword/Send
Forwerod)

Fontos, hogy ez a rétegeken nem fog változtatni, csak a megjelenítésen 2D nézetben.

Elemek kijelölése
Elemek kijelölése tab-al

Azonos típusú elemek kijelölése shift-el

Azonos típusú elemek kijelölése 'Select similar' eszközzel
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Elemek kijelölése törlése

(pl roof plan vagy framing törlése...)

Elemek manipulációja
Fillet and Chamfer Tools (kerekítés levágás)

https://www.chiefarchitect.com/videos/watch/5310/fillet-and-chamfer-tools.html?playlist=97
A Fillet és Chamfer eszközökkel CAD sarkokat kerekíthetünk le vagy csaphatunk le. A használatukhoz els? lépésként ki kell jelölni egy CAD téglalapot:

majd az alsó menüben a 'Fillet' vagy 'Chamfer' ( ) eszközök valamelyikét válasszuk ki. A példában a 'Fillet'-et (lekerekítés) fogom megmutatni,
a másik ugyan úgy m?ködik.

Ha kiválasztjuk a 'Fillet' eszközt akkor megjelenik az almenüje, ahol választhatunk, hogy csak 1 sarkot vagy az összes sarkot szeretnénk lekerekíteni:

A lekerekítés sugarát mindig az 'F' jel?vel (bal oldali: 'Set fillet radius') kell megadni még akkor is ha kés?bb az 'A' jelzés?vel az összes sarkot egyszerre
le fogjuk kerekíteni. A 'Set fillet radius' hatására megnyílik a rádiusz beíró dialógus:

Itt írjuk be a kívánt rádiuszt majd kattintsunk az OK-ra. Ekkor még semmi nem fog történni. Két lehet?ségünk van:

1. Egy sarok lekerekítése:

Rákattintunk az alsó al-menüben a 'Stick mode' pinre ( ) Ha van rajta egy kis pipa, akkor be van kapcsolva.
• 

Ekkor els? lépéskén válasszuk ki a lekerekíteni kívánt sarok melletti egyik élt• 
kattintunk a sarokra. Ekkor az él le fog kerekedni:• 

2. Az összes sarok lekerekítése:
A rádiusz beállítása után kattintsunk az 'A' jel? 'Set fillet radius'. Ebben a pillanatban az összes sarkot le fogja kerekíteni:

Trim and Extend Commands

https://www.chiefarchitect.com/videos/watch/306/using-the-trim-and-extend-commands.html

Legfontosabb CA alapfogalmak
.. TODO: a mélyebb CA megértéshez elengedhetetlen hogy értsük az ebben a fejezetben bemutatott alapfogalmakat és CA koncepciókat ...
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Rétegek és rétegcsoportok
https://www.chiefarchitect.com/videos/watch/5483/understanding-layer-sets.html?playlist=100
https://www.chiefarchitect.com/videos/watch/2421/saved-plan-views.html
https://www.chiefarchitect.com/videos/watch/5483/understanding-layer-sets.html?playlist=100

A CA hatékony használatához elengedhetetlen, hogy megértsük a rétegek (layers), rétegcsoportok (layer set), úgynevezett 'Default set'-ek és referencia
és elmenett nézetek (Saved view) fogalmát. Ezeket az egymásra épül? fogalmakat fogjuk sorban áttekinteni ebben és a soron következ? fejezetkeben.
Azonban most sem célunk, hogy lemásoljuk az amúgy kiváló súgó tartalmát, pusztán az alap filozófiát próbáljuk meg átadni, hogy gyorsítsuk a tanulás
folyamatát.

Akárcsak az AutoCad-ben, a CA-ban is vannak rétegek. De az AutoCad-el ellentétbe minden 'plan' templét alapértelmezetten tartalmazza a
potenciálisan szükséges rétegek nagy részét, nem feltétlen kell nekünk újakat létrehozni. Els?sre kicsit furcsa is lehet a "gyárilag" létrehozott rétegek
hatalmas száma. Nagyjából 80 el?re definiált réteg van alapértelmezetten minden új 'plan'-ben. Egy épület minden egyes objektum típusához ki van
találva egy el?re definiált réteg, és minden egyes épület elem automatikusan az alapértelmezett rétegére kerül. A réteg meghatározza rajta elhelyezett
objektumok láthatóságát, az alaprajzi ábrákon az elem színét, vonaltípusát, sraffozás típusát, bet? méretét és típusát stb.

Rétegcsoportok beállítása

A rétegeket úgynevezett 'layer-set'-ekbe, vagyis rétegcsoportokba szervezi a CA. Minden 'layer set'-ben benne van az összes réteg ki vagy bekapcsolt
állapotban. Tehát a rétegcsoport fogalma a CA-ban nem azonos az AutoCAD-ben használt rétegcsoportokkal, ahol különböz? rétegekb?l különböz?
csoportokat hozhatunk létre. A CA-ban kicsit más a filozófia a rétegcsoportok mögött, egy adott rétegcsoportból (Layer Set) nem lehet kivenni rétegeket,
vagy újakat hozzáadni. Ha új réteget hozunk létre, az minden egyes rétegcsoportba be fog kerülni, és ha kitörlünk egy réteget, akkor az az összes
rétegcsoportból el fog t?nni. Minden id?pillanatban egy meghatározott 'layer set' vagyis rétegcsoport aktív bármilyen nézetét is használjuk a tervrajznak.
A 'layer-set' lényege, hogy egy adott rétegcsoport kiválasztásával egy kattintással át tudjuk állítani az összes rétegünk színét, vonaltípusát, láthatóságát,
stb. Ha egy réteget módosítunk (láthatóság, bet?típus, vonaltípus, stb) akkor az csak az éppen kiválasztott 'set'-ben (rétegcsoportban) fog megváltozni,
nem globálisan az összes csoportban.
A 2d felülnézethez és minden metszet típushoz és különböz? 3D-s kamera képekhez tartozik egy alapértelmezett 'layer set'. Ahogy azt majd láthatjuk
kés?bb a könyvben, a különböz? 3D-s kamera nézet és metszet típusok valójában csak a réteg beállításokban különböznek egymáshoz, minden
kamera típushoz tartozik egy gyári, el?re definiált 'layer set', ami az adott kamera típusnak megfelel? állapotba állítja az összes réteget, aminek a
hatására a modell pont úgy fog megjelenni, ahogy azt az adott nézet megkívánja. (Pl. a váz szerkezet nézetben a 'Framing layer set' lesz aktív, ahol
csak a falváz rétegek vannak bekapcsolva, minden más réteg kikapcsolt állapotban van).

A rétegeket és réteg csoportokat a 'Layer Display Options' ablakban szerkeszthetjük, amit a 'Tools'-> 'Layer Settings'->'Display Options' menüpontban
nyithatunk meg.

Ezt a fels? eszköztárból is megnyithatjuk az alábbi ikonra kattintva:  A 'Layer Display Options' ablakban szerkeszthetjük rétegcsoportonként (Layer
set) a réteg tulajdonságokat. Fontos fejbe tartani, hogy itt nem az éppen használt nézethez (pl kamera nézet, metszet) választunk ki rétegeket vagy
réteg csoportot, hanem a tervrajzban szerepl? összes rétegcsoport beállítását tudjuk itt módosítani. Az éppen aktuális nézetben használt rétegek és
rétegcsoportról kés?bb fogunk értekezni.

Az ablak középs? részén láthatjuk az összes a tervben szerepl? réteget táblázatos formában felsorolva (1). Az ablak tetején található a rétegcsoport
(Layer set) választó (2). Az albak alján pedig a kiválaszott réteg beállításia módosíthatóak (3). A táblázatban a rétegek neve és sorrendje nem függ a
kiválasztott rétegcsoportól, mivel, minden rétegcsoport az összes réteget tartalmazza. A táblázatban szerepl? réteg attribútumok egy része nem
rétegcsoport specifikus, vagyis az az ezen attribútumok értéke nem állítható be rétegcsoportonként. Nézzük meg sorba a rétegek attribútumait:

Nem rétegcsoport specifikus tulajdonságok:
Name: réteg neve♦ 

• 
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Used: azt mutatja meg, hogy az adott rétegre helyeztünk bármilyen objektumot az aktuális terven. A piros kereszt  azt jelenti,
hogy a réteg tartalmaz legalább 1 objektumot (pl falat, tet?t, írást, nyilat..stb).

♦ 

Rétegcsoport specifikus tulajdonságok:
Disp (Display): A rétegen lév? objektumok láthatóságát állítja be rétegcsoport specifikusan. Ha egy adott rétegcsoportban (Layer
set) kikapcsoljuk egy réteg láthatóságát, akkor bármelyik tervrajz nézetben (2D plan view, camera view, cross section), ha
kiválasztjuk használatra ezt a rétegcsoportot, akkor minden olyan objektum el fog t?nni, ami olyan rétegeken van, ahol a 'Disp'
oszlopban nincs pipa az aktuális rétegcsoportban.

♦ 

Mat (Material list): A réteg feltüntetésre kerüljön e az anyaglistán (Material list). A CA tud egy nagyon részletes anyaglistát készíteni
az épülethez, amit majd részletesen tárgyalunk kés?bbi fejezetekben.

♦ 

Lock: Ha egy réteg egy rétegcsoportban zárolva van, és az adott nézetben (legyen az 2D tervez?i nézet, vagy valamelyik kamera
nézet) ez a rétegcsoport van kiválasztva, akkor a zárolt rétegen lév? semmilyen objektum nem kiválasztható az adott nézetben. Ez
nagyon hasznos funkció, ha már nagyon sok objektum van egy tervrajzon. Pl olyan nézetekben, ahol nem a tet?vel akarunk
foglalkozni hasznos lehet ha a tet? rétegeit zároljuk. Ett?l még a tet? látható marad, de könnyebben ki tudjuk majd választani a tet?
alatti, vagy a tet?höz közeli egyéb objektumokat. Ha már nagyon sok objektum van közel egymáshoz, pláne ha egy síkban vannak,
nagyon macerás lehet a kiválasztásuk.

♦ 

'Color', 'weight' és 'line-style': A vonalszín, vonal vastagság és a vonal típus mind olyan tulajdonságok, amik els?sorban a 2D
tervez?i nézetekre vonatkoznak, ahol a 3D-s objektumok valamilyen egyszer?sített 2D-s reprezentációját láthatjuk. Pl. A falakat a
2D-s tervez?i alaprajz nézetben csak egy vonallal jelöljük, vagy valamilyen sraffozással:

♦ 

• 

A tervrajzban megtalálható rétegcsoportokat (Layer set) egy külön felületen tudjuk szerkeszteni, amit a 'Tools'->'Layer settings'->'Layer Set
Management' menüpont alatt érhetünke el.

A 'Layer Set Management' ablakban könnyedén létrehozhatunk új rétegcsoportokat, vagy meglév?eket törölhetünk vagy másolhatunk le.

A rétegcsoportok másolása (Copy) egy nagyon hasznos eszköz. Ha van egy olyan rétegcsoport, ami nagyon hasonlít az újonnan létrehozni kívánt
csoporthoz (vagyis a réteg tulajdonságok, mint pl. láthatóság és színek majdnem megfelel?ek) akkor ezt a csoportot egy mozdulattal le tudjuk másolni,
majd módosíthatjuk a kívánt rétegeket benne.

Active Layer Display Options

..TODO...

Eszközök Alapértelmezett beállításai
A CA-ban minden egyes eszközhöz tartoznak egyedi alapértelmezett beállítások, ami meghatározza az eszköz viselkedését a különböz? nézetekben,
vagyis hogy az eszköz által létrehozott objektumok milyen tulajdonságokkal jöjjenek létre. Pl. a fal rajzoló eszköz alapértelmezett beállításai
meghatározzák, hogy milyen fal típust rajzoljon a fal eszköz alapértelmezetten, ha az eszközt kiválasztjuk, és anélkül hogy bármi tátállítanánk,
elkezdenénk pl. falat rajzolni. A falnak be lehet állítani az alapértelmezett rétegrendjét, burkoló anyagait, színét, stb. Fontos, hogy az alapértelmezett
beállítások mindig tervrajz (plan és layout) specifikusak, ha átállítjuk ?ket, akkor csak az adott 'plan' és 'layout' fájlra lesznek hatással. Az
alapértelmezett beállítások nem összekeverend?ek a 'Preferences' beállításokkal, ahol az egész CA számára a globális beállításokat találjuk. Ebben a
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fejezetben kifejezetten a 'plan' és 'layout' szint?, eszköz alapértelmezett beállításokról lesz szó. Természetesen a 'Default Setting' átvihet?k egyik
tervrjazból a másikba templétek használatával, de ezt most itt nem részletezzük.

Tervrajz specifikus alapértelmezett beállítások (Default Settings)

Egy tervrajzon belül (plan és layout) minden eszköznek beállíthatjuk az alapértelmezett tulajdonságait a 'Default Settings' ablakban. A 'Default

Settings'-et az 'Edit'->'Default Settings...' menüpontban vagy a fels? eszköztárban a kis villáskulcsra ( ) kattintva nyithatjuk meg

A 'Default Settings' ablakban fa struktúrában, kategóriákba csoportosítva találjuk a CA-ban fellelhet? összes eszközt. A felület sajnos nem túl
felhasználóbarát, nem lehet benne keresni, cserébe elég logikus a csoportosítása az eszközöknek. Minden eszköznek az eszközre jellemz?
alapértelmezett beállításai vannak, tehát ne csodálkozzunk rajta, hogy különböz? eszközöket megnyitva a 'Default Settings' ablakban teljesen más
beállító felületeket fogunk látni. Láthatjuk, ha lenyitjuk a 'Walls' f?kategóriát, 13 különböz? faltípus beállításiat találunk benne:

Els?ként nyissuk meg a 'General Wall' beállításokat ami a falrajzoló eszköz pár általános beállítását tartalmazza, ami az összes faltípusra közös, mint
pl. a falak átméretezési tulajdonságai, túl sok beállítási lehet?séget nem találunk itt.
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Ezzel ellentétben az 'Exterior Wall' (küls? falak) alapértelmezett tulajdonságok beállító ablakban már egy nagyon sok füles felületet láthatunk:

Ahogy azt majd kés?bb látni fogjuk, a CA-ban több el?re definiált faltípus van (küls? fal, bels? fal, pony wall, korlát, szoba határoló, stb). Ezek
lényegében mind fal típusú objektumok és csak a fal széleteses beállításaiban különböznek egymással.

Note
Egy adott eszköz alapértelmezett tulajdonságait úgy is megnyithatjuk, ha valamelyik eszköztárban kétszer kattintunk az eszköz ikonjára

Dinamikus alapértelmezett beállítások (Default Sets)

https://www.chiefarchitect.com/videos/watch/240/understanding-default-sets.html
https://www.chiefarchitect.com/support/article/KB-01167/setting-up-a-custom-default-annotation-set.html

Az úgynevezett 'Default Set'-ek segítségével bizonyos CA eszközökhöz több alapértelmezett beállítást is készíthetünk, amik szintén egy tervrajzon belül
('plan' vagy 'layout' fájl) értelmezettek. Ezeket az alapértelmezett beállítás "variációkat" úgynevezett alapértelmezett beállítás csoportokban szervezve el
tudjuk menteni tetsz?leges számban, és egy tervrajzon belül könnyen át tudunk váltani egyik alapértelmezett beállítás csoportból egy másikba. Hogy ez
miért is jó, azt majd az 'Elmentett nézetek' (Saved views) fejezetben fogjuk teljes mértékben megérten, de addig is tekintsük át a 'Default set'-ek
koncepcióját. A CA összesen 8 eszközre biztosít alapértelmezett beállítások csoport kezelést, amik az alábbiak:

Dimensions (dimenzió vonalak)1. 
Arrow (nyilak)2. 
Revision cloud3. 
Notes (megjegyzések)4. 
Rich text (formázott szövegek)5. 
Text (formázatlan szövegek)6. 
Markers7. 

Mikor alapértelmezett beállítás csoportot váltunk (Default Set), akkor a fenti 8 eszköz alapértelmezett beállítási tulajdonságait változtatjuk meg egy
mozdulattal egy tervrajzon belül. A 'Default Set'-ekre (alapértelmezett beállítás csoportokra) részben azért van szükség, mert ezen 8 eszköz által
létrehozott/megrajzolt objektumoknak nagyon máshogy kell kinézni a különböz? tervez?i nézetekben. Pl. a 2d-s tet? tervez?i nézetben másféle
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dimenzió vonalakra van szükség mint a 2d-s falváz tervez? nézetben. Ugyan ez igaz pl. a különböz? formázott (Rich text) és formázatlan (Text)
szövegdobozok létrehozására is. Ezen eszközökhöz beállítható tulajdonságok mind olyanok, amik nem kontrollálhatók kizárólag réteg tulajdonságokkal.
(Hiszen akkor elég lenne egy 'Layer Set' váltás, nem lenne szükség a 'Default Set'-ekre). Mikor a tervrajzon bármelyik nézetben létrehozunk egy
objektumot a fenti 8 eszköz valamelyikével (pl. létrehozunk egy új dimenzió vonalat) akkor az objektum tulajdonságait az éppen aktív 'Default Set'-b?l
fogja venni a CA (pl. a dimenzió vonal színét, vagy bet? típusát). Minden 'Default Set' a már felsorolt 8 eszköz alapértelmezett beállításán túl tartalmaz
még alapértelmezett réteg beállításokat is:

Alapértelmezett 'Layer Set' (réteg csoport): A 'Default Set' kiválasztásakor ez a rétegcsoport lesz aktív, tehát implicit a 'Default Set' választás
a réteg tulajdonságokat is meghatározza.

• 

Alapértelmezett CAD réteg: Az a réteg, amire alapértelmezetten minden CAD objektum kerülni fog, amikor egy adott 'Default Set' ki van
választva.

• 

Ezeknek a funkcióját részletesen át fogjuk tekinteni ebben a fejezetben.

Az alábbi ábrán láthatjuk a CA különböz? beállításainak, rétegcsoportjainak és CAD rétegeknek a kapcsolatát a 'Default Set'-el. A CA-ban minden terv
tartalmaz a fent említett 8 beállításhoz el?re elmentett konfigurációkat. Ezek az ábrán pl. a 'Dimension settings-1', 'Dimension-settings-2', 'Rich text-1' és
így tovább. A 'Dimension settings-1'-ben pl. a dimenzió vonalak színe lehet zöld, míg a 'Dimension settings-2'-ben a dimenzió vonalak színe lehet sárga.
Minden 'Set'-ben egy ilyen el?re elmentett konfigurációból kell választani mind a 8 fent felsorolt eszköz esetében.

Az ábrán láthatjuk, hogy a 'My custom default set' nev? 'Default Set'-hez a 'Dimension settings-1' konfiguráció van beállítva a 'Dimensions' eszközhöz,
mag a 'Rich Text' eszközhöz a 'Rich Text-2' konfiguráció tartozik. Ezen felül minden 'Default Set'-hez be kell állítani egy rétegcsoportot (Layer Set) is,
így az éppen aktív 'Default Set' implicit meg fogja határozni azt is, hogy milyen rétegcsoporttal dolgozzunk. Ugyanígy minden 'Default Set' kijelöl egy
alapértelmezett CAD réteget is, ahova az összes CAD objektum kerülni fog.

Note
X12 el?tti CA verzióban a 'Default Set'-et Annotation set-nek hívták

Default set beállítások

A 'Default set' beállításokat a 'Default settings' ablak 'Default Sets' menüpontjából nyithatjuk meg.

A 'Default sets' ablak baloldalán láthatjuk az összes a tervben elmentett 'Default set'-et név szerint ABC sorrendbe rendezve (1). Minden terv 9
gyári/beépített 'Default set'-et tartalmaz. Ha kiválasztunk egy 'Default set'-et a listáról, akkor annak a tartalmát a jobb oldalon láthatjuk (2).
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Ahogy azt már láthattuk, 8 CA eszköz alapértelmezett tulajdonságát állíthatjuk be minden egyes 'Default set'-ben. Minden egyes eszközhöz egy
legördül? listából választhatjuk ki az adott 'set'-hez tartozó beállításokat.

Minden eszközhöz (pl. dimenzió vonalakhoz vagy formázott szöveghez) készíthetünk névvel elmentett beállításokat, ezeket láthatjuk a legördül?
listákban. Így nagyon egyszer?en tudjuk ugyanazt a beállítást adni egy eszköznek különböz? 'Default set'-ekben. A legördül? listák melletti ceruzával

lehet az aktuális beállítását szerkeszteni egy eszköznek, vagyis azt ami éppen a legördül?listában ki van választva ( ). A legördül?listák melletti

plusz jelre kattintva ( ) készíthetünk egy másolatot az aktuálisan a listában kiválasztott beállításról.

Mind a 8 eszközhöz különböz? beállítások tartoznak, amik jellemz?ek az adott eszközre. Pl. A 'Dimensions' beállításai egy 9 fülb?l álló ablakban
vannak, kifejezetten a dimenzió vonalakra jellemz? beállításokkal:
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Ezzel ellentétben pl. a 'Callouts' (ábrafelirat) beállításai egy 4 fülb?l álló ablakban vannak a dimenzió vonalaktól teljesen eltér? attribútumokkal:

Egy közös pontja van az összes eszköz beállító ablaknak, ami mind a 8 beállító ablakban megtalálható. Ez nem más mint az alapértelmezett réteg
beállító fül illetve mez?. Na de mire is való ez. Minden nézetben (pl. 2D tervez?i nézet, vagy metszeti nézetek) mindig van egy éppen aktív 'Default set',
pl. az elektromos tervez?i nézetben (Electrical Plan View) mindig az 'Electrical Default Set' lesz aktív. Az aktuálisan aktív 'Default set'-ben az
eszközökhöz definiált rétegre fog alapértelmezetten kerülni minden az adott eszközzel készült objektum. Pl. ha egy dimenzió vonalat akarunk elhelyezni
az elektromos tervez?i nézetben, amihez az 'Electrical Default Set' tartozik, akkor ezek a dimenzió vonalak alapértelmezetten az 'Electrical dimensions'
nev? dimenzió beállításokban meghatározott rétegre fognak kerülni.

Kattintsunk a 'Dimensions' legördül? melletti kis ceruza ikonra, hogy megnézzük az 'Electrical Dimensions' tartalmát:
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Láthatjuk, hogy az itt definiált réteg a 'Dimensions, Electrical'. Tehát összegezve: ha az 'Electrical Default Set' aktív egy nézetben, és egy dimenzió
vonalat akarunk elhelyezni ebben a nézetben, akkor ezek a dimenzió vonalak alapértelmezetten az 'Dimensions, Electrical' rétegre fognak kerülni.

Van még két nagyon fontos tulajdonsága minden 'Default set'-nek. Ezek a 'Layer Set' vagyis 'rétegcsoport', és a 'Current CAD Layer', vagyis az 'aktuális
CAD réteg'.

Egy kis ismétlés: minden nézetben mindig pontosan egy aktív rétegcsoport ('Layer set') aktív. Minden rétegcsoport minden réteget tartalmaz, és
meghatározza a rétegek tulajdonságát, mint pl. a láthatóság, szín vagy vonaltípus, és nem azt hogy melyik objektum melyik rétegre kerül. A 'Layer set'
határozza meg lényegében, hogy az aktuális nézeten milyen objektumok és milyen formában látszanak.
Minden egyes 'Default set'-hez hozzá van rendelve egy 'Layer set'. Vagyis ha egy nézetben egy adott 'Default set' ki van választva, akkor az
meghatározza, hogy melyik rétegcsoportot használjuk alapértelmezetten azon a nézeten. Így áttételesen a 'Default set' kiválasztása meghatározza a
view megjelenését is, mivel a 'Default set' kiválasztása mindig kiválasztja a benne beállított rétegcsoportot is. Ez majd az elmentett nézetek estében
lesz nagyon fontos, mert ahogy ezt majd kés?bb látni fogjuk, az elmentett nézetekben (saved views) meg kell határozni a hozzá tartozó 'Default set'-et
és ez által implicit, hogy melyik 'Layer set' tartozik a nézethet.
A 'Default set' beállításai között van még egy fontos réteg beállítás, az alapértelmezett CAD réteg beállítása. Minden CAD elem (vonalak, négyzetek,
körök, stb) alapértelmezetten az itt beállított rétegre fognak kerülni, ha a 'Default set' aktív egy nézetben.

Active Default set

Ahogy már láthattuk, minden nézethez mindig tartozik egy éppen aktív 'Default set', ami meghatározza a nézetben használt eszközök tulajdonságait
(mint pl. dimenzió vonalak, szöveg dobozok, megjegyzések, stb.) valamint a 'Default set' meghatározza a nézetben használt rétegcsoportot és CAD
réteget. Ennek az éppen aktív 'Default set'-nek egy külön ablakban meg tudjuk nézi a beállításait a 'Tools'-> 'Active Defaults...' menüpontot választva.

Az 'Active Defaults for..' ablak tetején mindig megjelenik annak a nézetnek a neve, amihez a 'Default set' tartozik. Az alábbi példában a 'Default set' a
'Working plan view'-hoz tartozik, ami az egyik beépítettet 2D-s elmentett tervez?i nézet.
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'Active Defaults for..' ablak tartalma megegyezik a korábban már bemutatott 'Default Sets' ablakkal azzal a különbséggel, hogy itt nincs megjelenítve az
összes a tervben megtalálható/elmenetett 'Default set', mindig csak az aktuális nézetben éppen aktív 'Default set' beállításait láthatjuk.

Reference display
A 2D-s tervez?i nézetekben egy úgynevezett 'Referencia Nézet' (Reference Display) segítségével a 2D tervrajzra "rávetíthetünk" más szintekb?l vagy
akár más tervrajzokból is részleteket, amik els?sorban a tervrajz megrajzolását segítik. Pl. könnyebb elhelyezni egy adott emeleten egy fürd?szobát, ha
az aktuális szintre rá tudjuk vetíteni az alatt lév? szinten elhelyezett fürd?szobát. Referenciaként (rávetítésként) vagy az aktuális tervrajz egy másik
szintjének 2D-s tervrajzát választhatjuk, hogy akár egy másik 'plan' fájl egy kiválasztott szintjét. Ez utóbbi meglév? épületek b?vítésénél (remodel) lehet
hasznos, míg az el?bbi a szintek kialakításánál nagyon hasznos segédlet. Egyszerre akár több szintet is rávetíthetünk a jelenlegi nézetre, vagy akár
több másik tervrajz tetsz?leges számú szintjét is használhatjuk referenciaként. Azt hogy egy adott szintb?l vagy másik tervrajzból pontosan mint vetítsen
rá a CA az éppen használt 2D-s nézetre, az konfiguráció kérdése, teljesen testre szabható, de alapértelmezés szerint mindig a rávetített szint falainak
piros kontúrját fogjuk látni. Az alábbi képen a 2. szinten vagyunk, és kirajzolja az 1. szint falainak a kontúrját pirossal:

Referencia nézetet a 3D-s kamera nézetek és metszeti nézetek esetében is használhatunk. Ebben az esetben mindig egy vagy több másik tervrajz
részleteit jeleníthetjük meg együtt a jelenlegi 3D-s modellen tipikusan üvegháznézetben, hogy látszódjon hogy mi tartozik a jelenlegi tervrajzhoz, és mik
azok amiket referenciaként jelenítünk meg másik tervrajzokról. Pl. Ha több változatunk van egy adott tervrajzból, akkor 3D-s kamera nézetben
egymásra tudjuk vetíteni a különböz? változatokat, amivel nagyon jól lehet szemléltetni a változást az el?z? változathoz képest. Az alábbi képen
üvegháznézetben rávetítettünk a 3D-s kamera képre egy korábbi változatot, ahol még a tet? alacsonyabb volt, és az ablakok lejjebb voltak.
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A 'reference display'-t bármilyen nézeten be tudjuk kapcsolni, ekkor a nézet beállításainak megfelel? referenciát fogja "rávetíteni" a modellre. A 2D-s
alaprajz nézetekben ez alapértelmezetten az alsóbb szint falainak piros kontúrja, míg 3D-s nézetekben nincs alapértelmezett beállítása a 'reference
display' bekapcsolásának. A referencia megjelenítést a 'Tools' -> 'Floor/Reference Display' -> 'Reference display' menüpontban tudjuk ki és bekapcsolni

vagy a jobboldali nézetvezérl? eszközsavában elhelyezett ikon segítségével ( )

'Referencia display' beállítása 2D alaprajz nézetben

Ha egy 2D-s alaprajz nézet aktív (pl. working plan view), akkor a hozzá tartozó referencia megjelenít? beállításokat a 'Tools' -> 'Floor/Reference Display'
-> 'Change floor/Reference...' menüpontban nyithatjuk meg, vagy ha rákattintunk a fels? eszköztárban az aktuális szintet jelz? számra:

A megnyíló 'Change floor/Reference' ablak alsó része érdekes számunkra. A fels? szekcióban szintet tudunk választani az aktuális nézethez, míg a alsó
szekcióban be tudjuk állítani hogy milyen módon jelenítsen meg referenciákat a CA, ha a funkciót az adott nézetben bekapcsoljuk:

Az ablak használata nem bonyolult, de nem is intuitív. Láthatjuk, a referencia beállító felület egy táblázatból áll, és a táblázatot módosító gombokból (új
sor hozzáadása, mozgatása törlése).
A táblázatban alapértelmezetten mindig két sor van minden 2D tervrajz nézetben. Az egyik mindig az aktuális munka szintet szimbolizálja, ahol éppen
állunk a nézetben, ezt egy piros nyíl jelöli az els? oszlopban (alsó sor). A másik sor pedig az aktuális szintre rávetített szint beállításait tartalmazza (fels?
sor). A sorok sorrendje számít. Ugyanis a szintek kirajzolása alulról felfelé történik, és végül ha egy vonal két szinten is megtalálható, akkor a legfels?
szint fog nyerni, jelen esetben a munkaszintre rávetített másik szintje az épületnek. Egy 3 vagy több szintes épületben, ha több mint egy szintet
szeretnénk rávetíteni a munka szintre, vagy több tervrajzot szeretnénk "összevetíteni", akkor lesz érdekes a sorok sorrendje.
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Nézzük meg az oszlopokat:

Current: itt található meg az a piros nyíl, ami megmutatja, hogy melyik a munka szint, vagyis az aszon szintje az épületnek, amire rá lesz
vetítve egy másik szint (vagy egy másik tervrajz).

• 

Plan: itt választhatjuk ki, hogy a rávetített szintet melyik tervrajzból vegye a CA. A 'Current' sor esetében, ami a munka szintet reprezentálja,
ez értelem szer?en nem választható, hisz a munka szint csak az aktuálisan megnyitott 'Plan' fájlból kerülhet ki értelem szer?en. Viszont a
rávetetett épület szint már kikerülhet egy másik 'Plan' fájlból is. Alapértelmezetten a rávetített szint is ugyan azon plan egy másik szintje.
Akkor van értelme egy másik plan fájlból rávetíteni egy másik szintet (vagy akár ugyan azt a szintet egy másik plan fájlból) ha áttervezést,
b?vítést végzünk egy meglév? épületen (remodel, creating an edition). Ekkor az egyik plan fájlban lehet az épület jelenlegi terve, és egy
másikban az átalakítás utáni állapot.

• 

Floor: Melyik szintet szeretnénk rávetíteni az aktuális munkaszintre. Itt egy legördül? listából ki tudunk választani egy másik szintet az
épületben, vagy választhatjuk az Automatic lehet?séget is. Ez az alapértelmezett érték is. Ebben az esetben mindig az alsó szintet fogja
rávetíteni a munka szintre, kivéve ha a legalsó szint a munka szint, mert akkor a felette lév? szintet. Ami egy kétszintes épület esetén
tulajdonképpen mindig a másik a másik szintet fogja a munka szintre vetíteni, a fels? szint esetében mindig az alsó, az alsó szint esetében
mindig a fels?.

• 

Layer Set: A rétegcsoport kiválasztása befolyásolja, hogy a rávetített szint milyen módon jelenjen meg az aktuális munkaszint
tervrajznézetében. Láthattuk, hogy alapértelmezetten a referencia, vagyis a rávetetett szintb?l csak a falak kontúrja jelenik meg piros színnel,
ezen kívül semmi más nem látszik a referencia szintb?l. Ez pusztán azért van, mert a referenciaként használt alapértelmezett 'Reference
Display Layer Set'-ben minden más réteg láthatóság ki van kapcsolva a falakon kívül, és a falak layer színe pedig pirosra van állítva.
(Következ? ábra).

• 

Define: megnyithatjuk vele a rétegcsoport (Layer Set) szerkeszt?t.• 
XOR: Ha egybeesik két vonal ugyanazokkal a vonal beállításokkal két referencia szinten, vagy referencia szint és a munkaszint között, akkor
a vonal egyáltalán nem lesz megjelenítve, ha a XOR be van kapcsolva.

• 

'Referencia display' beállítása 3D nézetekben

A 3D-s kameranézetekben vagy metszetekben már nem annyira egyszer? bemutatni a referencia nézet használatát, mert mindenképpen szükség van
hozzá egy második tervrajzhoz is, ami valamilyen értelmes logikai relációban van az éppen használt tervvel, pl. ugyan azt az épületet tartalmazza csak
a referencia nézethez használt épület alacsonyabb mint az aktuális 'plan'-ben. Erre a funkcióra els?sorban épületek átépítésénél lehet szükség, ahol
egymásra akarjuk tenni a régi és az új épületet, hogy láthassuk a kett? közötti különbséget. Szintén hasznos lehet ez a funkció ugyanazon tervrajz
különböz? változatainak az összehasonlítására, ha szemmel látható méretbeli eltérések vannak az épület különböz? részei között a tervrajz verziókban.
A referencia megjelenítésekor a másik tervrajzban lév? modellt pont abból a szögb?l és abszolút pozícióban fogja elhelyezni a CA, mint az eredeti
modellt. Ezért a referenciaként használt modellben az épületnek praktikusan pont ott kell lennie, min az éppen használt plan fájlban, és ugyanolyan
tájolással kell a tervben szerepeljen, különben a két a referencia megjelenítésével két egymástól független épületet fogunk látni egymás mellett egy
nézetben, és nem egymásra vetítve.
Ha bármilyen metszeti nézetben, vagy 3D-s kamera nézetben rákattintunk a fels? eszközsávban az aktuális emeletet jelz? számra, vagy a 'Tools'->
'Floors/Reference Display' -> 'Change Floor/Reference...' menüpontjára, akkor a 2D tervez?i nézetekben látott ablakhoz nagyon hasonló referencia
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nézet beállító ablak nyílik meg:

A legfontosabb különbség, hogy referenciának kötelez? egy másik tervet választani, és hogy nincs szint választó. Nézzük meg az oszlopokat:

Current: Egy piros nyíl mutatja meg, hogy melyik az aktuális 'plan' fájl. A 2D tervez?i nézettel ellentétben itt az aktuális munka szintet jelöli a
nyíl, pusztán az aktuális plan fájlt, mert itt kötelez? hogy a rávetített tervet egy másik plan fájlból vegyük.

• 

Plan: Itt tudjuk kiválasztani, hogy melyik plan fájlból vegyük a rávetített nézetet. Szintet nem tudunk hozzá választani értelem szer?en.• 
Layer Set: Ugyan úgy, ahogy a 2d tervez?i nézet esetében láthattuk, ki kell választani, hogy milyen rétegcsoportalt jelenítsük meg a
referencia nézetet. Mivel a 3D-s kamera nézetben a rávetítés nem igényel speciális réteg beállításokat, itt nincs el?re definiált rétegcsoport
kiválasztva, mint a 2D tervez?i nézet esetében a Reference Display Layer Set' volt.

• 

Rendering Technique: Ez egy új oszlop a 2D tervez?i nézethez képest. Itt ki tudjuk választani, hogy a rávetített terv milyen módon legyen
rendereve. Nem lehet az összes 3D nézetekben használható renderelési technika közül választani, pusztán az üvegház (Glass House
Reference) és a normál renderelés között választhatunk. Ha a 'Glass House Reference' van kiválasztva, akkor a t?le jobbra lév? 'Define'
cellálra kattintva beállíthatjuk az üvegház átlátszóságát:

• 

Saved view
Most hogy megértettük mik azok a 'Layer set'-ek, 'Default set'-ek, hogy mi az a 'Reference display', rákanyarodhatunk az egyik legfontosabb fogalomra
a CA-ban, az úgynevezett 'Saved view' fogalmára, vagyis az elmentett nézetekre.

Saved planview

A 'Saved View', vagyis 'elmenett nézet' kizárólag a 'Plan view'-ra vonatkoznak, vagyis a 2D felülnézeti tervez?i nézetekre. Egy elmenett nézet (Saved
view) kiválasztásával egy mozdulattal tudjuk teljesen átkonfigurálni a CA minden porcikáját a 2D tervez?i nézet (Plan view) vonatkozásában. A 'Saved
view' nem más, mint egy csoportosítása adott konfigurációs beállításoknak, mint pl, az aktív rétegek csoport, 'default set' és 'reference display', stb.

A CA-ban 9 el?re definiált 'Saved view' van, amit minden tervrajz templét alapértelmezetten tartalmaz. 

Minden elmentett nézethez (Saved view) tartozik egy alapértelmezett layer beállítás halmaz, ami az adott view típushoz leginkább passzoló réteg
beállításokat tartalmazza. A view választással igazából egy layer beállítás halmazt választunk ki. Pl. az "Electrical Plan View"-ban nincs szükség a
dimenziók megjelenítésére, és elég ha a falakat csak egy vonalnak jelenítjük meg, nincs szükség a sraffozásra, vagy a falak kitöltésére.
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Saved camera view

Saved cross section view

Saved CAD details

Section/Elevation
https://youtu.be/SdB1BrYtJd4

Bevezet?
Ahogy azt már megszokhattuk a CA-ban minden cross section és elevation ugyan azon az objektum típuson alapul csak más beállításokkal. Az egyikb?l
el? tudjuk állítani a másikat konfiguráció útján. Az Elevation csak annyiban különbözik a section-t?l, hogy az egyik az épület belsejében van. A
blackclipped corssesion meg csak annyiban különbözik a normál corss esion-t?l, hogy korlátozva van a mélysége. A corss esion jele mindig egy kis
háromszög egy körrel:

 (ezt hívják callout-nak, vagyis ábra feliratnak)

A háromszög mutatja meg, hogy melyik irányba készült az elevation vagy section. Minden elevation -höz tartozik egy view, ahol vagy a ház egy
homlokzata látható vagy egy metszete. Ezeket az elevation és cross section view-kat el is menthetjük és el tudjuk küldeni egy layout valamelyik
oldalára. Az elevation és section adja meg a szerkesztéshez a különböz? oldal nézeteket, amit AutoCad-ban a modelltérben kapunk meg. A cross
section és elevation-nek ugyan úgy van Specification dialog-ja mint mind más objektum típusnak. De itt a dupla click nem m?ködik, mert az megnyitja az

elevation -höz tartozó view-t. Ehelyett a Specifcaiton gobbal ( ) tudjuk megnyitni a dialog-ot.
General fül:

Name: Ez a név fog megjelenni egyrészt a callout alatt a floor-plan-en, másrészt a layout-on, ha a section vagy elevation view-t elküldjük egy
layout-ra.

• 
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Rendering technique: Milyen módon renderelje a view-t. A 'Vector view' nevezhet? standarnak.• 
Show shadow: Az aktuális nap állás alapján az árnyékokat is rárakja az épületre. (Lásd fények és nap beállítása)• 
Edge smoothing: ett?l egy lágyabb képet fogunk lapni• 

Plan display:
Hogyan jelenjen meg a floor paln-en a metszet jelölése

Display on all floors: ha nincs bepipálva, akkor csak az aktuális szinten fog megjelenni.• 
Display as callout: ennek a hatására fog megjelenni a nyíl és a kör benne a számmal:

Placement: hova tegye a k?r+nyíl kombót és hány legyen bel?le. Elevation esetén jó a 'Center', ekkor csak egyet fog rakni, ami az
épület felé néz, section esetén meg válasszuk a Both sides-ot, hogy kett?t rakjon ki, ami közrezárja a secion-t.

♦ 

Callout label: ez fontos, ez azonosítja majd a layout hogy melyik Elevation-höz ill. metszethez tartozik. Ezt a számot automatikusna
generálja a CA. Section esetén 'S'-el prefixelve, Elevation esetén pedig 'E'-vel.

♦ 

Text below line: A kör ketté lehet osztva, és az view number alatt még lehet egy szöveg. Ha az Automatic be van pipálva, akkor
mikor elküldjük egy layout-ba akkor oda automatikusan ki fogja tölteni az oldalszámot.

♦ 

• 

Elevation

Auto generate elevations

Cross section
https://www.chiefarchitect.com/videos/watch/16/cross-section-elevation-views.html?playlist=102
Teljes épület metszetet a Cross section / Elevation tool-al csinálhatunk:

Ha a kamerát az épületeten belül helyezzük el, akkor egy metszetet fog készíteni. A metszet alapvonala a Cross section eszköz vonala lesz, és arra
fog nézni, amerre a szaggatott nyíl mutat. Nem számít a szaggatott vonal hossza, csak az iránya.
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Ekkor létre fog jönni egy külön fülön a metszet nézet ami az egész épületen végig megy, ami egy teljesen szerkezthet? nézet a modell szempontjából.
Minden olyan objektumot tudunk manipulálni, amit nem vágott félbe a metszet.

Az új view-t el tudjuk menteni a Tools -> Active view -> Save Active view menüpontban.

Az ikonja ki van rakva a bal fels? sarokba is a view választó elé: 

Mentés után bekerül az új metszet a Project Browser -be a Cross section virtuális mappába:

A cross section-t ki lehet dekorálni nyilakkal, dimenziókkal és egyéb CAD objekutmokkal is. Nyilat a Leader line-al készíthetünk: 

Vagy kidekorálhatjuk szigeteléssel és egyéb anyagokkal a rajzot automatikusan az Auto Detail ( ) gombbal.
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A cross-section-ön végzett minden módosítás a teljes modellen hajtódik végre!

A cross section-t érdemes két callout-al jelölni, ami mutatja, hogy mett?l meddig terjed a metszet. Ehhez nyissuk meg a section Specification dialog-ját a
kis kék ajtóval, és a 'Plan Dispaly' / Placement dobozban pipáljuk be hogy Both side. Ekkor a 'Cross section line style' is aktív lesz, ahol a vonal típusát
is be lehet állítani:

Backclipped cross section

A 'normál' cross section tool mélységben és széltében nem korlátozza amit látunk, mindegy milyen messzire húzzuk az alap vonalra mer?leges
szaggatott vonalat, az csak az irányt jelöli ki, és egészen a modell széléig mindent meg fog jeleníteni, ami csak látszik abból a vonalból, amit

megjelöltünk az alap vonallal. Ezzel ellentétben a backclipped cross section eszközzel ( ) szabályozhatjuk a mélységet és a
szélességet is az épületen kívül és belül is. Csak addig a mélységig fognak látszani a tárgyak, amíg elhúzzuk a szaggatott vonalat. És csak addig a
szélességig, amíg az alap vonal tart.

Jó példa ennek a felhasználására amikor a framing-re akarunk elevation-t mutatni. Ekkor ha nem korlátoznánk mélységben amit a view mutat, akkor az
összes hátsó fal váza belógna a képbe. De ha lekorlátozzuk a mélységet a fal vastagságára, akkor nem fog semmi belógni a képbe.

Ha az épületen kívül kezdjük húzni a fal felé, de a falnál megállunk, akkor azok a beugrók, amik ezen falnál mélyebben vannak, már nem fognak
látszani. Az alábbi ábrán a szaggatott vonal mélysége csak az épület sarkáig ér (ezt a szaggatott vonalra egy mer?leges segéd vonal is jelzi)

Az ebb?l keletkezett Elevation view-ban (baloldali) láthatjuk, hogy az épület bal oldali szárnya hiányzik. Ezzel ellentétben egy teljes Elevation veiw-ban
látszana a baloldali szárny is (job oldali ábra)
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Ugyan ez igaz, ha az épületen belül használjuk metszet készítésre. Csak az fog látszani, amit elér a vonal.

A backclipped cross section csak abban különbözik a normál cross section-t?l, hogy ki van a beállításiaban töltve a 'General -> Options -> Back clipp
after' szekció, ami megmondja, milyen távolba jelentse meg az elemeket a section az alapvonaltól:

Ha bepipáljuk a 'Clip to slide' lehet?séget is akkor oldalirányba is korlátozni fogja az alapvonal mentén hogy mit mutasson a metszet. Ha ezt bepipáljuk,
akkor az alapvonal két végén már megjelenik egy méretez? szürke kis nézet, aminek a huzogatásával kijelölhetjük a section szélességét is.

Ahogy az alábbi képen látható, a metszet mind mélységében (nem látjuk a szemben lév? falat és ajtót) és széltében (csak ezt az egy szobát látjuk)
korlátozva van:

Stepped section view
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https://www.youtube.com/watch?v=SdB1BrYtJd4 (13:10-nél kezd?dk)
A backclipped cross-section alapvonalat meg lehet törni, és az egyes szekciókat el lehet tolni egymáshoz képest, ekkor tudunk olyan blackcipped cross
section-t csinálni, ami követi pl a fal vonalát. Ehhez létre kell hozni egy olyan balcklipped section vonalat, ahol bekapcsoljuk hogy a callout mind a két
végén szerepeljen:

Majd a break eszközzel ( ) az alapvonalt vágjuk el a kívánt helyen:

A vágás után a vágás helyén megjelenik egy kis szürke diamond, és mind a két oldalán a vágásnak megjelenik egy szürke pötty, amivel a két szekciót
egymástól függetlenül tudjuk mozgatni:

És íme a végeredmény:

3D metszet

https://www.chiefarchitect.com/support/article/KB-00631/using-the-cross-section-slider.html

Készíthetünk 3D-s metszetet is az épületr?l. Ehhez készítsünk egy Perspective full overview-t:  Forgassuk be a modelt a
kívánt szögbe, mert a metszet készítése közben nem lehet forgatni.

Majd válasszuk a 3D -> Camera view options -> Cross section slider lehet?séget:

Ekkor megjelenik egy csúszka dialog, ahol minden irány mentén le tudunk vágni az épületb?l.
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A vágás után megint tudjuk forgatni a már levágott modellt:

Metszet to CAD konverzió

https://www.chiefarchitect.com/videos/watch/5479/creating-fully-editable-cross-sections.html?playlist=102
A metszeteket és elevation view-kat át lehet konvertálni 2D CAD részlet rajzá. Ehhez válasszuk a 'CAD -> CAD detail from view' lehet?séget. :

Ekkor a korábbi modellb?l létre fog jönni egy 2D-s, fekete-fehér CAD rajz, ami teljesen le lesz választva a model-r?l, minden eleme vonalankét
editálható lesz, és ha a modell változik ezt már nem fogja lekövetni, ez már egy önálló 2D-s CAD részlet rajz:

Be fog kerülni a CAD details közé a Project Brower-ben. Át tudjuk nevezni, és manipulálás után el tudjuk küldeni egy layout-ba is. A standard CAD
eszközkészlettel lehet manipulálni.

https://wiki.berki.org/index.php/File:ClipCapIt-210329-235136.PNG
https://wiki.berki.org/index.php/File:ClipCapIt-210329-235213.PNG
https://www.chiefarchitect.com/videos/watch/5479/creating-fully-editable-cross-sections.html?playlist=102
https://wiki.berki.org/index.php/File:ClipCapIt-210329-235803.PNG
https://wiki.berki.org/index.php/File:ClipCapIt-210330-000057.PNG


3D kamera nézetek
Bármelyik el?re definiált 3D kamera képet válasszuk is:

Mindig létrehoz hozzá a CA egy kamerát, amit a 2D tervez?i nézetben láthatunk is.

Ezek általában elég messze vannak az épülett?l.

Ha megnyitjuk a Camera beállításait a 2D tervez?i nézetben kijelölve a kamerát és a kék ajtóra kattintva az alsó eszköztárba, megnyitjuk a kamerához
tartozó kamera specifikációs dialógust, ami a különböz? 3D-s nézetekben valamellyest más:

Perspective Full Overview Specification:
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Full Camera specification:

Na de mi a különbség?

Building tools
A building tool-ok a bal fels? sarokban találhatóak:

Ezeknek a segítségével készíthetünk el minden az épületen. Új falakat adhatunk hozzá, új szinteket, tet?t, floor és fal framinget készíthetünk.
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Az én megértésemben a building tool-oknak két kategóriája van.

Manuális: mi rajzoljuk meg a kívánt objektumot a kívánt helyen. Ilyen pl a fal rajzolás tipikusan.• 
Automatikus: A már korábban megrajzolt objektumok és a beállítások alapján a CA magától legyártja az új objektumot. Tipikusan ilyen a
tet?, az új szint hozzáadása vagy pl a framing tervek elkészítése. Ilyenkor egy gombnyomásra megszületik a kívánt objektum (lásd lentebb).
Ezeket minden esetben érdemes kihasználni, és addig állítgatni, amíg ne visz minket olyan közel az automatikus generálás a célunkhoz
amennyire csak lehet, hogy a végén minél kevesebb manuális munka legyen.

• 

Wall and railing tools
Bevezet?
CA-ben a különböz? korlátok és falak mögött ugyan az az objektum típus található. Összesen 9 féle egyenes fal típus és 6 fél korlát típus van. Ezen
felül van még 5 íves fal típus is. Még a terraion eszközkészletben lév? falak és kerítések is ide tartoznak:

Ezek mind rokonlelkek.

Pl. A Strait wall tools-ban összesen 10 elem található. A 'Wall material region' kilóg a sorból, az nem fal típus, lásd lentebb:

Strait exterior wall• 
Strait interior wall• 
Strait foundation wall• 

....

A f?kategória egy el?re definiált beállítás set-el rendelkez? falat ad a kezünkbe. Pl. a Strait exterior wall alapértelmezetten mindig rendelkezik egy
középs? strukturális elemmel, a bels? oldalon valamilyen vakolattal/gipszkarton, a küls? oldalon pedig valami szigetelés, aztán küls? vakolat. De
valójában az összes fal ugyan az az objektum típus (fal), csak úgy van el?re konfigurálva, hogy a kívánt fal típus pottyanjon ki bel?le. De bármelyik
falból konfiguráció útján tudunk egy másik fal típust el?állítani. Tehát ez a sok faltípus csak segítség nekünk.

A kiválasztott fal típust mindig egy fehér pipa jelzi hogy aktív.

Ha aktív az egyik fal eszköz, akkor elkezdhetünk falakat rajzolni. Azt hogy milyen szögbe engedje a falat húzni, és hogy ráugorjon e a fal húzása közben
más elemekre (snap) azt a jobb oldali eszköz tárban állíthatjuk be:

A legalsó szabályozza, hogy milyen szögben enged valamit mozgatni ill. rajzolni.

A lényeg hogy helyiség, (aminek vagy van padlója vagy plafonja vagy mind kett?) csak úgy jöhet létre hogy vagy valamilyen fal elem vagy korlát elem
körbe veszi. Amint zárt objektum lesz helyiség lesz bel?le. Zárt fallal vagy korláttal körbevett területnek már lehet padlója és plafonja. Bekerülhet a
helyiség listába.

Méretezés

Miközben rajzoljuk a falat, kiírja hogy milyen hosszú. Minden objektumot át lehet méretezni, de nem úgy mint az AutoCad-ben, hanem dimension

vonalak segítségével. Mikor rákattintunk egy objektumra, pl egy fal elemre (Kiválasztani valamit mindig a select eszközzel lehet: ), akkor általában
megjelennek rajta automatikusan dimension vonalak.
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Ilyenkor ha a dimension szám fölé visszük az egeret, az kezecskévé változik, jelezve, hogy ennek az objektumnak az adott dimenzió mentén történ?
méretezése elvégezhet?. Ha rákattintunk, akkor el?jön a beíró mez?:

Itt megadhatjuk, hogy pontosan az adott dimenzió mentén mekkora legyen az elem. A beíró mez? mögött van három nyíl (Van hogy csak 1, ez az elem
típustól függ). A nyíl azt szabályozza, hogy az átméretezés után melyik végéb?l vegyen el vagy adjon hozzá az objektumbank. Pl a képen látható fal
esetében ha átírnám 2000-ra akkor a bal odalát vegye kisebbre és a jobb vége maradjon helyeben vagy fordítva. A középs? nyíllal a ceneter marad
középen és mind a két végét módosítja. Mindig az az oldal marad helyben, ahol a nyíl talpa van:

Ez a bal oldalt hagyja helyben. Ez nagyon fontos falak méretének a beállításakor, hogy ne essen szét a model a rossz oldal elmozdításakor.

Ha nem jelenik meg automatikusan az a dimenzió ami nekünk kéne, akkor a Dimension toolset (: ) valamelyik eszközével hozzá kell adjuk a
dimenziót. Az alábbi képen látható dimenziót a Internal dimension-el adtam hozzá:

Ekkor most akár a baloldali, akár a jobb oldali kis falszakaszt választjuk ki, majd az egeret a dimenzió száma fölé visszük és rákattintunk, mikor
kezecskévé változik, akkor az adott falat fogja méretezni. Fontos, hogy ha az objektum (pl fal szakasz) amit méretezünk, össze van kapcsolva más
objektumokkal is, akkor az a vége, ami ki van jelölve csökkentésre vagy növelésre a kis nyilakkal magával fogja húzni a hozzákapcsolt objektumokat is.

A fenit képen átíram a 660-at 400-ra, úgy hogy a fels? oldal kis nyila volt kiválasztva. Ekkor a lenti fal követte a méretezést, ráadásul a jobb oldali fal is
átmérerezésre került! Ezért fontos, hogy mindig a jó oldalát mozgassuk a falaknak.

Specification dialog
A fal és korlát szerkesztését az objektum beállító panelen végezhetjük el (object specification dialog), amit vagy gyors dupla likk-el nyithatunk meg, vagy
ha több azonos típusú objektumot akarunk egyszerre manipulálni, akkor az alábbi ikonnal, ami a bal alsó sarokban van, ha egy objektum(ok) ki van
választva.

Minden egyes objektum típusnak (legyen az fal vagy ablak vagy tet?) van specification dialógusa. Azonban a Specification dialog tartalma mindig az
adott objektum típusra jellemz?, és olyna beállításokat tartalmaz, ami az adott objektum típuson értelmezett. Pl a tet?nek van hajlásszöge, egy falnak
nincs. A különböz? fal és korlát típusokank teljesne megegyezik a Specification dialog -ja.
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General fül

Falak és korlátok esetében a legfontosabb beállítás a generál fül els? doboza:

Itt mondhatjuk meg, hogy alapjába véve ez a fal/korlát típus micsoda. Ezek bizonyos együtt állásokban bebpipálhatók:

Semmit nem pipálunk be: ez egy alapértelmezett fal, van neki valami struktúrája középen, van neki küls? és bels? rétegrendje (de utálom ezt
a szót) (lásd Structure fül)

• 

Foundation wall: az alapot alkotó fal. Általában van neki egy footing része betonból és áll rajta egy zsalu tégla fal.• 
Railing: Ha ez be van pipálva, akkor lesz bel?le korlát vagy kerítés (ezek között csak a stílus a különbség)• 
Terraian retaining wall: Ha ez is be van pipálva, akkor ebb?l terepet elválasztó kerti fal lesz.• 
Attic wall: Ez egy nagyon fontos fal típus. A tet? szerkezet és az alatta lév? fal közötti részt kitölt? falacska, fal darabocska. Általában a roof
tool magától hozza létre, mindig az alatta lév? fal tetejét?l indul és a tet? szerkezetig megy fel. Az attic wall megjelenik a floor plan-en is,
zavaró lehet. Elrejthetjük (invisible bepipálhatjuk) vagy ki is törölhetjük, ha sehol nem látszik, tehát nem fog lyukat okozni a törlése).

• 

Structure fül

A struktúra fülön számomra a legfontosabb a Framing doboz volt:

Ha bepipáljuk, hogy ez egy Bearing wall, akkor az automatikus alap készít? fog alá rakni sávalapot, vagy alaksori falat. Ezen felül az automatikus joist
kiosztás esetén 'Bearing wall'-ról fogja indítani a joist-okat mer?legesen a teherhordó falra.

Roof

Itt az adott fal feletti tet? tulajdonságait befolyásolhatjuk. A tet?khöz 3 féle úton is eljuthatunk.

Fal szakasz feletti tet? (err?l lesz itt szó)• 
Szoba feletti tet?• 
Tet? közvetlen állítgatása• 

Alapértelmezetten egy hip roof fog létrejönni ha máshogy nem rendelkezünk err?l. (Lásd roofing fejezet)

https://wiki.berki.org/index.php/File:ClipCapIt-210326-003508.PNG
https://wiki.berki.org/index.php/File:ClipCapIt-210326-004101.PNG
https://wiki.berki.org/index.php/File:ClipCapIt-210326-223742.PNG


A roof fül els? dobozában azt mondhatjuk meg, hogy milyen tet? fajta kerül a fal fölé. Alapértelmezetten a hip-wall van bepipálva, vagyis hip-roof fog a
fal fölé kerülni:

Ha viszont valamelyik oldalon bepipáljuk a Full gable wall lehet?séget, és a tet? automatikus tet? újra generálással készült, akkor láthatjuk, hogy máris
gable-roof lett bel?le és kapott egy gable falat a kiválasztott falszakasz.

Ha a Dutch gable wall-t választjuk, akkor meg tudjuk mondani a Start at height szekcióban, hogy milyen magásságban kezd?djön a részleges galbe
fal:
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Wall type

Na ez itt kérem szépen a legfontosabb.

Fal szerkezet

Láthatjuk, hogy a fal szerkezete egy csomó vonalból áll. A falnak mindig van egy küls? és egy bels? oldala ami eltér? rétegrend? (de utálom ezt a szót :)
)

És azt is láthatjuk, hogy a dimension vonalak mind a középs?, kék részhez futnak be. A középs? kék rész a fal struktúrája, ehhez jönnek hozzá a küls?
és bels? rétegek. Mi döntjük el, hogy melyik réteg hova tartozzon, és hogy milyen rétegekb?l épüljön fel a fal.

Wall material region

https://www.chiefarchitect.com/videos/watch/5234/material-region-tools.html

Ez a testvére a Floor material region eszköznek ami a Floor tools'-ban található. Mind a kett?vel kicserélhetjük a burkolatot egy adott
objektumon. A Wall materail region-el a fal küls? vagy bels? burkolatát cserélhetjük le egy kijelölt helyen vagy ragaszthatunk rá extra
rétegeket. Az alábbi képen a falra a kijelölt helyen díszburkolatot ragasztottam.
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Ezt a hatást ebben az esetben el lehetett volna érni pony-wall használatával is, ahol meg lehet adni hogy a fal két faltípusból épüljön fel, és hogy a típus
határ milyen magasan kezd?djön. De az mindig egy egyenes vágás a falon, és a teljes fal szegmensre vonatkozni fog. Ellenben itt egy általunk bejelölt
területr?l van szó.

Fürd?szoba fal csempézése (cover wall with tile)

A legegyszer?bb ha egy 3D-s nézetben vagy egy 'Wall elevation' nézetben kiválasztunk a 'Library browser'-böl egy csempe anyagot, és ráhúzzuk a
kívánt falfelületre. Ez még akkor is m?ködni fog, ha a fal a fürd?szoba után megy tovább egy másik helyiségbe, a csempe csak egy helyiség falai által
határolt területre fog rákerülni:

Láthatjuk, hogy a csempét csak arra a falszakaszra húzta rá, ami a fürd?szobát határolja.

Warning
Ennek a módszernek az a nagy hátránya, hogy nem jelenik meg a csempe a fal anyag listájában, se a komponensek között, ezért nem fog az egyesített
anyaglistában sem megjelenni.

Ha egy falrészt külön csempével szeretnénk ellátni, akkor erre a legjobb ha "Material region"-t használunk. Ehhez válasszuk a "Wall elevation"

( ) nézetet, majd húzzunk oda egy "Wall material region"-t ahova a más szín? csempét rakni szeretnénk. (A wall tool legalsó eszköze).
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Pony wall

Railing and deck tool

Abalok és ajtók
Ablakok
Az ablakok szerintem nem elég rugalmasan konfigurálhatók a CA-ban. Az USA piacon használt ablak típusokra talán egész jó, de az európai ablak
fajtáknál már nehezebb dolgunk van.

Warning
Sajnos bukó-nyíló ablak nincs a CA-ban beépítve. (tilt and turn) ami azt jelenit, hogy homlokzat és metszet nézetben nem fogjuk a szokásos bukó-nyíló
nyilakat látni az ablakon:

A baloldali a beépített, a jobb oldalira én rajzoltam rá a bukó irányt a homlokzat nézetben.

General fül

Az ablak alapvet? típusát a General fülön a 'Window type' legördül?ben lehet kiválasztani.
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Ezek közül számunkra itt Európában az alábbiak az érdekesek:

single casement: normál, egy irányba nyíló ablak. A nyíl mutatja a nyílási irányt oldal nézetekben.• 
double casement: két felé nyíló dupla szárnyú ablak• 
Fixed glass: Nem nyitható fix ablak.• 

Az ablak valódi méretét a 'Size and Position' szekcióban kell megadni. Tehát ez a nominális méret, nem a falnyílás mérete!

Kitt kell azt is megadni, hogy milyen magasan legyen az ablak valódi alja a padló szintjét?l (tehát nem a falnyílás alsó vonala) .

Nyílási irány:

Options fül

Az ablakot be akarjuk süllyeszteni a falba, úgy hogy az ablak küls? pereme az OSB küls? vonalával legyen egy vonalba.

Casing fül

Itt be kell állítani, hogy dupla fal esetén a küls? falra ne legyen hatással az ablak. Ez akkor lehet fontos, ha közel viszünk egy másik falat, pl egy deck
alapját a falhoz, akkor az ablak ne lógjon bele a deck-be:
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Sill fül

bels? és küls? párkány, lásd alább, külön alfejezet van róla

Sash fül

A nyíló ablakkeret tulajdonságai. Itt megadhatjuk a vastagságot és magasságot:

Frame fül

Az ablak küls? keretének méretei. A 'Fit frame to wall'-ból vegyük ki a pipát, akkor nem fogja a keret a teljes falnyílást kitölteni. Az 'Inset' azt
szabályozza, hogy mennyivel tolja beljebb a keretet az ablak középvonalához képest. Ha azt akarjuk, hogy az OSB küls? síkjáig kimenjen az albak,
akkor az Inset-be be kell írni az OSB vastagságát negatív értékkel:

Lite

Ablak felület díszít? vonalak (90-es évek ablakjai)

Treatment fül

Itt lehet az ablak alá kívülr?l dísz csíkot tenni, vagy belülr?l függönyt vagy sötétít?t, adja magát.

Framing fül

Na ez a legfontosabb. Itt tudjuk beállítani, hogy hogyan készüljön a header és mekkora legyen a tényleges ablak méret. A Header beállításaiban:
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type: itt választható az LVL• 
thickness: milyen vastag legyen. Ha vékonyabb mint a framing akkor a küls? oldalra fogja rakni• 
Count: ha csak 1-et adunk meg, az a küls? oldalra fog kerülni. Ha kett?t, akkor egyet rak belülre és kívülre (box header)• 
Depth: milyen magas legyen.• 

A framiningr?l részletesen a framing fejezetben olvashatunk.

A 'Trimmer' szabályozza, hogy hogy hány Jack stud legyen az ablaknyílás két oldalán. Alapértelmezetten ez 1.

És végül a legfontosabb, hogy mekkora a valódi ablaknyílás mérete a falon az ablakhoz képest. Ezt kell úgy megadni, hogy az ablak valódi méretének
értékéhez hozzáadva az itt megadott számokat, kiadja a nominális méretet, vagyis a katalógus méreteket:

Egyedi sill (párkány)
https://youtu.be/gjX2K_jpTQg
Itt több lehet?ségünk van, de igazán jó megoldás nincsen sajnos. A küls? párkányt mindig az balak küls? függ?leges vonalától indítja a CA, és mindig
az ablak keret alsó vízszintes vonalától. A bels? sill-t pedig mindig a fal szoba fel?li vonalától indítja, sajnos nem az ablaktól, mivel arra készülnek, hogy
az ablak keret ki fogja tölteni a teljes üreget a szoba felé. Sajnos erre nem lehet hatni ha az ablak 'Specification dialog'-ban lév? sill funkciót használjuk.

Küls? párkány testreszabása

A küls? párkányt legalább mindig az ablak küls? vonalától indítja a CA, ez OK, viszont a magasságára sajnos nem lehet hatni, a párkány tetejét mindig
az ablak alsó keret aljához fogja rakni a CA, ett?l az ablakhoz beépített párkány funkcióval nem lehet eltérni sajnos. A legegyszer?bben úgy tudunk
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egyedi párkányt gyártani, ha beletör?dünk a magasságba, hogy metszeti ábrán megrajzoljuk 2D-ben a számunkra kívánatos párkány formát. Tegyünk
egy 'Blackcipped cross section'-t egy ablak közepére, hogy csak az ablak középs? része legyen a metszeten:

Majd a 2D metszeti rajzon Polyline-ból ( ) rajzoljuk meg a kívánt formát:

Praktikus a párkány formát a keret aljától indítani, mert majd a CA is oda fogja rakni. Ha megvagyunk a formával, akkor az Add to library ( )
eszközzel adhatjuk hozzá a library-hez 2D molding-ként az új párkány formát. Ekkor megjelenik a User Catalog-ban. Adjunk neki egy egyedi nevet.

Nyissuk meg az ablak Specification dialog-ját, majd menjünk a Sill fülre. Majd pipáljuk be a Use exterior sill-t és a library-b?l válasszuk ki az újonnan
rajzolt modingot.

Állítsuk be a 30mm-es túllógást. (Extend), majd mentsük el.

Láthatjuk, hogy a küls? párkány teteje egy vonalba került az ablak keret aljával, és automatikusan kivágta a falat a megfelel? mélységig, amilyen
vastagra rajzoltuk a párkányt. Nincs mód az automatikusan rajzolt párkányt feljebb hozni.

Beállíthatjuk, hogy ezt a küls? párkányt minden ablak megkapja. Nyissuk meg a Default settings-et ( ), majd menjünk a sill fülre. Itt a exterior
sill-nél válasszuk ki a a sill-adam-1-et, majd a túllógásnak állítsunk be 30mm-et. A bels? sill-t kapcsoljuk ki (oda majd manuálisan kell majd sajnos rakni)
és kapcsoljuk ki az 'Apron'-t is, ami egy kis hézag a sill alatt.
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Ez minden új ablakra már vonatkozni fog, a régiken még manuálisan kell lecserélni.

Bels? párkény tesztre szabása

A bels? párkányt nem lehet sajnos olyan egyszer?en elintézni mint a küls?t, mert azt mindig a fal bels? síkjától indítja a CA. A legjobb amit tehetünk,
hogy készítünk egy egyedi 3D-s Millwork symol-t amit hozzáadunk az ablakhoz mint bels? treetment. (Millwork: ablak díszint? elem, mindig 3d-s
formából készül). Sajnos ezt a lépést nem lehet elvégezni a default beállításokban (kis villáskulcs), minden egyes ablakra magunk kell rárakjuk.

Els? lépésben kapcsoljuk ki a bels? sill-t az ablakok. Majd egy metszeti nézetben rajzoljunk polyline-ból egy dobozt az elképzelt párkány helyére:

Majd a fels? élét kerekítsük le az alsó menüben elérhet? Filet lines-al ( ). Miután rákattintottunk, megjelenik egy almenü, ahol ki tudjuk választani,
hogy minden sarokra vagy csak egyre vonatkozzon:

Nekünk a F-et kell választani. Kattintsunk rá. Ekkor meg fog jelenni a 'Set fillet radius' dialógus ablak. Sugárnak adjunk meg 4mm-et.

Az OK gomb megnyomása után kattintsunk a bal fels? sarkára a 'Rectangular polyline'-nak, ekkor le fogja gömbölyíteni a bal fels? sarkot:

Most konvertáljuk 3D-s polyline-á a Convert polyline ( ) eszközzel. Válasszuk a 'Polyline solid' lehet?séget:

Az OK gomb megnyomása után megadhatjuk a 3D-s vastagságot, adjunk meg 25 mm-et:
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Majd nyomjuk meg az OK-ot. Most már létrehozhatunk egy 3D-s symbol-t a 3D-s polyline-ból, amit berakhatunk a library-ba. Mikor ki van jelölve,

nyomjuk meg a 'Convert selected to symbol' ( ) lehet?séget a alsó menüben. A felugró dialógusban válasszuk ki a Millwork-ot kategóriának. (A
millwork azért jó, mert be lehet állítani neki a padló szint feletti magasságát) Névnek adjuk meg, hogy 'Inner sill'.

Ha rányomunk az OK-ra, akkor bekerül a 'User library'-ba a Library browser-ben.

Nyissuk meg a Symbol specification dialógusát:

Majd itt a 3D fülön forgassuk addig a 'Rotate' gombokkal, amíg nem fog úgy állni, hogy ha behúzzuk egy ablakhoz akkor az íves rész fog kifelé állni.

Most menjünk át plan-vew-ba, majd kattintsunk az új 'Inner sill'-re a Library browser-ben. Majd vigyük az egeret az ablak bels? párkánya föl, ekkor egy
szürke csík jelzi, hogy rá tudna kapcsolódni az adott ablakra:

Most a metszeti ábrán láthatjuk, hogy az új párkányt lerakta a fal aljára, ráadásul a felirattól nem is látszik:
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Kattintsunk kétszer az 'Inner sill' feliratra. Majd a specification dialógusban a Label fülön válasszuk a 'Specify label' lehet?séget, és töröljük ki a label
tartalmát:

A general fülön írjuk be hogy milyen magasan legyen a párkány a padlóhoz képest:

Vagy akár a helyére is húzhattuk volna. Menünk át plan view-ba. A két végét széthúzva húzzuk ki az ablak nyílás széléig:

És íme a végeredmény:

Ezt sajnos minden ablakra egyenként át kell másolni.

Roofing plan
Tet?kr?l általában
A tet?t elkészíthetjük automatikusan az összes szintre egyszerre, vagy manuálisan is összeállíthatjuk. Az automatikus tet? készítésnél minden korábbi
manuális módosításunk el fog veszni, ha csak nem állítjuk be, hogy a manuális módosításokat ne törölje, oda nem rakjon új tet?t. Attól függetlenül, hogy
manuálisan építjük meg a tet?t, vagy automatikusan generáltatjuk le a CA-val, az hogy milyen paraméter? tet? fog keletkezni, azt két dolog fogja
meghatározni:

Fal tulajdonságai ami a tet?t hordozza1. 
szoba tulajdonsága (room) ami fölé kerül a tet?2. 
'Build roof' dialógusban beállított tet? értékek.3. 

Minden egyes tet?t szegmenst a CA-ban 'Roof plane'-nek hívnak. Az alábbi képen egy kijelölt 'Roof plane'-t láthatunk. Egy tet?szerkezet a sok önálló
'Roof plane'-b?l épül fel.
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Fal tet? beállításai

Minden fal 'Wall specification' dialógusában a 'Roof' fülön szabályozhatjuk hogy erre a falra milyen tet? kerüljön függetlenül a helyiség többi falától. Meg
lehet adni egy adott falra különböz? d?lésszöget vagy túllógást.

Roof options: Ez határozza meg, hogy milyen tet? forma kerül ezen fal fölé.

'Hip Wall': ez az alapértelmezett, ez azt jelenti, hogy a fal fölé ferdetet? kerül:• 

'Full gable wall': Ez egy oromfal is egyben, így nincs fölötte ferde tet?, ez háromszöget fog alkotni egy sátortet?ben.• 

' Dutch gable wall': Az oromfal nem teljes, az alján van valamekkora ferde tet?:• 

Pitch options: egyedi hajlásszöget adhatnunk meg erre a tet?re.
Overhang: Mekkora legyen a túlnyúlás és milyen módon legyen dobozolva az eresz. Ezeket 'Roof plane' szinten illetve szoba szinten is tudjuk
szabályozni

Szoba tet? beállításai

Csak olyan szoba fölé fog tet? kerülni (manuálisan vagy automatikusan) ahol be van állítva, hogy a szoba felett tet?t található. Minden helyiség 'Room
specification' dialógusában a 'Structure' fülön állíthatjuk be, hogy van e tet? az adott szoba fölött a 'Ceiling' szekcióban a 'Roof over this room' pipálóval.
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A fal magassága is kihat az elkészült tet?re, mert alapértelmezetten mindig a fels? top-plat-re fogja illeszteni a truss-okat vagy rafter-eket a tet?
szerkezetét?l függ?en, amit a 'Rough ceiling' mez?ben tudunk bepipálni.

Build roof dialógus

A 'Build roof' ( ) dialógus a 'Roof tool' kategóriában található. Itt beállíthatjuk a tet? legfontosabb tulajdonságait és a tet? szerkezet anyagát
is, ami átfedésben van a 'Build frame' dialógus 'Roof' fülével.

Roof: ezen a fülön találjuk az alap vezérl? pipáló dobozokat:

'Build roof plan': ha ezt bepipáljuk, és rányomunk az OK gombra, akkor le fogja generálni a tet?t az összes olyan szoba felett, ahol be van
jelölve, hogy van felette tet?.

• 

'Auto rebuild roof': Ha ez be van pipálva, akkor minden alkalommal ha egy falat odébb mozgatunk, akkor a CA a tet?t automatikusan hozzá
fogja igazítani. (Csak olyan tet?k esetében fog m?ködni, ahol a két alábbi retain nem jut érvényre, vagy mert be sincs itt pipálva, vagy nem
módosítottuk manuálisan a tet?t)

• 

'Retain manually drawn roof planes': Minden tet?nek van egy alap attribútuma, hogy 'Manuálisan' vagy 'Automatikusan' hoztuk létre. Ha ez be
van pipálva, akkor a manuálisan készített tet?ket nem fogja felülcsapni egy tet? újragenerálás után.

• 

'Retain edited automatic roof plans': A korábban automatikusan létrehozott tet? terveknél be lehet állítani, hogy 'Módosított', vagyis hogy mi
manuálisan belekontárkodtunk. Ha ez be van pipálva itt, akkor egy tet? újragenerálás ezeket az automatikusan létrehozott de utána
manuálisan módosított tet? darabkákat nem fogja felül csapni.

• 

Specification: itt adhatjuk meg a tet? d?lés szögét:

Itt nagyon fontos, hogy a 'Trusses (no birdsmouth)' be legyen pipálva ha truss-okat akrunk haszálni a rafter-ek helyett (lásd #Roof_trusses fejezet)

Roof height: Itt állíthatjuk be, hogy az elképzelt tet? szerkezet mennyivel kerüljön a fels? top-plate fölé. Ha rafter-ekb?l lesz a tet? (hagyományos
szerkezet) akkor ez a szám 0 szokott lenne, ami azt jelenti, hogy a rafter ráül a top-plate-re.

Ha truss-os tet?t akarunk készíteni, olyat, ahol az 'Eave' egy vonalban van a top-plat-el, ahogy a fel? ábrán is van, akkor a tet? magasságát feljebb kell
emeljük. Azt hogy mennyivel, az a d?lésszögt?l függ. A tet? magasság kés?bb a 'Roof plan specification' dialógusokban egyenként is beállítható minden
egyes tet? 'darabkára' ennél sokkal szofisztikáltabban.

Same wall height for exterior walls': ha ez be van pipálva, akkor nem fogja figyelembe venni a tet? generálás közben az egyes szobák és
falak egyéni beállításait.

• 
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Automatic birdsmouth cut: ennek csak rafter-es tet? esetében van jelent?sége. A rafter-ekre, ha framing-et is készítünk a tet?höz a 'Framing tool'-al,
akkor a CA automatikusan el fogja készíteni a seat-cut-ot, (a kivágás ahol a rafter ráül a fels? top plate-re). Enneka a paramétereit állíthatjuk itt be. Ha
truss-os tet?t használunk, akkor ennek nincs jelent?sége, 0 kell legyen.

Manual roof plane for hiproof
https://www.chiefarchitect.com/videos/watch/724/joining-roof-planes.html

Lehet?ség van rá, hogy manuálisan készítsük el a tet? formát (nem a szerkezet, az framing ügy). Mindig az a jó megközelítés hogy amit csak lehet
automatikusan generáltatjuk le a CA-val és egészen addig nem hajtunk rajtuk végre egyedi módosításokat amíg csak lehet. Ez igaz a tet?re is, de
valamennyi manuális munka mindig marad. Azért a kontyolt tet?vel kezdjük, mert abból a nyereg tet? és a ferd etet? is származtatható, azok tekinthet?
a kontyolt tet? speciális eseteinek.

Akkor is ha manuálisan rajzoljuk meg a tet?t, az el?z? pontban leírt 3 beállítás lesz hatással a d?lésszögre, az ereszre és magasságra:

fal tet? jellemz?k1. 
helyiség tet? jellemz?k2. 
'Build roof' dialógus beállítások3. 

Roof plane rajzolása

Ha minden be van állítva el?re helyesen akkor a 'Roof tools' alatti 'Roof plane' ( ) eszközzel rajzolhatjuk meg manuálisan a tet? kontúrját.
Akkor vagyunk roof plan rajzoló üzemmódban, ha a 'Roof plane' mellett egy kis pipa van:

Note
Minden tet? szegmensb?l (roof plane) csak egy kis darabkát kell megrajzolni, aztán majd a CA-val összeköttetjük ezeket a kis darabokat és a CA fogja
kialakítani a 45°-os találkozásokat a sarkokon és a találkozásokat a ride-en (gerinc)

Ekkor bármilyen fal fölé tudunk tet?t rajzolni. Els?ként a tet? alapvonalát kell megrajzolni egy szakaszon valamelyik fal 'Structural layer'-ének küls?
vonalában. Láthatjuk, hogy ha az egeret a falszerkezet küls? vonalához visszük, akkor snap-el odaugrik és egy kis piros homokóra lesz bel?le.

Ekkor megrajzolhatjuk a tet? alapvonalát párhuzamosan a fallal valamelyik irányba:

Láthatjuk, hogy ahogy húzzuk a vonalat, úgy rajzolja meg az 'Eave'-et is a fal/tet? beállításoknak megfelel? szélességben. Nekünk 900mm-re van
állítva, amit mindig a fal küls? rétegét?l számít a tet? széléig, beleértve a facial board-ot is. Majd kattintsunk.

Ezután a szoba belseje felé mozgassuk az egeret, amivel kijelöljük, hogy merre építse meg a tet? d?lését, vagyis hogy merre fusson a tet?:
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Nem kell nagyon felhúzni, csak egy kis darab kell bel?le mind a két irányban, majd kattintsunk:

Ugyan ezt csináljuk meg a mellette lév? falon is:

Ahhoz hogy tet? legyen ebb?l a két roof plane-t a CA -val össze kell köttetni egymással.

Roof plane-ek összekötése

A CA automatikusan össze tudja kötni a roof plane-eket és leszabja az élüket olyan formára, hogy kiadják a megfelel? sarkokat, ami szimmetrikus tet?
esetén 45°. Els? lépésben jelöljük ki annak a roof plane-nek azt az oldalát, amit hozzá akarunk kötni egy másik roof plane-hez. Ehhez jelöljük ki a roof
plane-t 'Plane view'-ban, az egérrel kattintsunk azon az élen lév? négyzetre, amit hozzá akarunk kötni a szomszédos roof plane-hez. Ekkor a
kiválasztott élen a kis négyzet pirosra vált:

Most az alsó menüb?l válasszuk ki a 'Join roof plans' ( ) eszközt. Ezután kattintsunk a másik roof plan azon élére amit hozzá akarunk ehhez az
élhez kötni. Ahogy az egeret az él felé visszük, snap-el rá fog ugrani és meg fog jelenni a kis piros homokóra:

Ekkor ha kattintunk a két tet? darabkát össze fogja kötni a CA és ki fogja alakítani a 45°-os találkozást:
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Ha ezt mind a négy oldalon megcsináljuk, akkor középen maradni fog egy lyuk:

Nincs más dolgunk, mint hogy a gerinceket is összekössük. Ehhez jel?ljük ki pl az alsó roof plane-nek a fel?s élét:

Majd válasszuk a 'Join roof planes' eszközt és jelöljük ki a fels? roof plan alsó élét. Az egér snap-el rá fog ugrani.

Ha kattintunk, akkor az alsó és a fels? tet? darabka össze lesz kötve középen:

Nincs más dolgunk, mint hogy a két kis háromszöget is befoltozzuk. Ehhez válasszuk ki a jobb oldali roof plane bels? élét:
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Majd válasszuk ki megint a 'Join roof planes' eszközt és válasszuk ki az alsó vagy fels? roof plane valamelyik bels? élét:

Ekkor a lyukat be fogja zárni a CA:

Komplex formák rajzolása

Ha bonyolultabb a tet? formája, akkor szükséges a roof plane vonalainak a darabolására, hogy szabadabban tudjuk formázni. Ha van egy bonyolultabb
tet? formánk, akkor egy id? után pusztán az élek összekapcsolásával már nem tudjuk a lyukakat eltüntetni. Az alábbi képen két különböz? magasságú
tet? találkozik, és a nyíllal jelölt részt ki kéne töltse a nyíl baloldalán lév?, 'X'-el megjelölt Roof plane ahogy az a 3D-s ábrán is látható.
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Azonban ahhoz hogy felegye ezt a trükk?s alakot az 'X'-el jelt roof plane, be kell iktassunk törési pontokat, hogy át tudjuk méretezni. Ehhez jelöljük ki a

Roof Plane-t, majd az alsó menüben lév? 'Break' ( ) eszközzel iktassunk be egy törési pontot a 1-essel jelölt pontjára a roof plane-nek.

Manuálisan húzzuk a 2-es csúcsot a 3-as pontba:

Most látszik hogy a 'Break' eszközzel még egy törést be kell iktatni a 3-as és az 1-es pont közé, hogy a 4-es pontba is behúzható legyen.

A törés beiktatása után megjelenik egy új pont a 3-as és 1-es között szakaszon. Ezt az egérrel húzzuk a 4-es pontban és készen is vagyunk.
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Roof plane Specification

Minden elkészült tet? darabkának, vagyis roof plan-nek van 'Roof plane specification' dialógusa, ahol az adott tet? darab összes beállítása szerepel.

Note

Az itt megtalálható beállítás a 'Default settings'-ben is ( ) el?re beállíthatjuk, és akkor minden újonnan készült tet? ugyan úgy fog viselkedni

General:

'Height/Pitch': A legfontosabb rész a general fülön a 'Height/Pitch' szekció, ahol szintén a tet? magasságát és d?lésszögét állíthatjuk be,
ahogy azt a fal/szoba/'build roof' beállításokban, csak sokkal szofisztikáltabb módon.

• 

Mind a d?lésszöget, mind a tet? magasságát 5 különböz? viszonyítási pont szerint állíthatjuk be. Az egyiket a radio választóval lock-oljuk, a többit pedig
kalkulálja a program. A jobb oldali ábrán szokás szerint mutatja, hogy melyik pont van lock-olva. Ha a tet? síkját feljebb akarjuk mozgatni, akkor az a
legjobb, ha a 'Pitch'-et lock-oljuk, és a 'Baseline height'-t írjuk át a kívánt magasságra. Azt hogy mennyit kell a tet?t fentebb vinni, a legegyszer?bben
egy cross-section view-ban mérhetjük meg:

Ha azt szertnénk, hogy a eave alja egy vonalban legyen a top-plate tetejével, láthatjuk, hogy 300mm-et kell a tet?t feljebb vinni. Jelöljük ki az összes
roof-plane-t ami ehhez a tet?höz tartozik (legyen a roof plane eszköz aktív, és ekkor a Shift + egérrel az összes roof plane-t ki tudjuk jelölni), majd a
Specification dialógban a 'General' fülön adjunk hozzá 300mm-at a 'Baseline'-hoz miközben a 'Pitch' lockolva van.
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'Measurements': itt látható hogy a roof plane (tet? szegmens) manuálisan vagy automatikusan lett létrehozva:• 

Ennek akkor van jelent?sége ha automatikusan újra akarjuk generálni a tet?ket a 'Build roof' eszközzel, ki tudjuk választani, hogy a manuálisan készült
tet?ket ne csapja felül, azokat hagyja változatlanúl.

Options:
Az Options fül tetején található az 'Eaves' szekció, ahol be tudjuk állítani, hogy dobozos legyen az ereszé, és hogy kövesse e a tet?t, vagy mer?leges
legyen a falra.

Structure: Ez a 3. hely ahol be tudjuk állítani, hogy milyen anyagból milyen osztással legyen a tet? ha rafter tet?t akarunk. A truss tet?t nem tudja a CA
magától legenerálni.

Gutter: Itt tudjuk kiválasztani az es?csatorna formáját és anyagát. Itt 2D-s formával dolgozik a CA. Ha nem találjuk a megfelel? formát könnyen
rajzolhatunk egyet magunk 2D-ben, majd Molding-ként a library-hez adjuk (lásd itt: Egyedi moaldin legyártása
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Roof plane troubleshooting

Az alábbi egy tipikus hibaüzenet két roof plan összekapcsolásakor.

Warning
"The program cannot move a roof edge to another without making one of its adjacent edges zero length or reversing it"

Ennek két oka lehet:

Nem két szomszédos élt választottunk ki az összekapcsolásra. Tipikusan induláskor a kezd? élnél könny? mellé nyúlni. Mindig a jó élen
legyen induláskor a piros négyzet és mindig a szomszédos élre kattintsunk az összekapcsoláshoz.

1. 

A kiválasztott roof plan egyik éle túl rövid, és az összekapcsolás után elt?nne. Fontos, hogy nem veszhet el él az összekapcsolás után, vagyis
egyik él sem redukálódhat 0 hosszúságrura, erre nézzünk itt egy példát.

2. 

Tegyük fel, hogy adottak az alábbi roof plane-ek. A fels?t és az oldalsót már összekötöttük, az alsóhoz kötnénk hozzá a bal oldalit.
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Ha kijelöljük a megfelel? éleket és rányomunk a 'Join roof plans' eszközre, akkor a CA nem fogja tudni összekötni a két élet, mert az alábbi bekarikázott
élet 0-ra kéne csökkentse a CA. A jobboldali képen berajzoltam az a vonalat, ami mentén létrehozná a kapcsolatot, és láthatjuk, hogy a bels? élet
tejjesen eliminálná az összekapcsolás:

Ilyenkor meg kell növelni a problémás élet, úgy hogy megmaradjon az összekapcsolás után is. A jobboldali roof plane-t húzzuk összébb, hogy a bels? él
hosszabb legyen:

És most már össze tudjuk kapcsolni a két tet? darabkát:
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Manual roof plan for gable roof
A nyereg tet? felfogható a kontyolt tet? egy speciális változatának, ahol az oromfal fel?li tet?szakaszok hiányoznak. A megrajzolásnál is ezt az elvet kell
követni. Lényegében egy olyan kontyolt tet?t kell rajzolni, ami csak két szemben lév? tet?szakaszból áll, és ezen tet?szakaszok ki vannak túl az
oromfalakon. A CA általában észre fogja venni, hogy a tet? nyeregtet?t formál, és el fogja automatikusan készíteni az oromfalakat. Ehhez egy kis hint-et
kell adni a CA-nak a falak megfelel? tet? beállításaival.
Ha a képen látható tet?t szeretnénk elkészíteni, akkor a hosszanti falak tet? beállításait "hip wall"-ra kell állítani, míg a rövid oldalakon a fal tet? típusát
"full gable wall"-ra kell állítani:

Nyissuk meg egyenként a falak "wall specification" dialógusát, és a "Roof" fülön állítsuk be "hip wall"-ra illetve "full gable wall"-ra a tet? opciókat:

Roof plan felhelyezése

Ahogy a hip roof rajzolásnál is láthattuk, készítsük el a két szükséges tet?szakasz "roof plan"-jét. Ehhez válasszuk a fels? menüben a "Roof tools"-t

( ), majd a megnyíló ablakban válasszuk a "Roof plan" lehet?séget:
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Helyezzük a kurzort valamelyik hosszanti fal küls? síkjára és bal egér lenyomása mellett húzzuk balról jobbra az egeret, ezzel kijelölve a tet? terv

alapját, ami lényegében kijelöli az adott tet?szakasz orientációját és a tet? túllógását, ami akkora lesz, ami a "Bild roof" ( ) dialógusban be
van állítva.

Nem kell hogy kapásból elhúzzuk a tet? vonalat az oromfalakig, elég egy rövid szakaszt kijelölni. Az egér felengedése után húzzuk a képzeletbeli gerinc
felé az egeret, ezzel kijelölve a tet? terv magasságát. Itt sem fontos, hogy elhúzzuk az épület középvonaláig a tet?t, azt majd a CA automatikusan össze
fogja kötni.

Láthatjuk hogy az eresznél a tet? túllógás 760mm, ahogy az a "Build roof" dialógusban be van állítva:
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Csináljuk meg ugyan ezeket a lépéseket a szemben lév? oldalon is tükrözve:

Most össze fogjuk kapcsolni a két tet?t tervet ugyan úgy ahogy ezt a hip roof-nál láthattuk. Jelöljük ki valamelyik tet? terv bels? oldalát, ekkor egy kis
piros négyzet jelzi, hogy az adott oldal ki van jeölve:
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Ekkor megjelenik a roof plan eszközkészlet a képerny? alján. Itt válasszuk ki a "Join roof plans" eszközt és kattintsunk a szemben lév? tet? terv bels?
oldalára:

Ekkor a CA automatikusan össze fogja kötni a két tet? tervet az épület középvonalánál:
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Tet? kihúzása az oromfalakig

A kívánt végeredmény eléréséhez túl kell húzni mind a két tet? tervet az oromfalakon mindkét irányban. A túllógás mértékével els? körben ne
foglalkozzunk, a lényeg, hogy mind a két irányban túlhúzzuk az oromfalon.

Második lépésben állítsuk be a túllógás mértékét. Ezt már manuálisan kell megtenni. Kattintsunk a tet? terv valamelyik oromfal felöli végére. Ekkor meg
fog jelenni az automatikus dimenzió az oromfal és a tet? széle között. Overhang beállítása a gable end-eken Ehhez jelöljük ki a roof lane gable wall
felöli végét. Kattintsunk a dimenzióra és írjuk be a kívánt értéket.
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A másik tet?tervet is húzzuk hozzá mind két irányban:
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Láthatjuk, hogy a háromszöget magától berajzolta a ca az oromfalakon, mivel korábban beállítottuk, hogy a fal tet? típusa "full gable wall".
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Manual attic walls

El?fordul, hogy a CA nem rajzolja meg automatikusan az oromfalakat, vagy mert túl komplikált a tet?tervünk, vagy rosszak a fal beállítások. Ilyenkor
manuálisan meg lehet ezeket rajzolni.

Az attikafal manuális megrajzolásához a "Roof plan view" ban menjünk arra a szintre ahol a tet? is van. Ha csak egyszintes az épület akkor ez az "A"
(attic) szint lesz.

Ha a padlás térben semmilyen manuálisan megrajzolt fal még nincs a modellben, itt semmit nem fogunk látni, de ne ijedjünk meg. Kapcsoljuk be a
"Reference display"-t a jobboldali megjelenítést menüben:

Ekkor meg fog jelenni az alsó szint teljes körvonala a tet?vel és a falakkal együtt:
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A "Straight wall tool" segítségével ( ) rajzoljuk meg a hiányzó attikafalat. Ekkor a fal egy normál magasságú falként fog
megjelenni a padlás szintjén:

A fal megrajzolása után egy figyelmeztetést fogunk kapni. A CA arra akarja felhívni a figyelmünket, hogy ha teljes magasságú falakat akarunk elhelyezni
a második szinten, akkor inkább hozzunk létre egy új szintet.

Ezt a figyelmeztetést figyelmen kívül hagyhatjuk, mivel mi kifejezetten attikafalat akarunk készíteni.

Nincs más dolgunk, mint hogy a fal típusát átállítsuk "Attic wall"-ra a "Wall specification" dialógus "General" fülén:
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Az attikafal rajzolásának az irányától függ?en el?fordulhat, hogy az új fal rétegrendjét fordítva rajzolja meg a CA, vagyis a legküls? fal réteg néz befelé:

3D nézetben jelöljük ki a hibás attikafalat:

Majd az alsó menüben kattintsunk a "Reverse Layers" eszközre: 

Ekkor az attika fal rétegrendje is a megfelel? sorrendben fog megjelenni:
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Manual roof plan for shed roof
Láthattuk, hogy a nyeregetet? egy speciális esete volt a kontyolt tet?nek a CA-ban. A shed roof (ferde tet?) egy speciális esete a nyeregtet?nek (gable
roof). Ez egy olyan nyeregtet?, aminek csak egy oldala van megrajzolva, és a gerinc túlnyúlik a szemközti falon. Manuálisan megrajzolni is ebben a
szellemben kell.

A fal tet? beállításai abban különböznek a nyeregtet?t?l, hogy a ferde tet? magasabbik oldalán a fal tet? típusát "hip roof"-ról "High Shed/Gable wall"-ra
kell állítani.

Ha megvagyunk a falak tet? beállításaival, akkor a tet? megrajzolását az alacsonyabbik oldalon kell kezdeni a megszokott módon, els?nek az
alapvonalat rajzoljuk meg, majd behúzzuk a tet? tervez az épület közepe felé:
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Majd második lépésben húzzuk túl a tet?t tervet a szemközti fal vonalán és jobbra balra is húzzuk túl az oromfalakon.

Láthatjuk, hogy a CA automatikusan berajzolta az attikafalakat mind a három oldalon:
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Most a megfelel? tet? terv kis piros négyzetek kijelölésével beállíthatjuk a túllógás mértékét mind a három oldalon (a tet? alapvonalában nem kell ezt
megtenni, mert ott a túllógás a "Build roof" beállításokból jön). A megjelen? temprális dimenziókra kattintva beállíthatjuk a helyes értéket:

Ha az attikafalakat nem generálja le automatikusan a CA, akkor ugyan úgy kell ?ket manuálisan megrajzolni a tet? három oldalán, ahogy ezt az
oromfalak esetében láthattuk a nyergtet?nél.

Automatic roof plane
Hogyan m?ködik

A tet?t els?sorban automatikusan kell elkészíttetni a CA -val, majd ha az nem tökéletes, akkor kezdjük kézzel alakítgatni.

A tet?t a 'Build roof' ( ) eszközzel tudjuk legeneráltatni. Ugyan itt kell az alapbeállításokat is elvégezni a manuális tet? készítéshez. Itt a
'General' fül tetején találhatjuk a lényeget:

Ha bepipáljuk a 'Build roof planes' pipáló dobozt, majd rányomunk az OK gombra.

Note
Ahogy minden generáló eszköz a CA-ban, a 'Build roof' is olyan, hogy ha nem pipáljuk be a 'Build roof planes' opciót és úgy nyomunk rá az OK gombra,
akkor csak jóváhagytuk az általános tet? beállításokat is. Ha viszont bepipáljuk, és úgy nyomunk rá, akkor ezzel nem beállítottunk valami fajta
tulajdonságot, hanem utasítottuk a CA-t hogy most mehet a generálás. Ha újra megnyitjuk a 'Build roof' eszközt, akkor ez a pipáló nem lesz bepipálva
azért mert korábban már generáltunk. Tehát ez úgymond csak 'runtime' vonatkozik, csak azt szabályozza, hogy az OK gomb aktuális megnyomása mit
csináljon. A többi beállítás viszont a 'Build roof'-ban megmarad, az OK megnyomása elmenti

Az OK megnoymása minden olyan szoba fölé, ahol be van állítva a szoba beállításaiban a 'Structure' fülön, hogy legyen tet? felett:

El fogja készíteni automatikusan a teljes tet?t. A tet? tulajdonságait megint csak 4 dolog befolyásolja:

Fal beállítások 'Roof' füle1. 
Szoba beállítások 'Structure' füle.2. 
'Build roof' dialóg beállításai3. 
Default beállítások 'Roof' menüpontja4. 

Ezek egyvelegéb?l követve azon szobák falainak a vonalát le fogja a CA automatikusan generálni a tet?t, ami még egész komplex formák esetében is
sikerül neki.
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Ha megnyitjuk egy legenerált tet? szegmens (roof plane) beállításait, akkor a 'General' fülön a 'Measurements' szekcióban láthatjuk, hogy ez a tet? CA
által generált:

Ha itt bepipáljuk, hogy 'Mark as edited', akkor lehet?ség van rá, hogy az automatikusan újra generált tet? ezt a tet? darabot (roof plane-t) ne csapja felül.
Lásd következ? fejezet.

Korábbi módosítások megtartása

Ahányszor rányomunk, bepipáljuk a 'Build roof plane' dobozt és rányomunk az OK gombra, az összes korábbi tet?t ki fogja dobni a CA és a helyére
autó generált tet?t fog rakni. Ezt kétféle képen akadályozhatjuk meg a 'Build roof' dialógusban a 'General' fülön:

'Retain manual drawn roof planes': Minden tet? szegmensnek, vagy roof plane-nek NEM megváltoztatható tulajdonsága, hogy manuálisan
vagy automatikusan generált. Ha ezt bepipáljuk, akkor semmilyen manuálisan létrehozott tet? szegmenst (roof plane-t) nem fog felülcsapni.

1. 

'Retain edited automatic roof plan': Automatikusan generált tet?k esetében a beállításokban a 'Measurements' szekcióban a 'General' fülön be
lehet pipálni, hogy manuálisan mi átállítottuk az auto generált tet? szegmenst. Ha ezt bepipáljuk, akkor ezen tet?k darabokat sem fogja
bántani.

2. 

Orom falak kezelése (Gable roof)

Alapértelmezetten hip roof-ot fog készíteni a CA minden szoba fölé.

Ha Gable roof-ot akarunk készíteni,

akkor azon a falon, ami fölé a 'gable wall'-t rakni akarjuk, implicit be kell állítani, hogy a felette lév? tet?ben a fal típus 'gable wall', vagyis oromfal.

A 'Build roof' dialógus utolsó fülén (Roof style) az összes tet?t típusra mutat egy példát, és ha rákattintunk le van írva, hogy hogyan kell a CA-ban az
adott típust elkészíteni:
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Ha van egy ilyen modellünk:

Ahhoz hogy ezt átalakítsuk Gable roof-ra, valamelyik falnak nyissuk meg a Specification dialógusát, majd menjünk a 'Roof' fülre. Itt a 'Roof option'
szekcióban állíthatjuk be, hogy a fal felett milyen típusú tet? legyen.

Ha a fenti kis ház egyik falát átállítom 'Full Gable wall'-ra, majd megnyitom a 'Build roof' eszközt és bepipálom hogy 'Build roof planes' majd ok, akkor a
CA újra fogja generálni az összes tet?t, és az átállított fal fölé 'Gable roof'-ot fog tenni.

Note
A roof típusának átállítása csak akkor jut érvényre, ha újra generáljuk a tet?t a 'Build roof' eszközzel

A két roof plane-t a Gable wall két oldalán még kihúztam az oromfal fölé, hogy legyen ott is túllógás. Íme:

Az CF létrehozott egy úgynevezett 'Attic wall'-t az alsó fal felett, amin beállítottuk, hogy a tet? 'Full gable wall' típusú. Az Attic falakat a CA rendszerint
automatikusan hozza létre a falak és a tet? közötti sík kitöltésére, lásd a következ? fejezet.
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Attic wall
Gable wall (orom fal)

A padlás fal egy különleges állat fajta, amit általában a CA hoz létre automatikusa. Ha a tet? valahol nem ül rá az alatt lév? falra, akkor a CA a
felmaradó helyett automatikusan ki fogja tölteni úgynevezett 'Attic wall'-al, ami egy kis faldarab, ugyan olyan típusú mint az alatta lév? f?fal.

Pl mikor 'Gable roof'-ot csinálunk valamelyik oldalon (lásd el?z? alfejezet példája), akkor a tet? alatti kis háromszöget ki fogja tölteni a CA egy 'Attic
wall'-al:

Az 1-es falon beállítottuk a 'Roof' szekcióban, hogy a fel felett található tet?höz 'Gable wall' tartozik, vagyis 'Gable roof' van felette, nem 'Hip roof':

Ha megnyitjuk a képen látható automatikusan generálódott háromszög fal tulajdonságait, akkor a 'General' fülön láthatjuk, hogy a fal típusa 'Attic wall':

Ez nem összekeverend? a fel feletti tet? falának típusával. Ezen fal felett már nincs még egy tet?, tehát az 'Attic wall' beállításaiban a 'Roof' fülön már
irreleváns mi van, alapértelmezetten 'Hip roof', de mindegy is:

Hip roof alatti fal

Ha valahol a 'hip roof' nem éri el a top plate-et, akkor a CF oda is automatikusan generálni fog egy attic falat. Az alábbi képen a teljes tet? 300mm-el
feljebb van emelve, ezért egy ilyen magasságú 'attic' falat generált a CA:
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A fal típusa meg fog egyezni az alatta lév? fal típusával, amit természetesen átállíthatunk, de akkor azzal felrúgjuk az automatikusan generált roof

plane-t. Ez a fal 'Attic' szinten is látszik, vagyis ha a legfels? szinten még túlnyomjuk egyel a szint állítót: 

Át tudjuk állítani a fal beállításaiban, hogy csak egy vonalnak mutassa, vagy ki is tudjuk törölni ha nincs rá szükségünk. Ha pl truss-okat akarunk a
tet?be rakni rafter-ek helyett, akkor nincs szükség ezekre az attic falakra.

Manuális attic wall

Ha valamilyen okból a tet?t magasabbra kell rakni mint a födém síkja, akkor az attic fal nem láthatatlan helyen van, hanem tényleg kitölti az eresz doboz
és a fal fels? része közötti helyet:

Ha van egy szobánk, ami alacsonyabb mint a többi szoba, hogy helyet adjunk a plafonban az erkély szigetelésének, de a tet?t ugyan olyan magasra
kell rakni mint a többi szobán van:

Akkor a szoba fala és a tet? eresz doboza közé kell egy attic falat rakni:

Ez fels? nézetben az erkély körül a második szint plan view-ban csak szaggatott vonallal van megjelenítve, mert átállítottam a fal típusának a
megjelenítését (egyedi fal típust definiáltam ide) a falhoz tartozó 'Wal type' definition dialógusban.

Láthatjuk, hogy minden réteg megjelenítését kikapcsoltam a 'Line style' oszlopban, kivéve a legküls?t, aminek a vonal típusát átállítottam szaggatott
vonalra:

https://wiki.berki.org/index.php/File:ClipCapIt-210425-123845.PNG
https://wiki.berki.org/index.php/File:ClipCapIt-210425-224831.PNG
https://wiki.berki.org/index.php/File:ClipCapIt-210425-224948.PNG
https://wiki.berki.org/index.php/File:ClipCapIt-210425-224934.PNG
https://wiki.berki.org/index.php/File:ClipCapIt-210425-225025.PNG
https://wiki.berki.org/index.php/File:ClipCapIt-210425-230519.PNG
https://wiki.berki.org/index.php/File:ClipCapIt-210425-230608.PNG
https://wiki.berki.org/index.php/File:ClipCapIt-210425-230816.PNG
https://wiki.berki.org/index.php/File:ClipCapIt-210425-230853.PNG
https://wiki.berki.org/index.php/File:ClipCapIt-210425-230946.PNG
https://wiki.berki.org/index.php/File:ClipCapIt-210425-231038.PNG


Dimensioning roof plan
Gerinc hosszának megjelenítése

A felülnézeti ábrákon nem tudjuk megmérni a 45°-os gerincek és vápák hosszát, csak a vízszintes gerincek és fal csatlakozások hosszát tudjuk
megmérni.
A képen megjelölt gerincnek a hossza valójában nem 3000 mm, hiszen a megjelölt vonal csak a 2D-s síkra vetietett reprezentációját látjuk, ami értelem
szer?en rövidebb mint a gerinc alódi hossza.

A valódi hosszat úgy láthatjuk, ha készítünk egy metszet a gerinc síkjában:
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Ennél sokkal egyszer?bb megoldás, ha kijelöljük a roof plan egy a gernci/vápa melletti darabját úgy, hogy a gerinc felöli vonala legyen kijölve (piros
négyzet jeöli):

Most nyissuk meg a roof plane specifikációját, és válasszuk a "Selected Line" fület. Ekkor a gerinc valódi hossza a "Length At Pitch" mez?ben lesz.

Láthatjuk, hogy a projected line hossza is fel van tüntetve, azt a hosszt láthattuk korábban a 2D felül nézetben.

Most még át kell írnunk a felülnézetben szerepl? hosszt a valódi hosszra. Ehhez jelöljük kia projected line-ra rakott dimenziót, majd az alsó menüben

válasszuk ki az "Add aditional text" eszköt ( ). Ezután kattintsunk megint a dimenzió szövegére, és a felugró abalkban már át tudjuk írni az értékét
a gerinc tényleges hosszával. Pipáljuk be a "Suppress dimenison value" dobozt és a valódi hosssz értéket írjuk a "Leading text" mez?be.

Note
A material list-ben a CA teljesen pontosan megmutatja a gerinc elemek teljes hosszát (ridge cap), csak a vápa hosszakról nem tesz említést, elég csak
azokat külön kiszámolni

Tet? d?lésszöge

A CA miden roof plan-en meg tudja mutatni a d?lés irányát és a d?lés szöget is:
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Ezért a Roofs, labels réteg felel?s. A d?lésszög címke méretét ez a réteg fogja meghatározni.

Ha át akarjuk állítani a címke méretét, jelöljük ki a réteget, majd a bal alsó sarokban állítsuk át a szöveg típust.

Dimenzió színe és mérete

...TODO...: Dimensions, Roof

Angular dimension címke átírása

Az angular dimension címkéjét úgy tudjuk átírni, hogy mid két objektumot/vonalat kijelöljük, amik a szöget bezárják.

Ekkor, ha a szöget jelöl? vonal fölé visszük az egeret, piros homokórát jelöl majd a kurzor.

Ha rákattintunk a vonalra, megjelenik a dimenzió címkéjének beíró mez?je.
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Ceiling plan
https://www.chiefarchitect.com/videos/watch/69/ceiling-basics.html?playlist=124

Foundtaion

Materials and symbols
Áttekintés
A 'Library browser'-ben lényegében az alábbi 4 típusú elem található meg:

CAD blokkok: El?re legyártott 2D-s CAD rajzok, amiket több tervben is fel akarunk használni. Elég sok gyári, beépített CAD block található a
CA-ban.

• 

Képek, rajzok: JPG, PNG vagy más ismert kiterjesztés? kép típusok, amiket háttérnek tudunk felhasználni a 2D-s és 3D-s nézetekben• 
Anyagok (Materials): Az anyagok speciális attribútummal rendelkez? CA objektumok, amiknek van külön 2D és 3D-s megjelenése.• 
Szimbólumok (Symbols): A CA-ban 15 beépített szimbólum típus van, mindegyik más tulajdonsággal rendelkezik. Pl. a 'Molding' 2D
k?rvonallal rendelkez? forma, amit képes a CA 3D-be kihúzni. A 'Millwork' pedig olyan 3D-s forma, amival az ablak alatti és fölötti részt tudja
dekorálni a CA. De ide tartozik minden 3D-s objektum, köztük a bútorok, ajtók, ablakok, gerenda akasztók, stb..

• 

Itt most az utóbbi kett?r?l lesz szó.

Mik azok az anyagok
Az anyagoknak nagyon fontos szerepe van még a nem látszó komponensekben is két okból:

A végs?, pontos anyaglistába a nem látszó elemek is belekalkulálódnak (beton alap, faváz, OSB borítás, stb)• 
Az anyag típusa határozza meg az anyag viselkedését, és hogy milyen módon kalkulálja a CA a szükséges mennyiséget (darabszám, terület,
térfogat)

• 

Kétféle anyaglistánk lehet. Egyrészt vannak a 'Library'-ba rakott anyagok, amik minden Plan'-be elérhete?ek, ezeket a jobb oldali 'Library browser'-ben
láthatjuk:
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És vannak anyagok, amik csak egy adott plan-ben belül léteznek, ezeket dinamikusan hoztuk létre egy anyag kiválasztása közben valamelyik
specifikációs dialógusban:

Az anyag kiválasztó ablakokban a 'Plan Materials' fülön láthatjuk az összes anyagot ami egy adott plan-ben szerepel. Ha itt rányomunk, hogy 'New'
vagy 'Copy' akkor az újonnan létrehozott anyag kizárólag az adott Plan -ben lesz elérhet?, nem fog bekerülni a 'Library browser'-be.

A 'Library browser'-ben felül láthatjuk a gyári, beépített anyagokat, és alul 'User Catalog'-ban az általunk létrehozott anyagokat:

Anyag típusok szerkesztése
Két lehet?ségünk van egy anyag 'Define Material' dialógusának a megnyitására.

Valamelyik 3D nézetben az 'Adjust Material Definition' ( ) eszközzel kiválasztjuk azt a felületet, ami azzal az anyaggal van bevonva, amit
szerkeszteni szeretnénk. Ennek az a hátránya, hogy az összes el?fordulása az anyagnak meg fog változni.

1. 

A másik lehet?ség, hogy lemásoljuk az anyagot a 'User Catalog'-ba, és akkor már meg tudjuk közvetlen nyitni az anyagtulajdonságokat a
'Library Brower'-b?l. Érdekes módon a beállításait csak a 'User catalog'-ba lév? anyagoknak tudjuk közvetlen megnézni. Ide vagy úgy kerül
anyag, hogy újat hozunk létre, vagy egy meglév?t lemásoljuk, és akkor már be tudjuk rakni ide.

2. 
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A 'User catalog'-ban lév? anyagokon már meg lehet nyitni a 'Define Material' dialógust, ahol az anyag tulajdonságait tudjuk beállítani.

CA 12X-ben a 'Material list' fülön található a 'Material Structure type', ami az alapvet? viselkedését határozza meg egy anyagnak.

6 darab beépített anyag típus létezik, és mindegyiknek más tulajdonságát állíthatjuk be:

Air Gap: Légrés típus, nem fogja beszámolni az anyaglistába• 
Concrete: Köbméterben fogja számolni, és fog hozzá alapértelmezett vasalatot is számolni a CA.• 
Framing: Ha a fal egy layer-e olyan anyagból van, ami Framing típusú, akkor alapértelmezetten az itt definiált paraméterek szerint fogja CA
elkészíteni a favázat.

• 

Masonry: Tégla falak létrehozására, számolni fog a téglák közé kerül? malterrel is.• 
Steel framing: Ugyan az mint a Framing, csak fémre.• 
Other: Minden más, ami nem igényel speciális bánásmódot, az anyagok nagy része ide tartozik.• 

Framing típus

A CA-ban a falak, a födém, a plafon, a padló és a tet? rétegekb?l épülhet fel, amiket mi definiálhatunk különböz? specifikációs dialógusokban. Ha az
el?bb felsorolt elem típusok (fal, födém stb..) tartalmaz olyan réteget ami 'Framing' típusú anyagból készült, akkor a CA tud hozzá vázszerkezetet
generálni (fémet vagy fát). A vázszerkezet alapértelmezett jellemz?i (OC-OnCenter kiosztás, anyag átmér?) az anyaghoz beállított paraméterekb?l
fognak jönni.
A CA-ban alapértelmezetten, a 'Library Browser'-ben 8 féle 'Framing' típusú anyag található.
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Ezek közül is a 16" OC fém és fa stud valamint a 24" OC (OnCenter) fém és fa stud anyagok a legfontosabbak. Ha ezeket lemásoljuk és beillesztjük a
'User Library'-ba, akkor meg tudjuk nézni az anyagtulajdonságokat. A lényeg az utolsó fülön van (Materials List), itt láthatjuk, hogy a 'Material Structure
type' az 'Framing'. Ezen felül a 'Material List Calculation' is 'Framing' típus, vagyis az anyag lista kalkulációban nem a fal felületével vagy térfogatával
lesz beleszámolva, hanem a kiosztásnak (OC) megfelel? mennyiség alapján.

Láthatjuk, hogy a 'Spacing OC' értéke kb 10", ami furcsa mert az anyag nevében benne van a 16". De a lényeg, hogy az itt beállított stud kiosztást fogja
megkapni a réteg, ha a 'Framing' fejezetben leírtak szerint generáltatjuk a CA-val a vázszerkezeteket. Itt létrehozhatunk nekünk megfelel? kiosztást
minden szükséges rétegre. Az anyag szélességét itt állíthatjuk be, az anyag mélységét pedig a layer fogja meghatározni, amihez az anyagot rendeljük.
A 'Build Framing' eszközben a 'Wall' fülön, ha be van pipálva a 'Use wall framing material' doboz, akkor a vázszerkezet generálásakor a fal szerkezet f?
rétegének anyagát (középs? réteg) fogja figyelembe venni, nem az itteni beállításokat.
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OSB anyaga (egy jó kis példa)
Az OSB-hez három anyagi is tartozik a 'Library browser'-ben:

Ha az egyiket lemásoljuk a 'User Library'-be, akkor meg tudjuk nézni a beállításait. Ha leszedjük a rétegeket az egyik OSB réteggel is rendelkez? falon
a 'Remove Surface' eszközzel, akkor megjelenik az OSB borítás, horizontális anyagtípus esetén tényleg horizontális kiosztással.

Azonban amit látunk, az csak egy anyag minta, ami definiálva van az 'OSB Horizontal' anyag beállításaiban a 'Texture' fülön:
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Ha a 'Materials List' fülön megnézzük az anyag típusát, akkor láthatjuk, hogy a 'Material Structure Type' értéke 'Other' és a 'Materials List calculation'
értéke 'Count', vagyis darabszámban és nem m2-ben fog az anyag lista kalkulációban szerepelni. Ezt átállíthatnánk négyzetméterre is.

Itt tudjuk beállítani az OSB lemez pontos méretét, ami azért fontos, mert innen fogja tudni a CA, hogy hány lemezre van szükségünk, a kirajzolási
méretnek ehhez semmi köze.

Tehát az OSB megjelenítésekor látható minta csak egy pattern, a CA nem tudja intelligensen, a Framing kiosztáshoz hasonlóan elkészíteni az OSB
kiosztást. Persze a 'Texture' fülön, a 'Scale' szekcióban be tudjuk állítani a pattern pontos méretét, de (ami egy tábla széles és két tábla magas), de ett?l
még nincs garancia, hogy az tényleg helyesen lesz illesztve a vázra, csak a méret lesz pontos.
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Egyedi material hozzáadása
https://www.chiefarchitect.com/videos/watch/10145/creating-custom-tile-materials.html

Egyedi objektumok és formák legyártása (Symbol)
Áttekintés

Ahogy láthatjuk a beépített gyári library-ban vannak 2D és 3D objektumok is. Ahogy én megértettem, a 2D-s objektumokat mindig extrúdálással
alkalmazza a CA. Pl ha van egy ilyen formájú 2D-s objektumunk, tudunk bel?le csinálni egy ilyen 3D-s ablak párkányt automatikusan:

CA terminológiában ezeket a 2D-s rajzokat Molding-nak hívják, és lényegesebb kevesebb beállítási lehet?sége van minta 3D-s library objektumoknak,
amiket CA terminológiában Symbol-nak hívnak. A symbol-nak mindig van egy kategóriája, ami meghatározza a viselkedését, paraméter listáját, és
hogy milyen objektum típushoz lehet hozzárendelni. Pl az ablakok alá, fölé lehet rakni díszít? elemeket (Millwork), de ehhez olyan symbol-t kell
választani, ami a millwork kategóriába tartozik. Az alábbi symbol típusok léteznek a CA-ban:

Mikor létrehozunk egy új symbol-t akkor ezek valamelyikébe kell berakni. A pontos felhasználhatóságát az fogja meghatározni, hogy milyen kategóriába
tartozik.

Példa 2D symbol felhasználásra:
Az ablakok Specification dialogjában a Casing fülön ki lehet választani, hogy kívülr?l, ill. belülr?l milyen dísz kerete legyen az ablaknak.

Itt a library-ból tudunk választani vagy beépített vagy általunk definiált casing-et. Ha rákattintunk a library gombra, láthatjuk, hogy csak olyan elemeket
fog felhozni a library-ból amik megfelelnek az ablak ezen tulajdonságának, vagyis az ablak kerethez csak 2D-s formák fognak passzolni:

Példa 3D symbol felhasználásra: Szintén az ablak dialogósuban található a Treatment fül. Itt az ablak köré rakhatunk díszít? elemeket, de csak 3D-s
formákat és azon belül is csak olyanokat, amiknek Millwork a kategórája.
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Ha rákattintunk a library gombra, akkor láthatjuk, hogy csak olyan elemek közül választhatunk a library-ból, aminek 'Millwork' a típusa.

Egyedi 2D molding legyártása

2D-s molding-ot vagy egy CAD view-ban vagy a plan view-ban is csinálhatunk valamilyen vonal rajzoló eszköz segítségével:

Csak 2D-s polyline-t lehet molding-ként hozzáadni a library-heh. Ezért vagy eleve polyline-ból indulunk ki, vagy két lépésben egy nem polyline rajzból
csinálunk egy 2D-s plolylent.

Polyline formát a legegyszer?bben a Rectangular polyline eszközzel csinálhatunk.

Ez azért praktikus, mert elég gazdagon manipulálható a forma.

A másik lehet?ség, hogy pl kiindulunk egy Box-ból:

Majd két lépésben konvertáljuk 2D-s polyline-á. Els?re jelöljük ki a formát, majd a megjelen? alsó menüben kattintsunk a Convert Polyline eszközre:

( ). A megnyíló dialógban válasszuk a Molding polyline lehet?séget:

Majd a Convert to plain polyline eszközzel konvertáljuk 2D-s polyline-ra.

Ha valamelyik fenti módszerrel el?állt a 2D-s polyline-unk, akkor az Add to library ( ) eszközzel adhatjuk 2D-s molding-ként a library-hoz. Ekkor a
Library browser-ben meg fog jelenni a User catalog alatt Molding néven:

Ezt át tudjuk nevezni jobb click-el. Ezeket a 2D-s molding-okat minden olyan helyen el tudjuk sütni, ahol 2D-s formát vár a CA, pl az Ablak dialóg-ban a
Casing fülön.

3D-s symbol létrehozása

A 3D-s symoblhoz mindenképpen 3D-s objektumot kell létrehozzunk. Ehhez a legjobb ha 3D-s formából indulunk ki, amihez a legjobb ha a Primitive
tool valamelyik elemét használjuk fel.
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Ha megrajzoltuk a kívánt formát, akkor ha ki van jelölve az adott forma, az alsó almenüben a Convert Selected to Symbol ( ) eszközzel rakhatjuk
be a library-ba. Ha rányomunk megnyílik a Convert to library dialógus.

Itt ki kell válasszuk, hogy milyen kategóriába essen az új symbol. Ha bepipáljuk, aShow advanced options-t, akkor mentés el?tt meg fognak jelenni a
részletes beállítások ahol finomhangolhatjuk a symbol-t:

3D fül: A Rotation szekcióban állíthatjuk be az irányát. Ez azért fontos, mert ha széthúzza majd a CA a formát, hogy passzoljon a kívánt
helyre, nem mindegy ezt melyik tengely mentén teszi meg.

• 

2D fül: Itt állíthatjuk be, hogy a 2D-s plan view-kont hogyan jelenjen meg az elem. Választhatunk a meglév?k közül, vagy generálhatunk neki
egy újat is.

• 

Sizing fül: Itt állíthatjuk be, hogy hogyan húzza szét a formát a CA mikor a helyére rakja. A Stretch planes határozza meg, hogy milyen
tengely mentén hogyan húzza szét. Pl ha bepipáljuk a 'Width' - '1' -'X'-et, amit 0-ra rakunk, akkor az X tengely mentén pont az objektum
közepén lesz az a vonal, ami mentén majd a két irányba széthúzza.

• 

Err?l részletesebben a CA blogokban lehet olvasni.

A 3D-s symbol is meg fog jelenni a Library browser-ben a User catalog alatt:
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3D objektumok importálása
Ha valamilyen objektum típusunk hiányzik a 'Library browser'-b?l, de rendelkezésre áll a 3D-s modellje valamelyik ismert 3D modellez? formátumban (pl
DWG) akkor nagyon egyszer?en hozzáadhatjuk a CA library-hez és utána szabadon, méretarányosan használhatjuk a modellben.
Pl. A Simpson gerenda akasztókhoz szabadon letölthet? a DWG modell a Simpson weboldaláról:

A letöltött DGW fájlt szombólumként a CA katalógusba az alábbi menüponton importálhatjuk be: 'File -> Import -> Import 3D symbol'

Miután tallóztuk a DWG fájlt az 'Import 3D symbol' dialógusban állítsuk be a nevét, amivel a katalógusban szerepelni fog, állítsuk be a kategóriáját
(gerenda akasztó lévén itt vállaszuk a 'Hardware' kategóriát), és pipáljuk be a 'Show advanced options' lehet?séget is.
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Ez után megnyílik a 'Symbol specification' dialógus 5 tab-al. Az els? fülön állíthatjuk be a nevet, mértékegységet (mm)

A '2D block' fülön állíthatjuk be hogy hogyan jelenjen meg 'plan view'-ban a szimbólum. Itt a legegyszer?bb ha bepipáljuk az 'Auto generate'
lehet?séget, ekkor a CA gyártja nekünk a 2D formát a 3D forma alapján. Itt választhatnánk egy el?re legyártott CAD rajzot is, ha az automatikus nem
megfelel? számunkra.
Az 'Options' fülön mindig az adott kategóriának megfelel? lista jelenik meg. A 'Hardware' kategóriában ki tudjuk választani hogy milyen típusú hardvert
szeretnénk importálni, és láthatjuk, hogy kiválasztható a 'hanger' típus:
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A 'Sizing' fülön állíthatjuk be a modell méretét. A Simpson weboldaláról letöltött modellek teljes mértékben méret helyesek. Ha egy modell nem lenne
megfelel? méret?, itt át tudjuk méretezni.

Ha megvagyunk, akkor az új szimbólum 'User catalogue' gyökerébe fog kerülni. Ajánlatos létrehozni gyártónként mappákat és abba tenni az adott
gyártóhoz tartozó szimbolumot:

2D objektumok importálása CAD rajzokba
File -> Import -> Import drawing (DWG, DXF)

..TODO...

.. Hogyan kerül be a library-ba??
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Framing
https://www.chiefarchitect.com/videos/watch/73/framing-basics.html?playlist=93
https://www.chiefarchitect.com/support/article/KB-00907/specifying-the-on-center-spacing-for-wall-framing.html
https://www.chiefarchitect.com/videos/watch/334/framing-walls-with-different-studs-and-variable-stud-spacing.html

Bevezet?
A framinget a CA generálja ki automatikusan, amit mi utólag magunk tudunk finom hangolni. Alapjába véve a framing egy automatikus, reprodukálható
m?velet kell legyen. A CA ki tudja generálni a falak, a födém vázszerkezetét is. Ehhez a 'General framing tools'-on belül a Build framing

( ) eszközt kell választani. Persze a CA csak olyan fal típusra tud vázszerkezetet generálni, aminek a main layer-ében 'Framing'
típusú anyag van (lásd Materials' fejezet).

A dialógus bal oldalán azon elemek listáját láthatjuk, amiknek a vázszerkezetét a CA automatikusan ki tudja generálni, vagy újra tudja generálni:

A falak, az els? és a másodok szint födémjét, valamit a tet?szerkezetet képes automatikusan újra generálni a CA minden alkalommal, ha azok formája
megváltozik.

Egy adott kategórához úgy generálhatunk vázszerkezetet, pl a falakhoz, hogy kiválasztjuk a Wall fület, majd bepipáljuk a 'Build wall framing' dobozt és
rányomunk az OK gombra.

Ekkor az épület minden falába újra fogja generálni a CA a framing-et, kivéve azokban a falakban, ahol beállítottuk, hogy ne generálja újra, vagy
egyáltalán ne generáljon.

Ugyan ez igaz a födémre és a tet?re is. Ott be kell pipálni, hogy 'Build ceiling framing' illetve 'Build roof framing' dobozt és meg kell nyomni az Ok
gombot. Ekkor minden olyan plafonban illetve tet?ben újra fogja generálni a vázszerkezetet, ahol nem volt ez explicit kikapcsolva.

.. Attól még hogy egy falat egybe rajzolunk meg, pl ami végig fut a ház teljes oldalán, a fal magassága követni fogja minden szakaszon az alapot és az

adott szoba plafon magasságát. A framing ezt le fogja követni, tehát nem kell szétvágni a wall break-el ( ) szétvágni szakaszokra a falat, csak akkor
ha külön fal terven szeretnénk látni azt a Project browser-ben.

Mind az Orthographic mind a Perspective nézetnek van framing változata
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Ezek igazából nem speciális nézetek, csupán olyan layer beállítást töltenek be, hogy csak a framing látszik, tehát ez egy segéd eszköz, hogy ne nekünk
kelljen ezt átállítani.

Ezek a '3D framing layer set'-et töltik be, ezt bármilyen view-ban mi is bekapcsolhatjuk, hogy a framing-et megmutassuk.

Bármelyik cross-section view-ban is tudunk framing-et mutatni. Ehhez a legjobb a Backclipped cross section view, mert mivel a framing átlátszó, nem
fog bezavarni a hátrább lév? fal váza. Tehát oldalról húzzuk a backclipped cross section view-t a falhoz floor plan-bne úgy, hogy a mélység a fal
vastagságával egyezzen nagyjából meg:

Majd a megnyíló section view-ban válasszuk ki a '3D framing layer set'-et:

Ekkor meg fog jelenni a framing is section view-ban:
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Generate wall framing
https://www.youtube.com/watch?v=MWx-xNY6uss
https://www.chiefarchitect.com/videos/watch/332/editing-the-wall-framing-detail.html

Alapok

A fal favázát a 'Build framing' dialógus Wall fülén tudjuk generálni a teljes épületre, vagy ha már korábban generáltunk akkor újra generálni.

Ehhez csak be kell pipálni a 'Build wall framing' lehet?séget, majd az OK gombra kattintunk.

Ekkor minden olyan falban, minden olyan rétegre, amiben van van 'Framing' típusú anyag és amelyik falban a framing generálás nem volt explicit
kikapcsolva (lásd lentebb) újra fogja generálni a framinget minden rétegre, és minden korábbi manuális framing változtatás el fog veszni.

Csak olyan falakban fog vázszerkezetet generálni, amiben van legalább egy layer 'Framing' típusú anyagból készül (Lásd 'Materials' cím? fejezetet). Ez
nem kell a main layer legyen, bármelyik layer lehet és akár többi is. Ha több is van, akkor minden layer-re meg fogja csinálni a framing tervet.

Egy layer attól lesz framing layer, hogy a hozzá kiválasztott anyag 'Framing' típusú. A 'Framing' típusú anyagok tartalmazzák az anyaghoz tartozó 'Stud'
kiosztást és stud szélességet. A CA-ban 8 beépített, 'Framing' típusú anyag található, vagy mi is készíthetünk újakat.

Egy anyag tehát attól 'Framing típusú anyag, hogy az anyag tulajdonságokban, a 'Materials List' fülön a 'Material Structure Type' értéke 'Framing'.
'Framing' típusú elemek esetében meg kell adni a 'Spacing OC' (On Center) értékét is. A vázszerkezet kigenerálásakor ezt az értéket fogja figyelembe
venni a CA, ha ezt explicit nem definiáljuk felül:
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A framing kiosztást és tulajdonságokat a 'Build framing' dialógusban a 'Wall' fülön tudjuk beállítani.

Ha bepipáljuk a 'Use wall framing materials' dobozt, akkor a 'Framing layer'-nek megfelel? anyag jellemez?ket fogja figyelembe venni. Pl ha
'Fir studs 24" OC" layer-t használunk, akkor 24"-os osztással fog US szabványú stud méretet használni. Ha több egy mástól eltér? framing
réteg van a falba, akkor mindenképpen ezt az opciót kell választani, hogy a rétegenkénti egyedi framing beállítások érvényre jussanak.

• 

Ha a 'Use wall framing materials' dobozt nincs bepipálva, akkor az itt megadott stud kiosztás és stud vastagság lesz alkalmazva minden
framing layer-re. Ha van két eltér? framing anyagból készült réteg egy falban, akkor nem praktikus, ha itt felüldefiniáljuk az anyaghoz
megadott stud beállításokat, mert ez az összes framing layer-re vonatkozni fog amit itt megadunk.

• 

A 'Plate' szekcióban adhatjuk meg a fels? és alsó plate jellemz?it framing anyagoktól függetlenül. Tehát ez lesz alkalmazva minden a falban
lév? framing layer-re, ezt nem lehet rétgeneként/anyagonként állítani a CA 12X-ben.

• 

Ha bepipáljuk, az 'Automatically build wall framing' dobozt, akkor automatikusan újra fogja generálni a framinget minden falban ha
megváltozik a mérete ahol van framing layer ill. nincs explicit kikapcsolva a framing újragenerálás.

• 

Be lehet állítani, hogy hány top és hány button plate legyen és azok milyen vastagok legyenek.

Framing generálás egy falra

Plan view-ban ha olyan falat jelölünk ki, ahol a 'Retain Wall framing' nincs bekapcsolva, és van 'Framing' típusú anyagból készült réteg a falban, akkor

az alsó menüben meg fog jelenni a 'Build wall framing for selected object' ( ) eszköz, amivel csak erre a falra tudjuk újra generálni a framininget.
Vigyázzunk, mert itt is minden módosításunk el fog veszni.

Framing manuális módosítása

Egyrészt bármelyik section veiw-ban vagy 3D-s view-ban tudjuk a framinet manipulálni ha a '3D framing layer set' van kiválasztva. Itt ki tudjuk törölni az
egyes framing member -eket vagy át tudjuk ?ket méretezni.

Ezen felül minden egyes framing-el rendelkez? falhoz tartozik egy framing cad view, (akárcsak a truss-okhoz) ahol át tudjuk rajzolni a framing-et. Ha ki
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van választva a fal plan view-ban, akkor az alsó menüben az 'Open wall details' ( ) választásával tudjuk megnyitni a fal framing cad rajzát.

Ide a 'Project browser' -ben a 'Wall details' kiválasztásával is eljuthatunk, ahol szintenként vannak összegy?jtve a fal tervek:

A 'Wall details' cad view-ban a 'General framing tools' ( ) két alábbi eszközével tudjuk a framing-et manipulálni:

A 'general framing'-e új elemeket szúrhatunk be, aminek meg tudjuk mondani a típusát és méretét, a 'Wall bridging'-el pedig blocking-ot adhatunk a
falhoz. A blocking-ot csak végig kell húzni egy megadott magasságban és automatikusan beteszi az osztásközökbe:

Az hogy egy vonalba vagy létra szer?en rakja az a 'Build framing' dialógus 'Wall' fülén a 'Blocking' szekció beállításaitól függ:

Ha ezt átállítjuk 'Stugger'-re akkor létra szer?en fogja rakni:
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https://www.chiefarchitect.com/videos/watch/332/editing-the-wall-framing-detail.html

Framing kikapcsolása

Ha kézzel módosítsunk egy fal framing szerkezetén akkor mikor újra generáljuk a framing-et a 'Build framing' dialógusban, akkor felül fogja írni a korábbi
beállításokat. Ezért minden falban be lehet állítani, hogy tartsa meg a jelenlegi framing beállításait. Ehhez plan view-ban nyissuk meg a fal beállításait,
és a 'Structure' fül alján a 'Framing' szekcióban pipáljuk be a 'Retain Wall Framing' dobozt.

Ekkor ha megnyomjuk a 'Build Wall framing' lehet?ség ezt a falat nem fogja újra generálni. Ha korábban még nem volt framing generálva ehhez a
falhoz, akkor nem is fog hozzá egyáltalán generálni.

Automatikus blocking

Lehet?ség van rá, hogy a CA minden falba automatikusan legyártsa a blocking-ot. Azonban a magasságár nincs ráhatásunk. Mindig a fal közepére
fogja berakni, vagyis egyenl? távolságara a bottom plat aljától és a fels? top plate tetejét?l:

Ahhoz hogy automatikusan legyártsuk a blocking-ot a 'Build framing' dialógus 'Wall' fülén a 'Blocking' szekcióban pipáljuk be vagy az 'Exterior' vagy
'Interior' pipáló dobozt. Az el?bbi a küls? falakban gyártja le a blocking-ot míg az utóbbi a bels? falakban

Framing schedule

Az adott fal CAD framing nézetében oda tudunk rakni a fal mellé egy Framing schedule-t is. Nyissuk meg a fal CAD rajzát (vagy az alsó menü 'Open
wall details' eszközzel vagy a 'Project browser' wall details listájából). Majd menjünk a 'Tools -> Schedule -> Framing schedule' menüpontba,
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és tegyük az schedule-t a fal mellé. Ebben a táblázatban az adott fal összes eleme benne lesz. És ha módosítjuk a falat, dinamikusan frissülni fog a
táblázat.

Oldalnézet framing -el

Ha a ház négy oldalnézetét akarjuk framing-el megmutatni, akkor ehhez nem elég a 'Cross section' nézet, mert az összes framing látszani fog a fal
mögött, nem csak a homlokzati falak. Ezért ehhez 'Blackclipped cross section'-t kell használni:

Els? lépésben ki kell vinni a Callout-okat mind két oldalra, majd 'Break' tool-al fel kell darabolni, és egészen a falak mentén behúzni a cross-section
vonalát, hogy kövesse a házat.

Wall framing labels

https://www.chiefarchitect.com/videos/watch/5304/framing-labels-wall-labels-and-wall-details.html?playlist=85
Miután elkészítettük a framing-et egy falhoz, az kap egy automatikus címkét, ha az automatikus címke nincs kikapcsolva az adott fal beállításaiban. Ha
plan view-ban átmegyünk a layer beállításokban a 'Framing layer set'-re:

Majd bekapcsoljuk a 'Wall labels' layer-t is, akkor meg fognak jelenni a fal mellett a fal címkéi:
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Ez a címke meg fog egyezni a 'Project browser'-ben a 'Wall details' alatti fal nevével. Ha ott átnevezzük a falat, akkor az át fogja nevezni a plan
view-ban is:

A címke pozícióját a fal beállításaiban a 'Label' fülön állíthatjuk át a 'Plan view position and orientation' szekcióban:

Ugyan itt megadhatunk egyedi címkét is, ide kerül be az a címke név is, amit a 'Project Browser'-ben adunk egyedileg az adott falnak:

Lehet?ség van makrókat is tenni a címke nevébe, amik dinamikus változók, a CA automatikusan fel fogja tölteni, pl a fal vastagsága. A makrók
beszúrásához kattintsunk a címke beíró melletti kis nyílra:

Majd válasszunk egyet a listából, pl 'Thickness':

Ekkor ha elmentjük a beállításokat, akkor a fal pillanatnyi vastagsága mindig benne lesz a címkében:
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A label méretét az adott layer beállításai befolyásolják. Válasszuk ki a 'Wall layer'-t a 'Layer display options' dialógusban. A bet?típus és méret az ablak
alján lév? 'Text styl' beállítástól függ:

A legördül? menüb?l választhatunk másik típust, vagy 'Define' gombbal létrehozhatunk egy új stílust is.

Sarkok találkozások módosítása

A CA mikor legyártja a Wall framing-et, minden sarokban kiválaszt egy falat, amire a másik fal csatlakozni fog:

Arra a falra, ami teljesen végig fut rárak egy nailer board-ot, ami fogadja a másik falat. Be tudjuk állítani, hogy melyik fal fusson végig, és melyik induljon
a másik faltól. Ehhez válasszuk ki azt a 'bels? falat', amit módosítani akarunk (lehet?leg Framing floor plan view-ban), vagyis azt a falat, amit ki akarunk

vinni az alap széléig. Majd az alsó menüben válasszuk az 'Edit wall layer intersection' ( ) eszközt. Ekkor a sarok fölött meg fog jelenni egy csomó
mozgató négyzetecske:

A középs?vel húzzuk ki a falat egészen a ház széléig, majd generáljuk újra a framing-et:

Ezt elvileg a 'Specification' dialógus 'Structure' fülén is beállíthatjuk. Valahogy be lehet kapcsolni, hogy Plan view-ban mutassa hogy melyik a fal eleje és
vége egy kis 'S' illetve 'E' bet?vel, amit a specifikációs dialógus 3D nézetében is mutat.
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Valahol meg lehet mondani, hogy ezek meddig érjenek...

Láthattuk, hogy alapértelmezetten a CA 'California corner'-el oldja meg a sarkokat, ami nem más mint egy 3 stud-ból kialakított csomópont, ami a bels?
oldalon minden irányból biztosít szögelési felületet a gipszkartonnak.

Azonban ha a fal végén a kiosztás pont úgy jön ki, hogy a stud kiosztás pont a sarok közepére jönne ki, akkor nem fér már oda még egy stud, ezért
kívülre is berak a CA egy elfordított stud-ot, aminek a közepén lesz meg az 500mm, vagy a kiválasztott stud osztásköz:

Ez a megoldás még mindig biztosít valamennyi szigetelésre lehet?séget a sarkokban.

Delete wall framing

Az összes fal framing tervét egyszerre ki tudjuk törölni. Ehhez menünk az 'Edit -> Delete object' menüpontban:

Majd válasszuk a 'Framing' szekcióban az 'All framing' lehet?séget.

Az OK gomb megnyomásával az összes framing elt?nik!
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Framing reference

https://www.chiefarchitect.com/videos/watch/335/using-a-framing-reference.html?playlist=93
Akárcsak a floor framing esetében fal esetében is használhatjuk a 'Framing reference'-t, ami egy jelölés a CA számára, hogy melyik sarokhoz képest
ossza ki a stud-okat a tejes épületen.

Ez ugyan az a referencia, amit floor esetén használhatunk. Épületenként általában csak 1-et szoktak alkalmazni, de több is elhelyezhet? a terven, akár
szintenként 1 darab.

Ennek nagyon fontos szerepe van a végs? stud kiosztásban, nagyon fontos hogy hány darab van és hogy szintenként van e külön, csak ezen fog múlni
minden szoba minden stud kiosztása, ami nagyban befolyásolja a gipszkartonok és OSB-k helyét és hosszát.

Az a legáltalánosabb, hogy a földszinten egyet lerakunk valamelyik sarokba. A feni képen a jobb fels? sarokba raktam le a referenciát jobb fels? falak
találkozásánál. Az is fontos, hogy a falon pontosan hova esik a referencia középpontja, a legcélszer?bb a main framing layer küls? széléhez tenni, ekkor
ett?l a pontól fogja kezdeni a stud-ok kiosztását a beállításokban meghatározott eltolással. Nézzük meg a jobb fels? két fal tervét:

Láthatjuk, hogy a jobb fels? saroktól 500mm-re indul a kiosztás.
Ha az alsó szint stud kiosztását követni fogja a fels? szint (ami nem kötelez? amúgy dupla top plate esetén) akkor fontos, hogy csak az alsó szinten és
csak egy darab referencia pontot együnk le. Ekkor az alsó szint falai nagy valószín?séggel mind egy 500mm-es osztással fognak indulni valamelyik
oldalukon, tehát teljes OSB illetve gipszkarton táblával kell rajtuk indítani. De ha a fels? szint nem ugyanakkora mint az alsó, és a stud kiosztást az alsó
szinten lév? referencia ponttól fogja mérni (ami azt eredményezni, hogy a fels? szint stud-jai az alsó szint kiosztását fogja követni, mivel pont attól a
ponttól fogja számolni) akkor a fels? szintén már nem lesz olyan fal, ami 500mm-es osztással indul, minden falban tört érték lesz, tehát nem indítható a
burkolás teljes OSB-vel illetve gipszkartonnal. Az alábbi emeleti falon látható, hogy egyik oldalon sem 500mm-es osztással indul:

Egy épületre több referencia pont is elhelyezhet?, pl. szintenként 1 darab, amit minden szinten valamelyik sarokpontra pozícionálnuk. Ekkor minden
szinten teli osztással fog indulni a stud kiszosztás. Ha több referencia pont is van egy épületben, akkor minden falnál a hozzá legközelebbit és lehet?leg
vele egy szinten lév?t fogja figyelembe venni.

Balloon framing

Minden földszinti falat, ami fölött fan emeleti fal, de nincs közte födém, mert nyitott tér van a két szint között (pl. lépcs?ház, a CA automatikusan balloon
framing-el fog elkészíteni, vagyis az alsó és fels? fal egy nagy vázszerkezet lesz.

Ilyenkor az alsó szint fal specifikációjában pipáljuk be, hogy 'Stop at ceiling above' és hogy 'Stop at floor below', hogy egy szintre kényszerítsük a
falszakaszt:
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Rainscreen 1

Ha rainscreen szerkezet? a falunk, akkor a backerboard alatti wood striping-et akár készíthetnénk egy framing típusú anyagból, ahol beállítjuk, hogy
89mm széles legyen és szintén 500 OC-vel legyen kiosztva.

Hozzunk létre egy új réteget a striping-nek:

Majd a fal szerkezetébe állítsuk be, hogy a lécezésnek az anyaga az új anyag legyen:
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A 'Build framing' dialógus 'Wall' fülén pipáljuk be a 'Use wall framing material' lehet?séget, hogy a váz paramétereit mindig az anyagból szedje. Erre
azért van itt mindenképpen szükség, mert most kétféle váz van a falban. Van az épület f? váza és van lécezés a rainsccen alá.

Most generáljuk újra a framing-et. Ekkor a falban már mind két rétegre le fogja generálni a framing-et. Ha perspektivikus nézetben eltávolítjuk a küls?
rétegeket a 'Delete surface' eszközzel, akkor elénk fog tárulni a lécezés a backerboard alatt és a szigetelés fölött:
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Warning
Ezt a megoldást csak a 3D-s képe legyártásához használnám, mert ugyan úgy generál neki a CA button és top plate-et, sajnos az nem állítható
rétegenként, csak globálisan. Ezért az anyaglista kalkulációban hibásan fog szerepelni, sokkal több anyag lesz szerepeltetve mint kell. Ezen felül nem
igazodik a main layer stud kiosztásához, úgy hogy tervezésre sem lehet használni. Ráadásul a fal CAD tervrajzára is rákerül mint framing réteg

Rainscreen 2

Mivel a rainscreen favázát amúgy is hibásan kalkulálja a CA, ezért jobb ha ezt a réteget olyan anyagból csináljuk, ami nem framing típusú, és nincs
beleszámítva az anyaglistába.

Ceiling framing

Floor framing
Fa födém esetén a födém szerkezetét is le tudja generálni a CA. Ehhez a szokásos 'Build Framing' dialógust kell megnyitni, ami több helyr?l is elérhet?,
pl. ha duplán kattintunk bármelyik framing tool-ra:

A 'Build framing' dialóguson belül az emelet sorszámával megjelölt füleken generáltathatjuk le az adott emelet födém szerkezetét. Láthatjuk, hogy az
'1st' fülön az els? szint plafonját és a 2. szint födémét generálhatjuk le. A födémre a 'Subfloor for Floor 2' vonatkozik. Akár csak a többi framing panelen,
ha bepipáljuk, hogy 'Build floor framing' és megnyomjuk az 'OK' gombot, akkor le fogja generálni az adott szint födém szerkezetét:
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A fal framing-nél bemutatott 'Framing reference' ugyan úgy vonatkozik a födém szerkezetre is mint a fal szerkezetre, ugyanazt a referenciát fogja a CA
használni a fal stud kiosztásra mint födém joist kiosztásra. (Persze ha több is van a terven, akkor a legközelebbit fogja használni, de tervenként
általában csak egyet alkalmazunk)
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Ha 'Framing reference'-el készítjük el a födém szerkezetet, akkor a joist-ok a stud-ok közelében lesznek elhelyezve, a CA törekedni fog rá hogy minden
joist minél közelebb kerüljön az alatta lév? stud-hoz. (Dupla top plate esetén ugyan nem fontos, hogy a joist stud fölé kerüljön a kód szerint). Ezen felül
minden fal alá automatikusan a fal súlyának megfelel? s?r?ség? és mennyiség? extra gerendát fog berakni. Pl az alábbi képen az látható, hogy a nyíllal
jelölt dupla I gerendát a CA magától rakta be, mert az emeleten fal van felette:

Födém struktúra definiálása

A fa födém struktúrája két helyr?l jön. Egyrészt a födém feletti szoba padló szerkezet definíciójából, másrészt a 'Build framing' dialógus födémre
vonatkozó füleir?l.
A födém feletti szoba padló definíciója a 'Room specification' dialógus 'Structure' fülén található.

Ha ez meg van adva, akkor a CA ezt fogja figyelembe venni a gerenda típusának a meghatározására. A 'Rim joist' típusát itt nem lehet definiálni
szobánként.

A 'Build framing' dialógus födémre vonatkozó fülein állíthatjuk be a 'Rim joist' vastagságát és anyagát valamint beállíthatjuk, hogy a szomszédos
helyiségek felett futó gerendák hogyan találkozzanak egymással. A blocking-ot nem fogja a CA automatikusan megcsinálni, ezt nekünk manuálisan kell
a kívánt helyre berakni. Az itteni blocking beállítások határozzák meg, hogy a 'Blocking' eszköz hogyan viselkedjen.
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Bear on beams - Lap:
Lap: ebben az esetben a gerendák a stud-hoz képest jobbra és balra el lesznek mozdítva, hogy a találkozási ponton egymás mellé
fussanak 20 cm hosszan

♦ 

But: a gerendák a fal közepén találkoznak, és egy síkban futnak.♦ 

• 

Blocking:
In line: A blocking beül a gerendák közé egy vonalban♦ 

Stagger: Cikk-cakkban vannak a blocking-ok, így könnyebb beszögelni ?ket.♦ 

• 

Ha egy szobában nincs definiálva a padló szerkezet, akkor az itt megadott értékeket fogja figyelembe venni, ami a teljes szintre vonatkozni fog. Tehát a
bizonyos szobák padlója eltér? magasságú gerendából készül, akkor azt mindenképpen az adott szoba specifikációjában kell megadni.

Stud osztásköz és irány definiálása

Ha külön nem rendelkezünk róla, akkor a CA joist-ek futási irányát maga fogja meghatározni a szerinte optimális módon. A kiosztási s?r?séget pedig a
'Build framing' adott szintre vonatkozó beállításaiból fogja venni. Azonban ezt szobánként felül lehet írni a 'General framing tools'-on belül a 'Joist
direction' eszközzel.

Kattintsunk a 'Joist direction' eszközre, majd a szobában a gerendák elképzelt futási irányába húzzunk vele egy vonalat.

Ha ezután megnyitjuk a specifikációs dialógusát, akkor beállíthatjuk a gerendák magasságát és kiosztását.

https://wiki.berki.org/index.php/File:ClipCapIt-210606-173311.PNG
https://wiki.berki.org/index.php/File:ClipCapIt-210606-173903.PNG
https://wiki.berki.org/index.php/File:ClipCapIt-210606-175339.PNG
https://wiki.berki.org/index.php/File:ClipCapIt-210606-175216.PNG
https://wiki.berki.org/index.php/File:ClipCapIt-210606-175458.PNG


A gerenda típusa (pl I-joist) a szoba illetve a 'Build framing' dialógus beállításaiból jön.

Bearing lines

Floor blockings

Joist manuális rajzolása

Windows and doors
A legegyszer?bb az ablakok és ajtók körülül framing-et az ablak és ajtó Specification dialog-ban megcsinálni. Itt két fontos tényez? befolyásolja a
framinget. Ezt vagy a framing legenerálása el?tt kell beállítani, vagy auto-regenerate framing opcióval kell használni a fal generálást.

General / Size and position

Itt az ablak és ajtó nominális (valódi) méretét kell mindig megadni, a rough opening mérete ide még nem számít bele. Tehát úgy kell itt megadni az alak
magasságát a padló strukturális szintjét?l, hogy az ablak nyílás nincs beleszámolva.

Framing fül

Itt szabályozhatjuk a header méretét, anyagát, valamint hogy hány jack-stud kerüljön a nyílás két oldalára.

Header: A header szekcióban megmondhatjuk, hogy mib?l legyen a header. Ha nem rendelkezünk err?l, akkor a default-ban ( ) beállított
érték lesz. Box header esetén megmondhatjuk, hogy hány lapból állítsa el? a header-t. Ezeket egyenletesen osztja el. Ha 2-öt írunk be, akkor
egy lesz kívül, egy lesz beül, és a kett? közé mehet a szigetelés. Ha csak egyet írunk be, akkor az kívül lesz. Az itt megadott Depth érték lesz
a header magasság nem beleszámítva a doboz kialakításához szükséges 15x - alsó és fels? pallót. Viszont ezeket csak akkor fogja oda
rakni, ha marad neki hely, olyat sajno nem tud, hogy csak alsó dobozolás legyen, ha a header felér amúgy is a top-plate-hez.

• 

Trimmers: Más néven jack-stud. Itt állíthatjuk be, hogy hány darab legyen a nyílás két oldalán. Alapértelmezetten mindig 1.• 
Rough opening: Mennyivel legyen nagyobb a falnyílás az ablak valódi méreténél. A magyar prospektusokban szerepl? ablakoknál mindig a
fal méret van megadva. Így úgy kell ügyeskedni a valódi méret + ráhagyás értékkel, hogy kiadják a standard méreteket (60x150, 90x150..stb).

• 

Viszont nagyméret? terasz ajtóknál ez már trükkösebb, mert ott gyakran a valós méret van megadva. Így a gyártói specifikációt kell követni mikor a
rough opening ráhagyást beírjuk.

Roof trusses
Bevezet?

https://www.chiefarchitect.com/videos/watch/346/framing-a-truss-roof-system.html
A truss-ok (magyarul ez a kereszttartós gerenda) legyártását fél manuálisan kell végezni, teljesen automatikusan csak hagyományos
rafter-roof-framing-et tud csinálni jelenleg a CA. A koncepció az, hogy elhelyezünk minden olyan pontra manuálisan truss-okat ahova gondoljuk, majd
után legeneráltatjuk a roof framing-et a CA-val, ami ki fogja pótolni a hiányosságokat. Vagyis fel fogja helyezni a Sub-fascia deszkákat, és be fogja rakni
a gerinc mentén a blocking-okat valamint minden olyan helyre rafter-t fog rakni, ahol hiányolja strukturálisan az alátámasztást.

Az alábbi ábrán (bal) láthatjuk világos kékkel a garázs feletti truss-okat, és sötétkékkel a CA által kigenerált tet? framing elemeket. A jobb oldali ábrán
megjelöltem amiket a CA generált ki a truss elhelyezés alapján.
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Ahhoz hogy nekikezdhessünk a trust gyártásnak, els?re meg kell csináljuk a roof-plan-t és a ceiling plain-t. A kett? közötti részt fogják kitölteni a
megrajzolt truss-ok. A tet?t automatikusan vagy manuálisan el?állíthatjuk a Roof tool-al. Ha ceiling plain pedig magától el?áll minden szoba fölött, ahol
be van jelölve, hogy legyen felette plafon és hogy NEM a soffit adja a ceiling-et, mert az azt jelentené hogy követi a tet? vonalát, amibe nem lehet
kereszttartós tet?t rakni.

Truss alapú tet?nek el?követelménye, hogy ne legyen Birdsmouth kivágás a rafter-eken. Ehhez a Build roof dialogban a Roof/Specification ablakban
be be kell pipálni a Trusses checkbox-ot:

Ennek hatására az Automatic birdsmouth cut szekcióban a Reise of plate és a Birdsmouth seat értéke is 0 lesz.

Truss rajzolás

A turss-okat a 'Roof framing tools'-ból a 'Roof truss' eszközzel rajzolhatjuk meg.

Nincs más dolgunk, mint hogy a már korábban elkészített roof plan oldalától a gerincen keresztül a másik oldalig megrajzoljuk a truss-t. Nem kell
pontosan a szélét?l indítani, a CA a roof plan alapján méretre fogja igazítani, ki fogja tölteni a plafon és a tet? vonala közötti teret, és el fogja hozzá
készíteni a web-et is.
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Note
Ha azt szeretnénk, hogy a sofit egyenes legyen, vagyis hogy a truss vége ne lógjon le, hanem a top plate-el egy vonalban folytatódjon, akkor a tet?t
annyira fel kell emelni, hogy az alja pont egy vonalban legyen a top plate tetejével. Ez elég trükkös lehet, nem egyértelm?, több cross section
készítésével tudjuk pontosan kimérni, hogy milyen magasra kell emelni.
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A truss web-hez felhasznált lécek méreteit úgy tudjuk beállítani, hogy kétszer kattintunk a Roof framing tool-ra ( ). Ekkor

megnyílik Build framing dialog. Ezt meg lehet nyitni akkor is ha a General framing tools-ban a Build Framing-re kattintunk ( )
A trusses beállításokat a Trusses fülön találjuk:

Itt a tet?re vonatkozó truss beállítások a Roof szekcióban vannak. Ha a truss már le van gyártva, és azt szeretnénk hogy az új beállítások mentén újra
generálja a web-et, akkor újra kell generálni a truss-t. Ehhez nyissuk meg a truss specifikációt (bal alul kis kék ajtó) majd pipáljuk be a 'General' fülön
pipáljuk be a 'Force truss rebuild' lehet?séget és kattintsunk az OK gombra.

Ez a build funkció ugyan úgy m?ködik mint a többi build pipáló doboz, hogy a pipálás nem permanens, pusztán jelzi a CA számára, hogy az OK
megnyomásakor hajtsa végre a m?veletet. Ha újra megnyitjuk a specifikációt, akkor a doboz megint nem lesz bepipálva.

Ha olyan helyre húzzuk a Truss-t ahol kilóg a roof plan-b?l (pl a fal síkján kívül van a truss), akkor a CA nem fogja tudni legenerálni, és egy hibaüzenetet
fogunk kapni:
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Ha ezt megnézzük 3D-ben láthatjuk hogy nem is jött létre a truss.

Truss CAD detail

Ha akár csak egy truss is létrejön a terven, akkor a CA automatikusan létre fogja hozni a 'Project Browser'-ben a 'Truss Detail' rajzot:

Erre helyezi el az összes a terven szerepl? truss tervét egyenként beszámozva. (A számozást a terven is meg tudjuk jeleníteni a 'Framing, Roof Truss
Labels' megjelenítésével.

A CAD rajzon át tudjuk méretezni a stud körvonalát, amihez aztán újra tudjuk generáltatni a truss szerkezetét. A körvonal határozza meg a truss
szerkezetét, a körvonalat pedig roof plan -b?l számolja ki a CA. Ha a roof plan alapján nagyon fals körvonalat generál a CA, akkor itt át tudjuk méretezni
a körvonalat. Ehhez jelöljük ki a teljes stud-ot úgy hogy a szélére kattintunk úgy hogy az egész stud szürke legyen (Tab nyomkodással):
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Majd a polyline-okhoz hasonlóan a végpontok átmozgatásával át tudjuk méretezni a truss-t.

Ha megvan az új alak, akkor nyissuk meg a truss specifikációt, pipáljuk be, hogy 'Lock truss envelop and webing' hogy az újra generálásnál
megmaradjon az új alak, majd pipáljuk be hogy 'Force truss rebuild' és kattintsunk az OK gombra.
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Ekkor a truss szerkezete le fogja követni az új körvonalat.

Truss fal mellé mozgatása

A roof plan mindig a fal küls? burkához igazodik. Ha a falon kívül van egy küls? szigetelés, akkor a roof plan csak a szigetelésig fog menni, és nem fogja
hagyni hogy közelebb menjünk a falhoz a tet?vel.

Ez 3d design tervnek tökéletes, de a truss-okank el kéne menniük a falig.

1. Bekapcsolhatjuk az adott tet? szakasz roof plan-jében, hogy ne foglalkozzon a fallal, addig húzzuk amíg akarjuk. A Roof plan specificaton-ben a
General fülön be kell pipálni hogy : No special snapping

Azonban ha egy olyan tet? amit belehúztunk a szigetelésbe találkozik egy 'normál' tet?vel, akkor egész örült dolgok keletkeznek, úgy hogy nem a
legjobb módszer.

2. A truss-t átrajzoljuk és a fal mellé húzzuk. Azonban ilyenkor ha túl közel kerül a falhoz, akkor fel fogja venni a fal alakját. Ezért miel?tt odébb húznánk,
lock-oljuk: Roof truss specifiocation / General

És íme a végeredmény:
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Truss átméretezése

OSB sheeting megjelenítése

Erre jó megoldást még nem találtam. 3D view-ban van egy eszköz:

Ezzel ideglenesen el lehet távolítani annak a falnak/tet?nek egy darabját, amire rákattintok. De a truss-okat ilyenkor nem jeleníti meg. De az OSB
rétegig le tud menni.

Beépített padlástér kialakítása

https://www.chiefarchitect.com/videos/watch/354/framing-with-attic-trusses.html

Schedules
Áttekintés

https://www.chiefarchitect.com/videos/watch/1544/door-window-cabinet-schedules.html?playlist=87
Nagyon sokféle beépített schedule van kezdve az ablaktól egészen a bathroom fixtures-ig. Schedule-t a tools menü Schedule menüpontjában adhatunk
hozzá:

https://wiki.berki.org/index.php/File:ClipCapIt-210331-224754.PNG
https://wiki.berki.org/index.php/File:ClipCapIt-210331-224452.PNG
https://www.chiefarchitect.com/videos/watch/354/framing-with-attic-trusses.html
https://wiki.berki.org/index.php/File:ClipCapIt-210406-191515.PNG
https://www.chiefarchitect.com/videos/watch/1544/door-window-cabinet-schedules.html?playlist=87
https://wiki.berki.org/index.php/File:ClipCapIt-210327-122215.PNG


Ekkor az schedule-t tartalmazó táblázat mindig az aktuális view-ba fog kerülni, ami lehet bármelyik floor plan view vagy elevation view is, de nyilván
annak nem sok értelme lenne.

Ahogy azt már sok esetben láthattuk, az összes schedule fajta mögött ugyan az az objektum típus áll. A különböz? típusok csak el? vannak nekünk
konfigurálva, hogy pl csak ablakokat vagy csak ajtókat mutasson, de bármelyikb?l konfiguráció útján el?állítható egy másik, ahogy azt a falaknál
láthattuk. A Window schedule egy olyan jegyzék, amiben el? van konfigurálva hogy csak az ablakok jelenjenek meg. De bármikor beállíthatjuk, hogy az
ajtókat is mutassa.

Az schedule készítésnek az a célja, hogy egy layout valamelyik oldalán landoljon. Azonban nem lehet közvetlen oda küldeni a schedule-t, els?nek létre
kell hozni a plan-ben. Erre a legalkalmasabb a egy CAD details view-t létrehozni, itt elhelyezzük a schedule-t majd ezt a CAD view-t küldjük el a layout
valamelyik oldalára a szokott módon. Úgy hozhatunk létre új CAD részlet rajzot, hogy a CAD menüpontban a CAD detail management... menüpontban
hozzáadunk egy újat.

Itt adjunk hozzá egy új cad view-t és nevezzük el pl Window schedule-nak.

Célszer? egy CAD view-ba csak egy schedule-t rakni, mert csak az egész view-t tudjuk elküldni egy layout oldalra, és ha több is van rajta, akkor mindig
ki kell vágni a nekünk megfelel?t.

Az schedule nagymértékben testre szabható. Lehet szintenként, szobánként készíteni, sorrendezni lehet az oszlopokat, és meg lehet mondani, hogy
milyen oszlop kerüljön bele.

Schedule specification

A specification dialog-ot a szokásos módon nyithatjuk meg:

A General fülön találhatjuk a legfontosabb beállításokat:

Main title: ez a cím fog fent megjelenni.• 
Include options: Melyik szintb?l és melyik szobát tegye rá a schedule-ra. Pl lehet hogy szobánként csinálunk bútor jegyzéket.• 
Group similar object: ez fontos, ha pl nem akarjuk hogy minden egyes ablak külön legyen a jegyzéken. Ha bepipáljuk akkor az összes
ugyan olyan ablak csak egyszer fog szerepelni.

• 

Categories to include: Itt fog eld?lni, hogy milyen típusú elemekb?l legyen a jegyzék. Itt vannak el?re gyártott kategóriák (ablak, ajtó... ) de
kitalálhatunk új kategóriákat is.

• 

A Labels fül fontos még. Itt állíthatjuk be, hogy a különböz? view-kon megjelölje e a jegyzékben szerepl? elemeket. Ezt hívják Callout-nak. Pl, az alábbi
esetben be van jelölve a Diamond, ami tipikus jelölési mód ablakok esetén. Ezen felül be lehet állítani a Schedule number prefix mez?ben, hogy
milyen prefix-et kapjon minden jegyzék elem. Itt a W-t fogja kapni, és fel fogja az üres helyértékeket tölteni 0-val.
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Ennek fényében a view-kon láthatjuk, hogy az ablakokon megjelent egy kis gyémánt, benne az ablak sorszámával W0-val prefixelve.

Note schedule
https://www.youtube.com/watch?v=uhI0aSDEfWg

Bevezet?

Bármelyik view-ba, cross section-be vagy 'CAD-detailed'-ben elhelyezhetünk úgynevezett 'Note'-okat az ábrákon, amib?l automatikus jegyzéket tud
készíteni a CA. Ennek az els? számú értelme az hogy nem terheljük túl az ábrát feliratokkal, ott csak számokkal vagy bet?kkel hivatkozunk az egyes
elemekre, és mellette egy táblázatban helyezzük el a számok/bet?khöz tartozó magyarázat. Ez a táblázat a 'Note schedule'. Egy ábrán beül képes a CA
automatikusan kiosztani a sorszámokat, nem nekünk a futó sorszámot növelgetni:

Készíthetünk egyedi jelöléssel callout-okat (a kör, vagy négyzet benne egy bet?vel vagy számmal), ez a feni képen a jobboldali, vagy bízhatjuk a
sorszámozást a CA-ra, ez a jobboldali kép.

A note-okat egy view-n belül a note-nak adott típus csoportosítja. Mikor jegyzéket készítünk a note-okhoz meg kell mondani a 'Note schedule'
beállításaiban, hogy melyik típusból készítse el a táblázatot. Ezzel több különböz? note sorozatot tehetünk egy view-ra, és mindegyiknek saját futó
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sorszáma lehet a típuson belül.

Note-ok kezelése

Note-ot egy view-ban a 'Text tools' paletta ( ) 'Note eszközzel adhatnunk hozzá:

Kattintsunk bárhova a view-ba és oda le fog rakni alapértelmezetten egy kör alakú üres 'callout'-ot és meg fog nyíli a 'Note specification' dialógus.
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Itt megadhatjuk hogy mi kerüljön a forma (kör, négyzet, stb) belsejébe és hogy mi kerüljön majd a 'note' jegyzékbe mikor majd jegyzéket generálunk
ehhez a note-hoz.

Schedule text: ide kell írni azt ami majd meg fog jelenni a táblázatban a callout mellett. Pl 'átszell?ztetett homlokzat'• 
Type: ez fogja összekapcsolni a view-n belül a note-okat, amik egy táblázatba fognak megjelenni. Van beépített 11 beépített note típus, de
magunk is létrehozhatunk típusokat (lásd következ? fejezet). Válasszuk a 'General note'-ot ha elég egy note táblázat a view-n belül. Ekkor
minden olyan note aminek a típusa 'General note' ugyan abba a táblázatba fog kerülni.

• 

Text above line: Ha csak ez van megadva, akkor az itt megadott szöveg fog a formában kerülni, ami általában egy bet? vagy szám.• 
Text below line: Ha ezt is megadjuk, akkor a formát el fogja választani egy vonallal, és ez kerül a vonal alá.• 

Mind a három esetben használhatunk makrókat, ahogy azt már megszokhattuk. A legpraktikusabb makró a '%simple_schedule_number%' ami lehet?vé
teszi, hogy egy típuson belül automatikusan kezelje a számokat a CA.

Fontos, hogy ha makróval adjuk meg a forma belsejébe írandó szöveget, akkor az egészen addig nem lesz kitöltve, amíg nem készítünk hozzá
jegyzéket.

Schedule hozzáadása

A jegyzéket a 'Tools -> Schedule -> Note schedule' menüponttal hozhatunk létre.

A 'Note schedule'-t csak ugyan arra a view-ra rakhatjuk, amin a note-ok is szerepelnek, de innen copy-paste-el rakhatjuk át egy megfelel? 'CAD
detailed'-re. A 'Note schedule' menüpont kiválasztása után le kell rakni a táblázatot valahol a view-n:
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Ha csak egy note típus van a view-n akkor abból fogja csinálni a táblázatot. Ahogy a táblázatot leraktuk, ki fogja tölteni a futós sorszámokat, ha
makróval adtuk meg a formán belüli szöveget ( %simple_schedule_number%)

A táblázat sorai átrendezhet?ek, ekkor a sorszámot is ki ki fogja cserélni a bubikban.

Ha megnyitjuk az 'Schedule Specification' dialógust, akkor a 'General' fülön állíthatjuk felül, a 'Main title' mez?ben állíthatjuk be vagy kapcsolhatjuk ki a
táblázat címét, és ami a legfontosabb, hogy a 'Categories to include' szekcióban állíthatjuk be, hogy milyen 'Note type'-okat rakjon bele ebbe a
táblázatba.

Láthatjuk, hogy csak a 'General notes' van bepipálva.

Note típusok kezelése

Alapértelmezetten az alábbi 11 kategória elérhet? note-okhoz.
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De ezeket ki tudjuk b?víteni. A 'Text tool' palette 'Note type management' eszközével hozhatunk létre új note kategóriákat.

A megnyíló 'Note type manager' dialógusban hozhatunk létre új típusokat. Ez csak egy címke, a nevén kívül semmilyen attribútuma nincsen:

Küldés Layout-ra

A 'Note schedule'-t nem lehet közvetlen elküldeni egy layout megadott oldalára, és nem is jó, hogy a view-n van rajta. Ezért els? lépésként együk át egy
'CAD-detail' oldalra. Ehhez menjünk a 'CAD -> CAD detail manager' menüpontba:
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Majd adjunk hozzá egy új CAD oldalt, pl: 'Example schedule':

Majd 'Edit -> Cut' és 'Edit -> Past'-al másoljuk az új 'CAD detailed'-re a táblázatot. Ett?l még az összeköttetés a note-ok és a schedule között
megmarad, ha átrendezzük akkor átszámozódik ugyan úgy. Vagy ha hozzáadunk a view-hoz egy új note-ot, ami olyan típussal rendelkezik, ami be van
pipálva a schedule beállításaiban, akkor az automatikusan bele fog kerülni a táblázatba.

A 'CAD detail' tartalmát már el tudjuk küldeni egy layout megfelel? oldalára a 'Send to layout' funkcióval:

Ha note-okon módosítunk az eredeti view-ban, akkor a layout-on is és a CAD detail'-ben is módosulni fog.

Note egyedi mez?k használata

A 'Schedule Specification' ablakban be tudjuk állítani hogy jegyzékben milyen oszlopok jelenjenek meg. Alapértelmezetten ez mindig a '2D symbol', ami
a 'note' geometriai formáját jeleníti meg az els? oszlopban (pl. k?r benne egy sorszám) és a 'Text', ami meg a note szövegét jeleníti meg.
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Azonban a 'General' -> 'Columns' szekcióban beállíthatjuk hogy milyen tovább oszlopok jelenjenek meg. Minden objektumhoz típushoz a CA-ban
tartozik 5 darab el?re definiált további mez?, amiket az 'Object Information' fülön érhetünk el az adott 'Node' beállításai ablakban.
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Láthatjuk, hogy a Schedule-hoz tartozó 'Schedule Specification'-ben ezen mez?ket adhatjuk még hozzá a táblázathoz.
Azonban ezen el?re definiált globális mez?k listáját tovább b?víthetjük egyedi mez?kkel, amik minden egyes elemhez meg fognak jelenni, nem csak a
Note típushoz. A Note-hoz tartozó 'Note Specification' ablak 'Object Information' fülén a 'Create new fields...' gombbal tudunk új mez?ket hozzáadni
globálisan minden CA elemhez.
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Az itt hozzáadott elemek mindig String típusúak lesznek. Az egyedi mez?ket itt nem lehet átnevezni, vagy törölni. Az egyedi mez?k átnevezéséhez vagy
törléséhez menjünk a 'Default Setting'-> 'Schedules' -> 'Custom Object Field' beállításaiba:
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Rubby makrok használata note-okon

Ahogy majdnem minden szöveges mez?ben, úgy az egyedi mez?k értékeinek megadásakor is használhatunk makrókat. Pl. ha van egy hossz és egy
darab egyedi mez?nk, akkor az össz hosszt kiszámíthatjuk a hossz és darab mez?k értékeinek összeszorzásával. A példában egy 6-os sorszámú kerek
Note látható, ami négy egyedi mez?vel rendelkezik. A hossz mez? értéke 1.74. A db mez? értéke (ami nem látszik a képen) 258.

Ahogy az anyagmennyiségeknél is, úgy note-ok esetében is ki lehet listázni a 'Leader Line'-ban megadott %object_properties% makró használatával
az adott Note-on elérhet? összes mez?t:
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Láthatjuk, hogy van neki egy 'custom_fields' nev? változója, ami Hash típusú és ott vannak benne az egyedi mez?ink.
Ezt a Rubby konzolon is listázni tudjuk. Leyen kijelölve a fenti note elem, majd nyissuk meg a Rubby konzolt (Tools -> Rubby Console...). Írjuk be az
'owner' kulcsszót:

Láthatjuk, hogy az elem lista végén ott van a custom_fields' nev? mez?.
Most írjuk be az owner.custom_fields' kifejezést a konzrolra.

Ekkor megjelenik a 'custom_fields' hash tartalma.
Nézzük meg a 'db' nev? tömb elem értékét:

Láthatjuk, hogy a db nev? egyedi mez? értéke: 258, és String típusú. Nézzük meg ugyan ezt a 'hossz' mez?re:
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A hossz értéke '1.74', és ez is string.
Ha a kett? szorzatára vagyunk kíváncsiak, akkor els?ként a 'db' mez? értéket egész számmá kell konvertál, míg a 'hossz' mez? értékét lebeg?pontos
számmá. És az eredményt felfelé kell kerekíteni. Rubby-ban a string-et egész számmá a to_i függvénnyel, míg leveg?pontos számmá a to_f
függvénnyel tudunk konvertálni. A felfelé kerekítéshez a ceil függvényt kell használni. Tehát a kifejezés egyben:

(owner.custom_fields["db"].to_i*owner.custom_fields["hossz"].to_f).ceil

Írjuk ezt be a konzolra:

Láthatjuk hogy a végeredmény 449.

Készítsünk ebb?l egyedi makrót. Nyissuk meg a makró managert: CAD -> Text -> 'Text Makro Management'.

Nyomjunk rá a 'New' gombra, és másoljuk be a fenti kifejezést. Az 'Evaluate' legyen bepipálva, és a kontextus legyen 'Owner object'.
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Mentsük el.

Nyissuk meg újra a Note Specifikációs ablakát és menjünk az 'Object Information' fülre. Válasszuk ki az 'összhossz' egyedi mez?t. Majd kattintsunk a
bal oldalon az 'Insert' makró beszúró gombra. Válasszuk ki a 'User defined' listából az új makrónkat:

Majd mentsük el. Ha most vissza megyünk a Note schedule-ba, láthatjuk, hogy kiszámolja a makró az össz hosszat:

Window and door schedule
https://www.chiefarchitect.com/videos/watch/1543/cabinet-door-window-labels.html?playlist=86
A Note schedule-al ellentétben az ajtókra és ablakokra a callout-ot a CA magától rakja rá, nem nekünk kell azokat az ajtón és ablakon elhelyezni.
Azonban az ajtó ill. ablak callout-ok csak akkor jönnek létre, ha készítünk egy ajtó ill ablak schedule-ot bármelyik view-ban vagy egy CAD view-ban.
Célszer? minden schedule-t elve egy új CAD view-ban létrehozni:
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Minden ablakhoz tartozik egy címke, ami a "Windows, Labels" illetve a "Doors, Labels" rétegen van. Az ablak és ajtó callout-ok is ugyan ezekre a
rétegekre kerülnek, tehát csak akkor fog vagy címke (mértet, típus) vagy callout megjelenni, ha ezek a rétegek be vannak kapcsolva az adott view-ban.

Callout vagy label

Ha egy ablak szerepel egy schedule-ban, akkor a schedule beállításai fogják eldönteni, hogy a schedule-ban szerepl? ablakokon a schedule callout-ja
jelenjen meg, vagy az ablak saját címkéi. Alapértelmezetten minden ablak szerepelni fog a default ablak schedul-ben. Az ablak specifikációs
dialógusában, az Schedule fülön állíthatjuk be, hogy az adott ablak melyik schedule-ba szerepeljen.

Itt be tudjuk állítani, hogy az adott ablak egyáltalán ne szerepeljen az schedule-ban, illetve, hogy melyik schedule-ba kerüljön bele.

Annak a schedule specifikációs dialógusában, amibe az adott ablak tartozik, a "Labels" fülön "Use callouts for labels" checkbox-al állíthatjuk be, hogy
callout jelenjen meg az ablakon plan view-ban vagy az ablak saját címkéi. Ha be van pipálva, akkor a címkék nem fognak megjelenni, csak az itt
megadott callout forma. Itt a Note callout-al ellentétben nem adhatjuk meg, hogy milyen mez?kb?l álljon össze a callout belseje. Az itt megadott prefix-el
lesz egy futó szám.

Ha ez a checkbox nincs pipálva, akkor az ablak saját címkéi lesznek megjelenítve.
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Ha a callout nem megfelel? helyen van, akkor azt odébb lehet mozgatni, a közepén található kis pöttyel, mikor az alábbira változik az egésrmutató:

Ablak/Ajtó címkék

Ha egy ablak nem tartozik egy schedule-ba sem, vagy ha igen, akkor a schedule-ban ki van kapcsolva a callout megjelenítése (Use callouts for labels =
false) akkor az a címke fog megjelenni a plan view-ban az ablakon, ami az ablak specifikációjában meg van adva a "Labels" fülön.

A címke tartalma lehet automatikus, ekkor a magasság x szélesség fog belekerülni, vagy lehet egyedi, ekkor a szokásos makrókat használhatjuk. Ha az
ablak része egy schedule-nak, de ott ki van kapcsolva a callout használat (Use callouts for labels = false) akkor az "Include schedule number"
pipálásával a címkébe bele fog kerülni az ablak száma az adott schedule-ban
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Callout/Címke szövegének mérete

A címke illetve a callout bet?méretét els?sorban a layer határozza meg, ablak esetében a "Windows, labels", míg ajtók esetében a "Doors, labels" réteg
bet? méret beállításai. A "Layers display options"-ben keressük ki a "Windows, labels" réteget, és "Text style" ban választhatunk olyan stílust, amiben
nagyobbak a bet?k.
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Callout keret méret

Alapértelmezetten a callout kerete követi a benne lév? bet?méretet. Azonban a schedule beállításaiban manuálisan is beállíthatjuk a callout méretet:
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Electrical & HVAC & Pluming
https://www.chiefarchitect.com/videos/watch/6100/kitchen-electrical-plan-for-the-kbi-project.html?playlist=90

Auto place outlets
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Terrain (Domborzat)
https://www.chiefarchitect.com/videos/watch/75/terrain-site-plan-basics.html?playlist=101

Terrain eszköztárak
Minden plan-ben pontosan egy darab terrain-t lehet csak létrehozni. A terrain eszköz készlet aktiválásához válasszuk a fels? menüben a 'Terrain
configuration' eszköz készletet.

Ha ezt kiválasztjuk, a fels? menüsort lecseréli a CA a terrain eszköz-gy?jteményre, amib?l a legfontosabb a 'Terrain tool' eszköz készlet.

Ezen beüli is a Terrain-t a 'Create Terrain perimeter' eszközzel lehet létrehozni.

Ez az eszköz csak addig lesz választható, amíg nem hozzuk vele létre a domborzatot, utána már szürke lesz, mivel minden plan-en csak egy darab
terrain objekutm szerepelhet.
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Terrain stílusának beállítása
Miel?tt elkezdenénk megrajzolni a domborzatot válasszuk ki a 'Plot plan view'-t, amiben ki van kapcsolva a ház struktúrájának legtöbb eleme.

Ahogy azt már korábban láthattuk a view-k csoportosítanak egy nagy adag alapértelmezett beállítást, többek között:

kiválasztott layer set• 
default sets (dimensions, text stb..)• 

A veiw- listáját jobb oldalon láthatjuk a 'Project browser'-ben a 'Plan view' alatt:

Nyissuk meg szerkesztésre a 'Plot plan view'-t:

Láthatjuk a 'Saved plan view specification' dialógusban a második fülön a view-hoz tartozó 'Default set'-et és a 'layer set' -et:
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Láthatjuk a 'Selected defaults' fülön, hogy a jelenleg kiválasztott 'Default set' az a 'Plot plan view adam', aminek a részleteit alatt láthatjuk. Legalul van
az alapértelmezett layer (Plot plan layer set) és alatta pedig a default cad layer.

A view-hoz tartozó 'Default set'-et megnyithatjuk a 'Tools -> Active Defaults' menüpontban is:
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Láthatjuk, hogy a tartalma megegyezik a 'Saved plan view specification' dialógus második fülének tartalmával. Láthatjuk hogy a 'Dimensions' default
értéke a 'Plot Plan dimension adam'. Nyissuk ezt meg szerkesztésre a ceruzára kattintva.

A megnyíló 'Dimension default' beállítások ablak 'Primary format' fülén állíthatjuk be, hogy mi legyen a dimenzió mértékegysége. Domborzatról révén
szó, itt 'Format/Unit's-ban métereket kell beállítani. Ezen felül 'Decimal places' értéket állítsuk 2-re, azaz két tizedesig mutassa:

A 'Layer' fülön láthatjuk, hogy a megrajzolt dimenzió milyen rétegre fog kerülni. Láthatjuk, hogy ez a 'Dimension plot plan':

Ha megnyomjuk a 'Define' gombot, akkor megnyílik a 'Layer display options' ablak, ahol láthatjuk a 'Dimension plot plan' layer beállításait.
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Itt láthatjuk, hogy a 'Dimension plot plan' rétegen megjelen? bet?k stílusa (vagyis a dimenzióra írt számok mérete és stílusa) a 'Plot plan text style'
szöveg típusból jön. Nyissuk meg a 'Text style' beállításokat a 'Text style' mez? melletti 'Define' gombra kattintva. Ekkor megjelenik az elmentett 'Text
style'-ok listája, de szerintem csak azok amik a 'Plot plan layer set'-ben szerepelnek:

Nyissuk meg szerkesztésre a 'Plot plan text style' stílust. Itt állíthatjuk be a karakter típust, és a karakterek méretet.
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Láthatjuk, hogy a jelenlegi karakter magasság 250mm és a kiválasztott bet? típus 'Chief Bluprint'.

Ha megnyitjuk a 'Default settings'-ben a 'CAD -> General CAD' beállításokat, akkor itt is láthatjuk, ahogy a 'Plot plan view' beállításokban is láthattuk,
hogy ha a 'Plot plan view' aktív, akkor a kiválasztott CAD layer a 'CAD plot plan', ami meghatározza, hogy a CAD elemek ezen a view-n ide fognak
kerülni, és meghatározza hogy hogyan jelenjenek meg.

Warning
A 'Default settings' tartalma mindig az éppen aktív view beállításait mutatja. Tehát mikor a 'Plot plan view'-ban megnyitjuk a 'General CAD' fület, akkor
amit a dialógusban átírunk, az csak a 'Plot plan view'-ra lesz hatással.

A 'Plot plan view'-hoz tartozó 'CAD Default' ablakban a 'Display line length format' melletti 'Define' gombra kattintunk, akkor beállíthatjuk, hogy hogyan
jelenjenek meg azon CAD elemek hosszai, ahol be van kapcsolva hogy mutassa az elem hosszát:
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Itt állíthatjuk be, hogy mi legyen a mértékegység, és hogy hány karakter legyen a tizedes mögött. Domborzat esetén a mm már túl apró lenne, itt már
méterre van szükségünk. Ennek az átállítása azért fontos, mert a Terrain Perimeter vonalain ha meg akarjuk jeleníteni a vonalak hosszúságát, akkor ez
a CAD beállítás fogja meghatározni. Tehát állítsuk méterre és a 'Decimal places'-t állítsuk 2-re. Ezen felül meg lehet minden vonal mellett jeleníteni
hogy hány fokban áll. Ez a telek határoló vonalai esetén nagyon praktikus, mert mutatja a tájolását minden egyes határvonalnak. A 'CAD default'
ablakban a 'Display line angle as' szekcióban állíthatjuk be hogy a tájolást milyen módon jelenítse meg. Az alapértelmezett az 'Angle' ami nem túl
informatív ha fokokban mutatja, állítsuk be a 'Quadrant bearing'-et, aminek a hatására a négy égtály kominációjával fogja megjeleníteni a telek
körvonalának a tájolását:

Terrain kezelése
North pointer

Az irányt?t a 'CAD -> Lines -> North pointer' menüponttal adhatjuk hozzá:

Sun angle
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...TODO...

Rebuild terrain

Mikor 'Elevation point'-okat vagy 'Elevation line'-okat rakunk a fel pl 'Plot plan view'-ban, és az automatikus terrain generálás nincs bekapcsolva, akkor
az újonnan hozzáadott 'Elevation point'-ok nem lesznek hatással a domborzatra egészen addig, amíg nem nyomjuk meg a 'Terrain tool'-on belül a 'Build
terrain'-t:

Ha megnyitjuk a terrain beállításait, akkor 'General' fülön kapcsolhatjuk be az 'Auto rebuild terrain' funkciót, ami szerintem nem mindig m?ködik, volt
hogy manuálisan rá kellett nyomjak.

Domborzati magassági vonalak megjelenítése

A 'Plot Plan view'-ban alapértelmezetten nem jelennek meg a terrain domborzati vonalak:

Ezt a 'Terrain, Primary Contour' layer-el kapcsolhatjuk be:
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Alapértelmezetten a negatív domborzati magasságokat pirossal rakja ki a CA. Ezt a Terrain beállításaiban a 'Contour' fülön a 'Highlight Negative
Elevations' -el kapcsolhatjuk ki:

Terrain megrjzolása

Menjünk át a 'Terran Configuration' eszköztárba ( ) a toolbar jobb fels? sarkában, majd válasszuk a 'Terrain tool'-ból válasszuk a 'Create terrain
perimeter' eszközt:
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Ami létre fog hozni 0 magasságon 0-0 középpontban egy sík téglalap alakú domborzatot:

Ha meg akarjuk jeleníteni a Terramin perimeter vonalak hosszát, akkor els?re ahogy láthattuk az el?z? fejezetben a 'Default settings -> CAD -> General
cad -> Display line length format' alatt állítsuk be, hogy méterben mutassa és két tizedesig. Majd nyissuk meg az elkészült domborzathoz tartozó
'Terrain specification' dialógust, és a 'Line syle' fülön pipáljuk be hogy a hosszat is mutassa:
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Ekkor a paln view-ban meg fog jelenni a dombozrazt határain a hossz.

Azonban a 'terrain'-t mindig érdemes nagyobbra rajzolni mint az aktuális telek, mivel utakat, növényeket csak terrain-rre lehet rakni, így ha a környezetet
is rá akarjuk rakni, akkor a terrain-nek jóval nagyobbnak kell lenni.

Draw lot perimeters, import terrain image

Mivel a terrain-t nagyobra csináljuk mint a 'lot' mérete, ezért a terrain-en CAD vonalakkal be fogjuk jelölni a valódi lot méretet. Ehhez, ha van egy képünk
egy földhivatalai térképr?l, ami pontosan tartalmazza a telek méretét és alakját, azt fel tudjuk használni kiindulási pontnak. Másoljuk be a képet pl 'plot
plan veiw'-ba COPY-PASTE-el, majd a 'Point to point resize' fejezetben leírtak szerint méretezzük át a képet a modellnek megfelel? méret?re, majd
forgassuk a megfelel? szögbe a [[#Rotate_around_custom_point|'Rotate around custom point'] fejezetben leírtak szerint. Ezután mozgassuk a helyére a
'Point to point move' fejezetben leírtak szerint.

Ezután rajzoljuk meg a lot valódi körvonalát a kép alapján CAD vonalakkal körbe, amíg nem alkotnak egy zárt formát. Ehhez induljunk el a kép egyik
sarkából, és ahogy húzzuk a CAD vonalat nyomjuk meg a TAB-t. Ekkor fel fog jönni az 'Enter coordinates' dialógus, ahol pontosan megadhatjuk a CAD
vonal hosszát. A hosszat az importált térképr?l puskázhatjuk le.
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Ha balról jobbra húztuk a vonalat, akkor negatív lesz a hossz, ha balról jobbra akkor meg pozitív.

Ha körbeértünk, akkor nyissuk meg az új CAD formát ami a lot határiait szimbolizálja, és tegyük át egy új rétegre, amit direkt erre a célra hozunk létre. A
CAD forma beállításaiban menjünk a 'Line style' fülre, és a 'Layer' sorba menjünk rá hogy 'Define':

A megnyíló 'Layer display options' ablakban hozzunk létre egy új Layert-t 'Terrain, perimeter lot' néven:
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Majd OK. Ekkor a lot körvonalát tartalmazó CAD forma átkerült a 'Terrain, perimeter lot' rétegre. Kapcsoljuk be rajta a hossz megjelenítést a kerület
mentén. Ehhez szintén a 'Line style' fülön pipáljuk be a 'Show length' dobozt:

Most már kitörölhetjük a képet a terrain alól. A végeredmény így néz ki:
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Utility schedule

https://www.youtube.com/watch?v=uhI0aSDEfWg Az 'Utility schedule' minden 'Site plan'-en szerepel. Ezen vannak bejelölve a közm?vek:

Ezeket 'Note-okkal tudjuk létrehozni pl a 'Plot plan view'-ban (jobb oldali ábra), majd azokból csinálunk egy 'Note schedule'-t amit els?ként átrakunk egy
'CAD detail'-re majd onnan küldjük el a layout-ra a site plan mellé.
Els? lépésként a plan-en válasszuk ki a 'Plot plan veiw'-t, majd adjunk hozzá egy note-ot a 'Note' eszközzel a 'Text tools'-ból:

Ekkor meg fog nyíli a 'Note specification' dialógus. Itt a 'Note' fülön állítsuk be:
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A 'Text' dobozba írjuk be azt a szöveget, ami majd a táblázatban meg fog jelenni. Jelen példában ez a Power line jelölése lesz, ezért írjuk be
hogy 'Power'.

• 

Type: itt válasszuk ki, hogy 'Plot plan notes'.• 
'Text above line': itt írjuk be azt ami a formában meg fog jelenni, ami a példában egy 'P' bet?.• 
'Shape': square, vagyis négyzet legyen a forma.• 

Majd ha elmentettük, meg fog jelenni az új callout:

Most húzunk a callout-ból egy CAD vonalat az épület azon sarkához, ahol az áram vezeték be fog menni:

Majd nyissuk meg a vonal beállításait, és itt a 'Line style' fülön a 'Style' melletti 'Library' gombbal nyissuk meg a Library browser-t.
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Itt írjuk be a keres?be, hogy 'Property line', majd válasszuk a 'Property line (large)-ot a listából, majd mentsük el. Ekkor a plot plan view-ba a vonalra rá
lesz írva, hogy 'P/L'.

Ezt ugyan így csináljuk meg a többi közm?re is.

Majd menjünk a 'Tools -> Schedule -> Note schedule' menüpontba, és adjunk hozzá egy új táblázatot a view-hoz.

Láthatjuk, hogy az írás túl kicsi rajta. Nyissuk meg a note schedule beállításait, majd a 'General' fülön állítsuk be, hogy ne jelenjen meg a címe:

Az 'Attributes' fülön állítsuk be, hogy se kerete se bels? grid-e ne legyen a táblázatnak.

A 'Text style' fülön állítsuk be hogy 'Use custom text style', ekkor az egyedi beállítások aktívvá vállnak. Állítsuk be a 'Character height' értékét 250
mm-re

Ha elmentjük, láthatjuk, hogy a bet?méret már jó a táblázatban, viszont most az oszlopok túl szélesek:
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Fogjuk meg a táblázat közepén lév? kis pöttyöt benne a függ?leges kis vonallal, majd húzzuk balra, ezzel át tudjuk méretezni az els? oszlop
szélességét:

Hozzunk létre egy új 'CAD detail'-t a CAD menüpont 'CAD detail manager' menüpontjában, nevezzük el 'Utility shcedule'-nek, és Cat -> Past-el rakjuk
oda át az 'Note schedule' táblázatunkat:

Majd húzzunk mind a két sor mellé egy CAD vonalat. Nyissuk meg sorba a két CAD vonal beállításait, és a 'Line style' fülön a 'Style' melletti 'Library'-ra
kattintva, válasszuk ki a 'Library'-ból a 'Property Line'-t:

A Water sor esetében pedig a 'Cold water'-t:

Most már elküldhetjük a site plan layout-ba a 'Sent to layout' gombbal.
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Láthatjuk, hogy a Utility schedule címe a doboz alatt jelenik meg és túl vékony írással. Azt szeretnénk, hogy a doboz fölé kerüljön, és vastagon legyen
szedve.
A layout-okon a dobozok címei a 'Layout box labels' rétegen vannak:

Ennek a rétegnek a szövegbeállítása a 'CAD text style'. Nyomjunk rá a define-ra hogy létrehozzunk egy új szöveg stílust. Válasszuk ki a listából a 'CAD
text style'-t, majd mondjuk, hogy 'Copy', és nevezzük el 'CAD text style, bold'-nak. Ha ez megvan, akkor 'Edit' és itt állítsuk be a 'bold' bet?típust. Ezután
a 'Layout page display options'-ben a 'Layout box labels' réteghez állítsuk be, hogy a 'CAD text style, bold' tartozzon:
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Ekkor az összes 'layout box' címke vastagra fog változni:

Most méretezzük át a layout box-ot mert túl nagy. Ehhez jelöljük ki, majd az alsó menüb?l válasszuk a 'Rescale layout view' eszközt.

A megnyíló 'Change scale' dialógusban állítsuk be, hogy az arány 1:80 m legyen.

Most a méret már jó, csak a címet kell átrakni felülre:
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Ehhez nyissuk meg az Utility schedule 'Layout box specification' dialógust, majd a 'Label' fülön az 'Y offset'-et állítsuk be -50mm-re:

Ezzel készen is vagyunk:

Terrain metszet

A terrain-b?l nem lehet cross section view-t csinálni, mert nem fog látszani a körvonala. Az alábbi ábrán lév? lév? metszetet kerítés segítségével
készíthetjük el.

Lássuk a lépéseket:

Plot plan veiw-ban tegyük kerítést a telekhatárra azokra az oldalakra, amir?l metszetet akarunk készíteni. Azonban alapértelmezetten nem követi a
domborzatot:
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Nyissuk meg a kerítés beállításait, és a 'Rail style' fülön pipáljuk be hogy 'Follow terrain':

Most készítsünk egy 'Blackclipped cross section' plot plan view-ban a kerítésr?l:

Most kapcsoljuk be az 'Active layer display options'-ben a kerítés réteget.

Ekkor megjelenik a kerítés a cross section-ben aminek a póznái már kijelölik a domborzatot az adott telek határon.

Most a Line eszközzel kössük össze a kerítés lábait, úgy hogy a C-t lenyomva tartjuk, így tudunk szabad szögben rajzolni:
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Most jelöljük ki az új polyline-t majd az alsó menüben kattintsunk a 'Close polyline' ( ) eszközre, amivel bezárjuk a polyline-t. Most adjunk hozzá
még két töréspontot az alsó szakaszra a 'Break' eszközzel az alsó menüb?l és formázzuk háromszög alakúra ahogy az alsó ábrán látható:

Most már törölhet? a kerítés. Most a jobb alsó sarokba húzzunk egy kis vonal darabot, ezt fogjuk lemásolni 5 méterenként:

Jelöljük ki, majd az alsó menüben lév? 'Replicate/Transform object' eszközzel másoljuk le 5 méterenként az x tengely mentén 5 példányban:

Majd minden pálcikát mozgassunk a forma belsejébe:

Most küldjük el a nézetet egy 'CAD detail' -re a 'CAD -> CAD detail from view' menüponttal:
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Nyissuk meg a CAD detail nézetet és rajzoljunk egy vonalat az út magasságába, ami a 0 pont lesz, majd állítsuk be hogy szaggatott vonal legyen:

Majd 'Point to point dimension'-el kezdjünk el dimenziókat húzni 5 méterenként a 0 vonalhoz. És 'Manual dimension'-el az alsó vonal mentén egy
húzással az összes alsó vonal mentén az összes 5 méteres dimenziót felrakhatjuk.

A dimenziók a 'Dimension manual' rétegen vannak:

Láthatjuk, hogy a bet? stílus a 'Plot plan text style'. Nyissuk meg a 'Define' gombbal, majd 'Edit', majd írjuk át a bet?magasságot 500 mm-re:
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Adjunk sraffozást a formának. Kattintsunk a háromszög formára, majd a be 'Polyline Specification' dialógus 'Fill Style' fülén válasszuk típusnak a 'hatch,
Angle' típust, és 'Width'-nek állítsunk be 150mm-ert:

Ekkor már itt tartunk:
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Most küldjük el egy layout-ra a bal fels? menüben lév? 'Send to layout' gombbal és a 'Rescail layout view' ( ) eszközzel méretezzük be.

Épület feltüntetése a helyszín rajzon
Sajnos nincs rá egy gombnyomásra m?köd? módszer, hogy az alábbi ábrát el?állítsuk, hogy az épület tet?stül így megjelenjen a site plan-en, legalábbis
én nem tudok róla.

Sajnos a plot plan view-ban mindig az épület 1. szintjét látjuk, és ha felmegyünk a 2. szintre, vagy le a 0. szintre, az alagsorba, akkor a terrain elt?nik.
Ezért a legjobb módszer, ha CAD elemekb?l megrajzoljuk a házat a kontúr vonalak alapján. A fenti képen a ház a következ? képen készült.

Felmentem a 2. szintre, ami hatására elt?nt a terrain, de megjelent a tet? körvonala.• 
A tet? szegmensekre 'Rectangular polyline'-okat kell illeszteni:• 

Ezek tetsz?leges formára igazíthatóak, és új töréspontokat is hozzá lehet adni.
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Hozzunk létre egy új layer-t amire tegyük rá az összes tet? Polyline szegmenst. A layer neve legyen 'CAD Plot plan, roof':

Ezután átmenetileg minden layer-t kapcsoljunk ki, csak ez maradjon aktív. Vágjuk ki (Cat), majd menjünk egy szinttel lentebb, és ott 'Past,
hold postion'-el illeszük be. Ekkor megvan az emeleti tet? kontúrja.

• 

Ugyan így készítsük el az 1. szint tet? kontúrját is. A polyline-nak állítsuk b a 'Fill style'-ba a cserép mintát. Az irányt (Angle) megfelel?en
variáljuk 0° és 90° között.

• 

Az es?csatornát szintén 'Rectangular polyline'-al rajzoljuk meg és adjon neki solid kitöltést. Ezután tüntessük el a tet? layer-t.• 

Terrain formálása
Terrain wall

TODO: sima egyenes fal, ami követi a felszínt

Retaining wall

TODO: támfal, a két oldalán lév? magasságot fogja figyelembe venni, egy az egyben nem lehet bedönteni, ha lépcs?zetesre akarjuk, akkor azt
manuálisan kell odarakni, a retaining wall elé. A fal biztosítja a terrain domborzatot, és manuálisan elé rakjuk a dekorációt, pl lépcs?zetes füves
kockáckat.
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Lépcs? lejt?n

TODO: Kell készíteni egy landinget felül, egyet alúl, be kell állítani a magasságukat és le kell róluk szedni minden korlátot. A lépcs? tud két landing
között automatikusan generálódni. Még az egész alá be kell rakni egy elevation region-t, amivel a lépcs? alatt lenyomjuk a lejt?t, ha átütne.

Layouts
https://www.youtube.com/watch?v=8B9VBrObzqs

Note
Az egész CA vagy metrikus vagy imperial üzemmódban fut, ezt telepítés után ki kellett választani. Metrikus üzemmódban nem tudunk imperial templétet
betölteni és viszont.

Layout áttekintés
Létrehozás

A layout-ot mindig egy layout templétb?l hozunk létre. Majd a plan különböz? nézeteit el tudjuk küldeni a layout egy tetsz?leges oldalára. Több layout-ot
is létrehozhatunk egy plan-hez. A layout egy független fájl, amit külön mentünk el a plan mellé, tehát nem a plan fájl része. Vagyis minden tisztességes
projekt legalább egy plan és egy layout kiterjesztés? fájlt tartalmaz, és a plan és a layout külön életet élnek.

Egy plan-hez layout-ot a legegyszer?bben a 'File -> New layout' menüpontban adhatunk hozzá:

Ilyenkor a CA preferenciákban beállított alapértelmezett layout templétb?l fogja létrehozni a layout-ot. A layout templét nem más mint a váza a
layout-nak. Tartamazza a tervrajz méretét, és az összes statikus részét, akár a tejes layout vázat az összes oldallal valódi tartalom nélkül.
Minden layout (akár milyen templétb?l is hoztuk létre) mindig tartalmaz egy speciális oldalt, a 0. oldalt. Minden olyan információ amit a 0. oldalra rakunk
rá minden további layout oldalon meg fog jelenni. Egy layout templét nem csak a 0. oldalt tartalmazhatja (bár az alapértelmezett, beépített CA templétek
csak azt tartalmazzák) hanem tetesz?leges számú további oldalt, tehát a 0. oldal nem egyenl? a layout templéttel, a 0. oldal csak egy layouton fogható
fel a további oldalak templétjének. Ahányszor egy új oldalt adunk a layoout-hoz, akkor a keretet és a baloldali kvázi statikus oszlopot mindig a 0. oldal
alapján fogja legyártani a CA. A 0. oldal makrókat is tartalmazhat, a legáltalánosabb makró az oldalszám, ami minden oldalon automatikusan kiírja az
adott oldalszámot (akár csak MW Word-ben). Minden nem statikus tartalom már a layout adott oldalán kerül beszúrásra manuálisan.

Az alapértelmezett layout templét az 'Edit -> Preferences -> New plan' menüpontban állítható be. Amikor megnyomjuk a 'New layout' gombot, akkor
mindig ebb?l a templétb?l fogja létrehozni.
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Minden layout-nak a 0. oldala tartalmazza az összes statikus tartalmat. Amit itt módosítunk, az minden oldalon meg fog jelenni. Ezért mindig a 0.
oldalon van a keret és a jobb oldali alap infókat tartalmazó oszlop:

A 0. oldalon kell beírjuk a projekt/kliens nevét, címét, itt kell elhelyezni a cégünk lógóját (az alapértelmezett templétetn a 0. oldalon a CA logója van),
valamint a makrókat, pl az oldalszámot ami a jobb fels? sarokban van a default templéten. Majd az 1. oldaltól kezdve amit az adott oldalra rakunk az
csak azon az oldalon fog megjelenni. Fontos látni, hogy a 0. oldal egy layout-on nem egyenl? a layout templéttel, egy layout templét akár 20 el?re
gyártott oldalt is tartalmazhat, de minimum egy 0. oldalt mindig tartalmaz. Emellett tarthozhat még hozzá tetsz?leges számú további oldal, pl
gyárthatunk olyan layout templétet amiben a 0. oldalon felül van egy üres 'Site plan', egy üres 'floor plan' és pár üres 'elevation plan' oldalak, valamint
egy borító oldal, ahol ezekb?l egy tartalomjegyzék szerepel. Ha egy ilyen templétb?l hozunk létre egy layout-ot, akkor már nem lesz más dolgunk, mint
hogy az el?re gyártott oldalakra tartalmat rakjunk, nem kell azon agyalni, hogy milyen oldal hiányzik még, és hogy címet adjunk az oldalaknak.

Explicit kiválaszthatjuk, hogy milyen templétb?l akarjuk a layout-ot létrehozni a 'File -> Template -> New layout from template' menüpontban:

A layout nyomtatási méretét ellen?rizhetjük a 'File -> Print -> Drawing sheet setup' menüpontban. Itt át is tudjuk állítani a méretet, aminek az
alapértelmezett értéke a templétb?l jön, amib?l a layout-ot létrehoztuk.

Ha itt átállítjuk a méretet, attól még a templét (amib?l a layout-ot létrehoztuk) nem fog megváltozunk.

Layout elemei

Akárcsak a plan fájl, a layout is megjelenik a 'Project Browser'-ban a jobb oldalon. Viszont kevesebb mappából áll. A layout háromféle elemb?l épül fel:
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CAD Details: Akárcsak a plan fájlban is lehetnek 'CAD detail'-ek. Ugyan úgy tartozik egy 'CAD detail manager' a layout-hoz is mint a planhez.• 
Pages: na ez a legfontosabb. Itt láthatjuk felsorolva a layout összes oldalát. Amelyik éppen nyitva van, ott 'Open' címke szerepel, ami üres,
annak egy üres papír, amin meg van valami egy táblázatos papír a jele.

• 

Tables: Több féle táblázatot is elhelyezhetünk a layout-on, amib?l a két legfontosabb:
Layout page table: ez maga a taralomjegyzék♦ 
Revision table: ez meg egy terv részlet el?életét tartalmazó táblázat.♦ 

• 

Az oldalaknak van egy paraméter szerkeszt? dialógusa, a 'Layout page specification' dialógus, amit az 'Edit Page information' -el nyithatunk meg vagy a
jobb oldali Tool palettából vagy jobb click-el bármelyik page-ra a 'Project browser'-ben.

A megnyíló dialógus közös az összes oldal számára, a dialógus tetején lév? legördül?b?l választhatjuk ki, hogy melyik oldal beállításait akarjuk átírni.
Els?re mindig az az oldal van kiválasztva, amin rákattintottunk a dialgósu megnyitására:

Az itt felsorolt mez?k mindegyike egy külön oszlopban jelenik meg a 'Layout page table'-ben, ami a tartalomjegyzék (lásd lentebb). Legalább a label és
title mez?ket illik kitölteni.

Látni fogjuk, hogy csinálhatunk olyan templétet, amiben minden oldalon az oldal címe egy makróból jön, ahol a makró az itt megadott 'Title' mez?b?l
szedi az elemet. Ezel szépen templétezhetjük a layout-unkat (lásd lentebb).

A '#' a label beíró mez?ben egy spéci makró, egy futó sorszám. A label mindig a 'Title' el?tt fog megjelenni. Ha prefixet adunk a lablenke, majd mögé
írjuk a '#'-ot, akkor a futós sorszám prefixenként fog futni, ezzel tudjuk megvalósítani a USA tervrajzokon megszokott bet?-s oldal csoportosítást:

G: general rajzok• 
L: landscape• 
A: architectural• 

Ha a 'Label' mez?be pl ezt írjuk: 'A-#' több oldalon is, akkor az A prefixü label-ellel rendelkez? oldalakon a sorszámot automatikusan növelni fogja ill.
karban fogja tartani a CA:

A-1• 
A-2• 
A-3• 
L-1• 
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L-2• 

Layout használata
Bevezet?

Ha létrehoztunk egy új layout fájlt (amit a CA szerint a legjobb ha ugyan abban a mappában tartunk, ahol a plan fájl is van) akkor bármelyik view-t,
kamera nézetet, cross-section-t vagy CAD-detail-t el tudunk küldeni a layout kijelölt oldalára:

Ezek megtarthatják a kapcsolatot a plan fájlal, ami azt jelenti, hogy ha a plan-en módosítjuk a nézetet, akkor a layout-ban is módosulni fog.
Mindig a teljes view-t, cross-seciton-t vagy CAD-detail-t lehet elküldeni a layout egy megadott oldalára, amit aztán ott le tudunk vágni vagy átméretezni.
Egy view-nak vagy CAD-detail-nek egy része külön nem elküldhet?. Ugyan lehet?ség van rá, hogy kapásból úgy legyen trimmelve a layout-on view-ból
képzett doboz, hogy csak az eredeti view egy része látszódjon rajta, de ett?l még a teljes view tartalom ott van, csak el?re ki van nagyítva akkorára,
hogy a felesleges részek ki legyenek takarva.

Note
A layout-nak nyitva kell lennie ugyan abban a CA példányban, ahol a plan is található. A nyitott plan-ek és layout-ok külön fülre kerülnek a CA-ban

Minden layout oldalon úgynevezett 'Layout box'-okból épül fel. Egy 'Layout box' mindig egy view-hoz, Cross-section-höz vagy CAD-detail-hez tartozik,
és a view tartalma csak a dobozon belül látszik az adott layout oldalon.

A fenti ábrán 3 layout doboz látható a layout 2. oldalán. Az alsó és a fels? egy-egy CAD-detail-hez tartozok, míg a középs? a 'Plot plan view'-hoz. Az
hogy mekkora a 'Layout box', vagy hogy az adott méret? layout box-on belül mi látszik a view-ból (vagyis hogy mennyire van ki-vagy bezoomolva) az
állítható. Mikor egy view-t elküldünk egy layout adott oldalára, akkor pont azokkal a layer beállításokkal fog oda átkerülni, ahogy a view-n is szerepelt. A
'Layout box' tehát egy maszk, aminek a méretezésével szabályozhatjuk, hogy mennyit takarjon ki az eredeti view-ból.

A 'Layout box' legfontosabb tulajdonsága a méretaránya, ami azt mondja meg, hogy a kinyomtatott tervrajzon az adott 'Layout box'-ban megjelen?
tervrajz részleten egy egység hány egység a valóságban. A layout mindig egy layout templétb?l fog létrejönni. A layout templét legfontosabb
tulajdonsága a papír méret, ez általában bene is van a templét nevében:
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Küldés a layout-ra

Egy veiw-t, cross-section-t vagy CAD-detail-t úgy tudunk egy szintén ugyan abban a CA példányban megnyitott (már létez?) layout-ra küldeni, ha éppen
az a view, cross-section vagy CAD-detail aktív, amit el akarunk küldeni, majd megnyomjuk a bal fels? sarokban a fels? menüben lév? 'Send to layout'
ikont. Ugyan ez a Fájl menüb?l is elérhet?:

Ekkor fel fog nyílni a 'Send to layout' dialógus, ahol nagyon fontos beállítások találhatóak:

Itt kell megmondani, hogy melyik layout-ba akarjuk küldeni a view-t. Ugyan is egy CA-ban több layout fájl is egyszerre nyitva lehet. Ha csak
egy van nyitva, akkor ezzel nincs dolgunk.

1. 

Page number: itt állíthatjuk be, hogy melyik oldalára küldje a view-t a layout-nak. Ha még nincs olyan oldal, akkor létre fogja hozni. Ha már
van más is az oldalon, akkor mellé fogja rakni.

2. 

Send options: mi látszódjon az elküldött view-ból. Minden esetben a teljes view-t, CAD-detail-t küldi el, azonban megmondhatjuk, hogy azt
hogy állítsa be, hogy mennyi legyen kitakarva:

3. 

https://wiki.berki.org/index.php/File:ClipCapIt-210506-010014.PNG
https://wiki.berki.org/index.php/File:ClipCapIt-210505-235409.PNG
https://wiki.berki.org/index.php/File:ClipCapIt-210509-221101.PNG
https://wiki.berki.org/index.php/File:ClipCapIt-210506-000137.PNG


'Entire Plan/View': Attól függetlenül, hogy mennyire vagyunk belezummolva az elküldend? view-ba, úgy fogja beállítani, hogy a
layout-on létrehozott doboz-ban a teljes view látszani fog

♦ 

'Current screen': Ha bele vagyunk zoomolva a view egy bizonyos részére, akkor a layout-on létrehozott dobozt eleve úgy fogja
beállítani, hogy pont annyi látszódjon a layout box-on belül, mint ami a képerny?n volt az elküldés pillanatában. Ett?l még persze a
teljes view ott van, csak már nem látszik, mert a 'Layout box' határi letakarják. Ha átméreteznék a layout box-ot nagyobbra, vagy a
benne lév? view megjelenítésének a scale-jét állítanánk kisebbre, akkor újabb részletek jelennének meg az eredeti view-ból (ezért
mondom, hogy valójában az ekkor is ott van csak le van takarva.

♦ 

'Current screen as image': Ekkor egy képet fog készíteni a view-ból amit képként fog beszúrni. Ez így sokkal kisebb számítás
igény?, de kés?bb nem módosítható, és nem is követi a model változásait.

♦ 

'Camera view options': csak kamera és cross section képek esetén azt határozz meg, hogy ha változik a model, akkor hogyan változtassa a
3D-s képet illetve a cross sectin rajzot a layout-on.

4. 

'Scaling': Mekkora legyen a méretaránya a view-nak a layout-hoz beállított papír mérethez képest. Tehát fontos hogy mekkora papírra lesz
nyomtatva a tervrajz, ez még a layout templat-b?l jön. A scaling beállításával pontosan lehet tudni, hogy egy egység az adott 'Layout box'-on
belül nyomtatás után, hány egység a valóságban. Ezt úgy kell megválasztani, hogy a legjobban ráférjen a kinyomtatott tervrajz adott oldalára.
Ezt kés?bb is át lehet állítani. Pontosabban ezen a ponto még elég nehéz tudni, mi legyen a 'layout box' méretaránya, ezt hagyjuk az
alapértelmezett 1:50 m -en.

5. 

Rajz stílusa / frissítés a layout-on

A 3D-s kamerak view-k és a 2D-s cross section view-k esetében aktív a 'Camera view options' szekció a 'Send to layout' dialógusban. Azonban
máshogy viselkednek kamra és cross-section esetében:

kamera view esetében: Csak a Live view aktív, ahol két lehet?ségünk van. Automatikusan mindig frissítse a kamera képet tartalmazó layout
box tartalmát a CA ha a kamera nézet megváltozik, vagy manuálisan mi firssítsük. Az automatikus update elég számítás igényes, viszont így
tutira nem felejtjük el frissíteni nyomtatás el?tt.

• 

cross section esetében: Cross section-re két lehet?ség is van:
Live view: Ilyenkor ugyan úgy mint a kamera esetén egy az egyben a cross section view-t fogja áthozni, aminek a min?sége elég
gyatra.

♦ 

Plot line: Generál az eredeti cross section alapján a CA cad vonalakat, és kiszínezi. Ilyenkor az automatikus firssítés nem
lehetséges.

♦ 

• 

Note
Cross section/elevation esetén mindig a 'Plot-line'-t válasszuk és abból is a 'Colore fill'-t. Ez adja a legjobb végeredményt

https://wiki.berki.org/index.php/File:ClipCapIt-210516-120234.PNG
https://wiki.berki.org/index.php/File:ImportantIcon.png


A fenti képen a bal oldali 'Live view'-val készült még a jobb oldali 'Plot line -> Color fill'-el.

A 'Live view -> Update always' opción kívül az összes több esetében manuálisan kell frissíteni a 'Live view'-t vagy a 'Plot line'-t. Erre két lehet?ségünk
van.

Layout box frissítése:
Ha a layout-on aktív egy layout box, ami vagy egy camera vagy cross section view-hoz tartozik, akkor a layout box tartalmát az alsó menüben található
'Update view' eszközzel végezhetjük el:

Összes view frissítése:
Layoutok esetén a fels? menüben található a 'Update Layout views' eszköz készlet.

Ez három lehet?séget tartalmaz:

És ezek a layout összes dobozában frissíteni fogják a camera és/vagy corss section view dobozokat.

Plot line - layout box szerkesztése

Ha a Cross-section view-t Plot line-ként küldjük el a layout-ra, akkor az az eredeti view-tól függetlenül szerkeszthet?. Mivel a 'Plot line'-ként létrehozott
layout box úgy viselkedik mint egy CAD detail rajz, minden benne lév? vonal CAD vonalként szerkeszthet? válik. Viszont ha frissítenénk a
layout-box-ban lév? view-t (lásd el?z? fejezet) akkor minden módosítás el fog veszni!!

A layout-box-on belüli 'Plot line' szerkesztést a fels? menüben lév? 'Edit plot line' eszközzel kapcsolhatjuk be. Amíg be van kapcsolva, minden
plot-line-ból készült layout box-ban szerkeszteni tudjuk mérsékelt módon a már létez? CAD vonalakat.
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Layout box-ok átméretezése

Ha view-t, cross-section-t vagy CAD-detail-t küldünk egy layout egy adott oldalára, akkor a méretarány kulcsfontosságú, ellentétben a képekkel és 3D
nézetekkel, ahol a méretarány irreleváns vagy nem is értelmezhet?. A méretarányra a legjobb ha úgy tekintünk, hogy megmondja, hogy mennyire
vagyunk belezummolva az adott view-ba, vagyis hogy a laphoz képest mennyire van lekcsinyítve. Egy layout-o lév? 'Layut box' kezdeti méretarányát a
'Send to layout' dialógusban állíthatjuk be mikor az adott view-t a layout egy adott oldalára küldjük, vagy utólag, ha kijelöljük a layout boy-ot és az alsó

menüben 'Rescale layout view' ( ) eszközre kattintunk. A megnyíló 'Change scale' dialógusban átállíthatjuk a korábban (küldés közben) beállított
layout-ot:

A 'Use layout line scaling' bepipálásával át fogja méretezni a méretaránynak megfelel?en a vonalak vastagságát is és egy a view-n nagyon dundinak
látszó vaonal átméretezve akár egészen vékony is lehet.

A méretarányon felül a 'Layout box'-ot átméretezhetjük, ami azt szabályozza, hogy az adott méretarány mellett mennyi látszódjon az eredeti view-ból,
vagyis mekkor legyen a maszk 2D-s kiterjedése. Ezt a 'Layout box' szélein lév? vonalak mozgatásával tudjuk szabályozni.

A 'Layout box' sarkait megfogva szabálytalan alakúra is átformálhatjuk a maszkot és a 'Break' eszközzel töréspontok mentén kiszögeléseket is
rakhatunk bele.

Ha lenyomjuk az 'X'-et és úgy húzzuk meg a sarkoknál fogva a 'Layout box'-t, akkor egyenletesen fogja növelni vagy csökkenteni a box (vagyis a
maszk) méretét.

Note
Fontos látni, hogy a 'Layout box' átméretezése a méretarányon nem változtat!! Csak azt szabályozza, hogy az adott méretarány mellett mennyit és mit
lássunk a view-ból
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Méretarány megjelenítése

A 'Layout box'-ok alatt terv részletet tartalmazó layout box estén illik megjeleníteni az adott tervrészlet méretarányát:

Ezt kétféleképpen rakhatjuk oda:

1. Manuálisan:
A 'Layout box' beállításaiban a 'Label' fülön bepipáljuk, hogy 'Suppress label':

Majd manuálisan hozzáadunk egy 'Ritch text' elemet a layout-hoz a doboz alá, amibe kézzel beleírjk a korábban beállított méretarányt:

A címet balra, a méretarányt kisebb bet?kkel jobbra rendezzük, így áll el? a fenti képen látható végeredény is.

2. Makró használatával:
A 'Layout box' saját Label -ét használjuk a cím megjelenítésére, amibe beletesszük a %box-scale% makrót is.

Ennek az a hátránya, hogy a felbontást nem lehet külön formázni, pont akkora lesz mint a 'Layout box' címe. Nagy el?nye visont, hogy
megváltoztatnánk a felbontást, akkor ez automatikusan levköveti, nem tudunk hibázni azzal, hogy egy rossz felbontás marad a doboz alatt:

https://wiki.berki.org/index.php/File:ClipCapIt-210506-012453.PNG
https://wiki.berki.org/index.php/File:ClipCapIt-210506-012652.PNG
https://wiki.berki.org/index.php/File:ClipCapIt-210506-012826.PNG
https://wiki.berki.org/index.php/File:ClipCapIt-210509-221816.PNG
https://wiki.berki.org/index.php/File:ClipCapIt-210509-222030.PNG


3D-s nézet és képek a layout-on

..:TODO... X-el méretezés ...

Beágyazás a plan-be, hogy hordozható legyen ...

Layout templét létrehozása
https://www.chiefarchitect.com/videos/watch/1/creating-a-layout-template.html?playlist=105
https://www.chiefarchitect.com/support/article/KB-00737/creating-and-using-layout-templates.html

Bevezet?

A gyári Layout templétek a 'c:\Program Files\Chief Architect\Chief Architect Premier X12 (64 bit)\Templates\' mappában vannak. Gyárilag két beépített
metrikus layout templét található benne, mind a kett? elég bénán néz ki:

ISO1A 594x841 Layout Template.layout• 
ArchD 24x36 Layout Template.layout• 

? baloldali a gyári metrikus de mi a default Chief Architect gyári imperial templétjét szeretnénk használni (jobb oldali)
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Sajnos ez metrikusan nem elérhet?, ezért le kell gyártani. A layout templét gyártása a következ?:

Fogunk egy létez? layout-ot1. 
Átalakítjuk olyan formára ahogy nekünk tetszik. A layout templét, vagyis a 0. oldala minden layout-nak szabványos CAD vonalakból és
szövegekb?l épül fel.

2. 

Elmentjük templétként3. 

Templét legyártása

Els? lépésként hozzunk létre egy új layout-ot a 'ISO1A 594x841 Layout Template.layout' -ból: "File -> Template -> New from template"

Mint azt láthattuk minden egyes layout-nak a 0. oldala a sablon, ami templétként szolgál asz összes oldal létrehozására. Ezért lépjünk az oldal
választóval a 0. oldalra:

Majd töltsünk le egy olyan Sample plan-t a CA oldaláról, ami a nekünk tetsz? CA default imperial layout-ot tartalmazza. Ezután töröljük ki a megnyitott
metrikus layout-unkból a baloldali oszlopot:

https://wiki.berki.org/index.php/File:ClipCapIt-210430-222604.PNG
https://wiki.berki.org/index.php/File:ClipCapIt-210430-222954.PNG
https://wiki.berki.org/index.php/File:ClipCapIt-210430-223120.PNG


Majd kerekítsük le a sarkokat a két négyzeten ami a keretet adja. Ehhez jelöljük ki els?ként a bels? keretet, majd az alsó menüben válasszuk a 'Fillet'
eszközt, majd a 'Set filet radius'-ban adjunk meg 5 mm-et, majd válasszuk a 'Fillet all corners' gobot.

Ugyan ezt végezzük el a küls? kereten is. Ekkor el?áll az a két gömbölyített keret, ami a default imperial CA layout templéten is van:

Most nyissuk meg a letöltött CA layout-ot amib?l ki szeretnénk indulni. Én ezt használtam:
https://cloud.chiefarchitect.com/1/samples/projects/bachelor-view/bachelor-view.zip
Majd menjünk ezen sample layout 0. oldalára, ahol a templétje található és másoljuk ki a jobb oldali "statius" infókat tartalmazó oszlopot és másoljuk be
az új layout-ba ahol korábban legömbölyítettük a sarkokat. Ekkor figyelmeztetést fogunk kapni, hogy Imerial-ból másolunk Metrics-be, ezért a méretek
nem fognak simmelni: "The object(s) on the clipboard come from a document with different units. The resulting size of the object(s) in the current
document will be wrong". Mondjuk hogy ok.
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Ekkor a pointer át fog változni a CA beszúró szimbólummá, amivel kijelölhetjük hogy hova illessze be:

Pozicionáljuk a jobb oldalra. Láthatjuk, hogy a beszúr oszlop sokkal kisebb mint amire nekünk szükségünk van:

Jelöljük ki a a most beszúrt oszlopot és válasszuk a 'Transform/Replicate object' ( ) eszközt. A megnyíló dialógusban állítsuk be a 'Resize factor'-t
nagyjából 2-re.

Ezt addig ismételgessük, amíg nem lesz pont akkora amit szeretnénk.

Ha a jobb fels? sarokban lév? 0-ás 'Sheet number'-re kattintunk, akkor láthatjuk, hogy egy makróval van megcsinálva:

A makrók listáját minden 'Text specification' dialógusban a makrók listáját a fels? 'M' ( ) gombbal nyithatjuk meg.

Itt a kliens nevét?l kezdve a program verziójáig minden jöhet makróból. A kliens és a saját irodánk adatait minden egyes layout-hoz be lehet állítani a
'Tools -> Project information' menüpont alatt.
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Az itt beállított paraméterekre mind lehet makróval hivatkozni a layout templat szövegeiben (vagy bárhol másol a programban ahol szöveget szúrunk
be):

Templét mentése

Az el?bbi lépésekkel pusztán létrehoztunk egy custom layout-ot, aminek a templétjét átszabtuk a kívánt formára. Most ezt el kell menteni "valódi" layout
templét-ként, hogy tudjuk használni más layout-ok létrehozására. Ehhez válasszuk a 'File -> Template -> Save as template' lehet?séget:

A felugró ablakban megkérdezni, hogy mit töröljön le a layout-ról, vagyis hogy tényleg csak a 0. oldalra felrajzolt dolgok maradjanak a templétbe.
Hagyjuk ahogy van, majd mehet az ok.

A 'Save as template' dialógusban állíthatjuk be, hogy mi kerüljön be a templétbe a mostani layout-ból. Jelenleg ezt a layout-ot kifejezetten a templét
létrehozására hoztuk létre, és csak egy 0. oldalt tartalmaz, így nincs nagy jelent?sége, hogy mit pipálunk az alábbi dialógusban:
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Ha bepipáljuk a 'Save template as default for metric layout' dobozt is, akkor automatikusan át fogja írni az 'Edit -> Preferences -> New plan' alatt az
alapértelmezett templétet erre. A tempéltetek ide szokás menteni: c:\Program Files\Chief Architect\Chief Architect Premier X12 (64 bit)\Templates\

A templét nevébe jó ha belekerül a méret szabvány (pl. ISO) és a lap méret (pl. A1) és számokkal is a méret (pl. 594x84):
ISO1A-594x841-my-Layout-template.layout

Több oldalas layout templét + tartalomjegyzék
https://www.youtube.com/watch?v=8B9VBrObzqs&t=1806s
Egy layout templétbe nem csak egy 0. (statikus) oldalt rakhatunk, hanem elkészíthetjük el?re a teljes tervrajz vázát üres oldalakkal, úgy hogy minden
oldalra csak egy placeholder-t rakunk. A templét tartalmazni fogja az összes szokásos oldalt címmel együtt, de az oldalak üresek lesznek, csak text
boxok fogják jelezni minden oldalon, hogy az adott helyre mi való.

Ez a legjobb módja annak, hogy ne felejtsünk el bizonyos típusú ábrákat elkészíteni, mindig fogjuk a templétet, "példányosítjuk", majd feldobáljuk rá a
plan-b?l az ábrákat a placeholder-ek helyére. Nagyon tuti módszer. A CA ugyan nem biztosít gyárilag ilyen több oldalas templétet, de elmondják hogy
szerintük ezt hogy érdemes megcsinálni, és hogy milyen oldalakat érdemes létrehozni. Ezen ajánlások alapján én az alábbi 23 oldalt definiáltam az új
templétben.

https://wiki.berki.org/index.php/File:ClipCapIt-210516-104436.PNG
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A végeredményhez ennél majd több kell, de ennyi tutira.

Az 1. oldal a borító, ezen található mindig egy 3D-s kép a házról, és alatta egy project összefoglaló + egy tartalomjegyzék. Ezt követik a floor plan és
elevation oldalak, és így tovább.

A több oldalas tempétet ugyan úgy kell elkészíteni hogy els?ként létrehozunk egy új layoutot a csak a 0. oldalt tartalmazó templétb?l, amit az el?z?
fejezetben készítettünk, majd egyenként hozzáadjuk a szükséges oldalakat, amikben lehelyezzük a placeholdereket, majd az egészet megint elmentjük
templétként.

Oldal címek és label-ek beállítása

Miért adjunk címet az oldalaknak:

A CA-ban minden layout oldalnak lehet adni címet és címkét. Ha az oldalaknak van címe, akkor azokból tud a CA automatikusan
tartalomjegyzéket generálni.

• 

A 0. oldalon elhelyezhetünk egy oldal cím makrót, ami hatására minden oldalon a CA meg fogja jeleníteni az oldal beállított címét, nem kell
minden oldalon ezt a keretben kitölteni.

• 

Az oldal címe megadó dialógusban makrókat is használhatunk, amivel automatikus címkézést valósíthatunk meg, és el?állíthatjuk vele a
szokásos G-XX (General), A-XX (Architectural), L-XX (Landscape) ... prefixelt megjelölt oldalszámozást is, ahol a prefix utáni sorszámot a CA
automatikusan fogja minden prefix esetén 1-t?l futtatni.

• 

A layout-on található oldalaknak egy darab közös oldal információ beállító dialagóusa van. Ezt két helyr?l is megnyithatjuk.

Ha a project browser-ben jobb klikkel bármelyik oldalra kattintunk, akkor majd a 'Page layout information'1. 
A jobb oldali 'Tool Palette' -en 'Edit page information'2. 
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Bárhonnan is nyitottuk meg, a 'Layout page specification' dialógusban az összes oldal adatait szerkeszthetjük, egy legördül? listából választhatjuk ki,
hogy melyik oldal címét és címkéit akarjuk átírni:

Ha a 'Project browser'-b?l nyitjuk meg, akkor az az oldal lesz kiválasztva, ahonnan megnyitottuk jobb klikkel.
A tartalomjegyzékbe mind a négy mez? szerepel alapértelmezetten:

Label1. 
Title2. 
Description3. 
Comment4. 

Ezek mindegyike makró formájában is elérhet?, így dinamikusan megjeleníthet? minden oldalon, ha a 0. oldalra elhelyezzük az ehhez tartozó makrókat.
(Lásd lentebb). Minden oldalon töltsük ki a címet. Csupa nagybet?kkel, az alábbi oldalakat ajánlja a CA oktató:

PROJECT SUMMARY1. 
SITE & DISTURBANCE PLAN2. 
FRONT ELEVATIONS3. 
SIDE ELEVATIONS4. 
1ST FLOOR PLAN5. 
2ND FLOOR PLAN6. 
BASEMENT FLOOR PLAN7. 
FAUNDATION PLAN8. 
1ST FLOOR CEILING PLAN9. 
2ND FLOOR CEILING PLAN10. 
FLOOR FRAMING PLAN11. 
WALL FRAMING12. 
ROOF FRAMING PLAN13. 
SECTIONS & 3D SECTIONS14. 
SECTION & DETAILS15. 
SECTION & DETAILS16. 
DOOR & WINDOW SCHEDULE17. 
INTERIOR ELEVATIONS18. 
INT. PERSPECTIVES & ELEVATIONS19. 
ELECTRICAL PLAN20. 
PLUMBING & HVAC PLAN21. 
KITCHEN PLAN & ELEVATIONS22. 
BATH SUIT PLAN & ELEVATIONS23. 

https://www.archtoolbox.com/practice/contract-documents/condocsheetorder.html
Ha használni szeretnénk a szokványos oldal prefixelést és csoportosítást, hogy az alábbi sokszor használt jelölést kapjuk:
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G - General Sheet list, symbols, code summary, etc.• 
L - Landscape• 
S - Structural• 
A - Architectural• 
I - Interiors• 
F - Fire Protection• 
P - Plumbing• 
M - Mechanical• 
E - Electrical• 

0 - General: Symbol legend, abbreviations, general notes• 
1 - Plans• 
2 - Elevations• 
3 - Sections• 
4 - Large Scale Drawings: plans, elevations, sections (NOT details)• 
5 - Details• 
6 - Schedules and Diagrams• 

Nincs más dolgunk, mint hogy az oldalak label mez?jébe beírjuk a bet?t prefix bet?ket és számokat, és a futós sorszámot a '#' makró használatával egy
prefixen belül a CA maga fogja futtatni:

Sajnos minden prefix-et külön csoportnak vesz, és újra kezdi a számozást minden prefix esetében, tehát az A1 és A2 esetében külön oldalszámot fog
kezdeni, így az oldal al-típust nem tudom hogy lehetne behozni a képeltbe. Viszont az A-# jelölés m?ködik, vagyis egy bet? után a számot
automatikusan fogja 1-t?l növelni.

A 0. oldalra tegyünk ki egy Text mez?t, amibe tegyük bele a '%layout.title%' makrót. Ez minden oldalon meg fogja jeleníteni az oldal beállított címét.

Tartalomjegyzék

A tartalomjegyzék a 'Page layout specification' dialógusban beállított mez?kb?l készül? táblázat, ami többnyire automatikusan frissül, viszont csak
azokat az oldalakat teszi bele a tartalomjegyzékbe, amin van is valami. Az üres oldalakat nem. Ha majd templétet csinálunk a layout-ból, akkor minden
olyan layout-on automatikusan meg fog jelenni a tartalomjegyzék, amit ebb?l a templétb?l hozunk létre. Ha majd az ebb?l létrehozott layout-on kés?bb
új oldalakat adunk hozzá ezeken felül, akkor fontos, hogy azokon is beállítsuk a címet és hogy be legyen pipálva, hogy megjelenjenek a page layout
táblzáatban.

A tartalomjegyzéket a 'Tools -> Layout -> Layout page table' -el helyezhetünk el egy oldalon, vagy a fels? menüben van rá külön ikon:
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A tartalomjegyzéket célszer? az 1. oldalra tenni.

A táblázat elég nagy, és felesleges oszlopokat is tartalmaz. Nyissuk meg dupla klikkel a specifikációs dialógusát, majd a 'General' fülön állítsuk be, hogy
a címet ne jelenítse meg, dobjuk ki a felesleges oszlopokat, és ne jelentsük meg a fejlécet.
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A 'Text style' oldalon állítsuk be a bet?méretet és a színt.

Majd tegyünk egy 'Text' box-ot kézzel a táblázat fölé, aminek szabadobban állíthatunk be stílust:

Disclaimers/Notes

A CA-ban a 'Library browser'-ben találunk több el?re gyártott szöveget, amik minden tervre passzolnak. Ezek között vannak 'nyilatkozatok' és
megjegyzések.

Ezekben a cégünk helye egy placeholder-el van helyettesítve. Kérdés hogyan tudjuk ebben kitölteni ezeket a placeholder-eket:
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Ezeket is úgy kell módosítani mint minden más CAD blockot. Szúrjuk be a layout templétünk megfelel? oldalára, majd jobb click és a felugró menüben
válasszuk az 'Explode CAD block' lehet?séget:

Ekkor a beszúrt CAD blokkból el?bújik a Rich text tartalom, ahol már át tudjuk írni a szöveget. Itt a szöveg színét is át tudjuk írni:

Layout templét mentése

A 'File -> Template -> Sava as template' menüpontban tudjuk templétként elmenteni. A felugró dialógusban állítsuk be, hogy csak a 'Client Info' és a
'Revision entries' legyen törölve, más ne, mert használtunk CAD dolgokat a templétet, azokat ne törölje le.

Majd mentsük el a 'c:\Program Files\Chief Architect\Chief Architect Premier X12 (64 bit)\Templates\' mappába ezen a néven: ISO1A
594x841-multi-page-Layout-Template

Terv/épület adatok, méretek
Minden tervrajzon meg kell jeleníteni az össze alapterületet négyzetméterben, valamint szintenként és szobánként az alapterületet és méretet, valamint
az élettér nagyságát. Érdekes módon, ehhez elég kevés támogatást ad a CA meglátásom szerint.

Szobák mérete és alapterülete

A különböz? plan view-ban a szobák méretét és alapterületét címkékkel kapcsolhatjuk be.

Interior area: a szoba bels? mérete a bels? burkolatok között.• 
Interior dimensions: A szoba bels? falai által közrezárt terület• 
Standard dimensions: A küls? falfelületig mért méret.• 
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Szoba jegyzék / room schedule

A room schedule nincs a beépített schedule-ok között, a Custom schedule segítségével készíthet? el:

Hozzunk létre egy Custom Schedule-t egy új, üres 'CAD Details'-ben.
Nyissuk meg az új custom schedule beállításait. A legfels? sorban adhatunk ki nevet a megszokott módon.

A 'Group similar object' ne legen kiválasztva, hogy minden szoba külön sorba jelenjen meg, nem csoportosítsa pl az összes fürd?szobát.1. 
A 'Categories to include'-ból válasszuk ki a 'Room' kategóriát, és alatta azokat a szoba fajtákat amiket be akarunk rakni a jegyzékbe. Pl a
teraszt én kivettem.

2. 

A 'Columns to include'-ban válasszuk ki legalább az emeletet, nevet, méretet és területet. Ezek alapján tudunk majd az excel-ben
statisztikákat készíteni pl. emeletenként.

3. 
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És íme a végeredmény:
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Ahhoz hogy emeletenként kapjunk egy kimutatást az a teljes alapterületr?l, a legjobb ha excel-be átvisszük a teljes Schedule-t. Ehhez jelöljük ki az
schedule-t, majd másoljuk ki, és az excel-ben simán szúrjuk be:

Excelben könnyedén meg tudjuk határozni szintenként és az épület teljes "bels?" alapterületét is, amit aztán statikus szövegben tudunk beilleszteni a
layaout-okba.

Lakótér terület / living area

Az úgynevezett lakótérbe azok a szobák számítanak bele, ahol valójában életvitelszer?en tartózkodunk. Tehát a spájz vagy a gardrób szobák
alapértelmezetten nem számítanak bele. Minden szoba specifikációs dialógusában, a 'General' fülön be tudjuk állítani hogy az adott helyiség
beleszámítson e a teljes lakóterületbe.

A a lakótér teljes területét a '%living.area%' makróval írhatjuk ki valamelyik plan view nézetben. Ehhez helyezzünk el egy 'Rich text'-et valahol a terven,
majd az 'Insert makro'-ban vá
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Fontos, hogy ebbe csak azok a szobák fognak belekerülni, ahol ez meg van jelölve:

Szintenkénti lakóterület kiszámolása

Érdekes módon erre beépített módszer nincs. Ugyan a szoba jegyzékb?l ki lehet nyerni ezeket az infókat, de beépített makró nincs rá.

Ezért ...

Majd ezeket összeadni https://www.youtube.com/watch?v=xvf5X-DZGdU

Material list
A CA képes egy teljesen részletes anyag listát összeállítani amibe ha az anyagárakat is beleírjuk, akkor egy teljesen pontos költség számítást
kaphatunk a megtervezett házhoz. Azonban ehhez elengedhetetlen a pontos model.

Fontos, hogy az épület minden porcikájában helyesen legyen beállítva a rétegrend. Vagyis minden fal, tet? és födém olyan rétegekb?l álljon a
modellben mint majd a valóságban fog.

• 

Minden felhasznált anyagot úgy kell konfigurálni, hogy a régiónkban kapaható anyag méreteknek feleljen meg (pl, olyan OSB anyagot
használjunk a modellben, amiben a méret pontosan be van állítva a nálunk kapható táblaméretre)

• 

Az anyaglista alapját a komponensek képezik, ezért els? körben ismerkedjünk meg részletesen a komponensekkel, majd utána az anyaglista
kezelésével.

https://wiki.berki.org/index.php/File:ClipCapIt-211030-002217.PNG
https://wiki.berki.org/index.php/File:ClipCapIt-211030-002326.PNG
https://wiki.berki.org/index.php/File:ClipCapIt-211030-002519.PNG
https://www.youtube.com/watch?v=xvf5X-DZGdU


Anyagok és komponensek
Sajnos a CA Help fájlokban a komponensek és a hozzá tartozó anyagok leírás nem túl részletes, nagyon nehéz bel?lük megérteni a pontos m?ködést,
pedig a komponensek központi szerepet töltenek be a tervezésben ha anyaglistát is szeretnénk generálni.

A CA-ban a legtöbb objektum egy vagy több komponensb?l vagy al-komponensb?l áll. Ezek mind beépített gyárit objektum típusok. Minden objektumot,
amit a terven el tudunk helyezni legalább egy komponens alkot. A komponensek és az anyagok között a CA-ban egy furcsa kapcsolat van, amit
elmagyarázunk alább.

A legtöbb objektum esetében, a 'Specification' ablakban megtaláljuk a 'Materials' és a 'Components' füleket.

Ez a két fül el? van töltve az objektum beépített komponenseivel és az azokhoz tartozó anyagokkal. A beépített komponensek listáját a 'Components'
fülön vannak, még a hozzájuk tartozó anyagok listája a 'Materials' fülön találjuk.

Komponens fül
A komponens fülön minden komponens esetében azt szabályozhatjuk, hogy milyen módon jelenjen meg az objektumhoz tartozó komponens az
anyaglistában. A tervrajzon az összes objektum a komponensei által lesznek reprezentálva az anyaglistában függetlenül attól hogy mennyire összetett
az objektum. Ha egy tervrajzon szerepl? objektum összes komponensét töröljük, akkor a szóban forgó objektum semmilyen módon nem fog megjelenni
az anyaglista kimutatásban. Ha kiválasztunk egy komponenst, akkor a megnyíló táblázat sorai az anyaglista táblázat oszlopainak felelnek meg.

Ebben a táblázatban a 'Formula' definiálhatjuk, hogy a tervrajzhoz generált anyaglista megfelel? oszlopaiban milyen értékek szerepeljenek az adott
komponens esetében.

Talál a három legfontosabb mez?k:

ID: Az anyaglistában minden elem kategóriák szerinti csoportosításban jelenik meg. A komponenshez tartozó táblázatban az ID mez? egy
legördül? lista, ahol ki tudjuk választani az anyag f?kategóriáját. Ehhez a kategóriához generál majd automatikusan egy egyedi azonosítót a
CA, ahogy azt az el?z? ábrán is láthatjuk.

• 

Description: A komponenshez megjelen? név az anyaglistában. Ennek az értéke azért nagyon fontos, mert egyrészt ezáltal tudunk
beazonosítani egy sort az anyaglistában, másrészt az azonos 'description'-el rendelkez? sorokat a CA összevonja, és együttesen jeleníti meg
azokat az anyaglistában. Pl ha több helyen is ugyan olyan típusú betont használunk egy házalapban, akkor az össze köbméter számot fogja a
CA megmutatni nekünk, nem (csak) egyesével lesznek felsorolva ezek a komponensek.

• 

Count: Ez talán a legfontosabb mez?, itt definiálhatjuk, hogy milyen módon kalkulálja ki a CA a komponens anyagszükségletét.• 
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Minden 'Formula' mez?ben használhatunk fix, konstans értéket, vagy használhatunk Ruby makrókat is. A manuális megadáshoz nincs más dolgunk
mint egyszer?en begépelni a cellába a kívánt értéket. Ruby makró használatával a következ? fejezetben foglalkozunk.

Materials fül
A 'Materials' fülön az objektumhoz tartozó komponensekhez anyagot rendelhetünk hozzá. De a komponensek listája a 'Materials' a fülön nem b?víthet?
és nem is törölhet? bel?le elem, ez egy "beégetett" lista az objektum típusának megfelel?en. A komponenshez rendelt anyag nem csak a megjelenését
fogja megváltoztatni az objektumnak, hanem a CA az anyag tulajdonságai alapján fogja kiszámolni a komponenshez tartozó anyagmennyiséget az
anyaglistában. Ha egy gyári objektum (pl egy ajtó) több beépített komponensb?l áll, akkor a 'Materials' listában is egy több elem? listát láthatunk. Mind
két fülön ('Materials' és 'Componens') a komponens listát automatikusan generálja a CA mikor elhelyezünk egy új objektumot a tervrajzon. Minden
komponenshez vagy komponens kategóriához tartozik egy vagy több anyagtípus a 'Materials' fülön. Tehát egy komponenst több anyag is alkothat, de
ezeket az összerendeléseket nem lehet megváltoztatni, az objektum típusából adódik. Hiába adunk hozzá manuálisan egy komponenst egy a tervrajzon
szerepl? objektumhoz, ahhoz anyagot nem fogunk tudni rendelni, a manuálisan hozzáadott komponensek nem jelennek meg a 'Materials' fülön.
Nézzünk egy példát a 'Materials' listára. A baloldali ábrán egy egyszer? doboz 'Materials' fülét láthatjuk, míg a jobboldali ábrán egy ajtó 'Materials' fülét
mutatjuk meg:

Attól függetlenül, hogy a 'Components' fülön hogy manipuláljuk a komponens listát, a 'Materials' lista mindig fix marad, kizárólag az objektum típusától
függ.

Ruby alapok

Mi az a Ruby

A Ruby egy egyszer?, szkript alapú programozási nyelv, aminek a segítségével megadhatunk akár komplex formulákat is az anyagmennyiség
számítására. A komponensekhez tartozó táblázatokban, a 'Formula' mez?k mindegyikékben használhatjuk a ruby nyelven készült makrókat. Ett?l nem
kell megijedni, használatuk nagyon egyszer? még azok számára is, akik meg foglalkoztak még programozással. Ha a 'Formula' mez?ben nem statikus
szöveget szeretnénk használni, hanem Ruby formulát, akkor az érték megadását egy '=' jellel kell kezdeni, ez jelzi a CA számára, hogy a cellába írtakat
nem statikus szövegként kell értelmezni, hanem Ruby segítségével kell kiértékelni. Ez akár lehet egy egyszer? matematika m?velet is. Az alábbi
példában egy egyszer? képletet adtunk meg:

=2*3

Láthatjuk, hogy a CA ezt a Ruby segítségével kiértékelte, és a 'Value' oszlopban 6 jelenik meg.

A 'Formula' cellákban a képletek megadásánál használhatunk a komponenshez tartozó Ruby változókat, és beépített vagy általunk létrehozott makrókat
is. A makrók névvel el?re elkészített és elmentett Ruby képletek. Pl a legtöbb komponens esetében a 'volume' (térfogat) változóban van a komponens
által reprezentált objektum térfogata. Ha beírjuk a 'Count' sorhoz tartozó 'Formula' cellába hogy '=volume', akkor a 'Value' oszlopban meg fog jelenni a
komponens térfogata.

Note
Joggal merülhetne fel bárkiben a kérdés, hogy összetett objektumok esetében honnan tudja a CA, hogy melyik komponens térfogatát kell itt figyelembe
venni. Ezt rövidesen részletesen kifejtjük, de dióhéjban a következ? a lényeg. Mikor elhelyezünk egy objektumot a tervrajzon, akkor CA legenerálja az
objektum típusának megfelel? komponens listát, és ezen CA által generált komponensek esetében nem szükséges külön definiálni, hogy melyik
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elemér?l van szó az objektumnak, ezt a CA elfedi el?lünk. Viszont ha manuálisan adunk hozzá komponenseket a listához, akkor a CA már nem fogja
tudni, hogy az pontosan az objektumunk melyik porcikáját reprezentálja, és ott majd meg kell adni a változó teljes nevét ahhoz hogy a CA tudja, hogy
pontosan minek a térfogatára vagyunk kíváncsiak.

Azt hogy egy adott objektumhoz összességében milyen változók érhet?k el kétféle képen tudhatjuk meg:

Ruby konzol

Note
Ezen fejezet megértéséhez némi programozási el?ismeret szükséges, sajnos a könyv keretein túlmutatna ezen alapismeretek átadása is

A CA-ban van egy beépített Ruby konzol, ahol mindig az aktuálisan kiválasztott objektum vonatkozásában írhatunk Ruby szkripteket. Listázhatjuk az
elérhet? változókat, vagy kipróbálhatjuk az általunk írt makrókat. A Ruby konzol a 'Tools -> Ruby Console...' menüpontban nyitható meg. Az aktuálisan
kiválasztott objektumra mindig az 'owner' kulcsszóval tudunk hivatkozni. A kiválasztott objektum összes elérhet? attribútumát így listázhatjuk:

owner.names

Ha egy fal objektum van kiválasztva, mikor a Ruby konzolt megnyitjuk és beírjuk az 'owner.names' kifejezést, akkor az alábbi változó listát kapjuk:

=> [..., "wall_type", ..., "layer", "upper_layers", ... ""lower_layers", .... "length", ]

Ez azt jelenti, hogy a kiválasztott fal objektumunk (amire az 'owner' kulcsszóval hivatkozunk) az itt felsorolt változó nevekkel rendelkezik. Ha a fal típus
nevére vagyunk kíváncsiak, a fenti lista alapján: owner.wall_type

A listában szerepl? változók közül vannak összetett objektumok (további változókat tartalmaznak) tömbök, boolean-ek, Integer és String típusú változók
is. Falak esetében az alábbi változók a leghasznosabbak:

length: Szám típus, az adott falszakasz hosszát tartalmazza• 
layer: Összetett objektum, a fal f?, vázszerkezetet is tartalmazó rétegét írja le.• 
upper_layers: A f? falszakasz rétegrendje, tömb típus. A 0. elem a legküls? réteg (tipikusan a vakolat küls? falak esetében). Ha a fal tartalmaz
parapet falat is (pony wall) akkor annak a rétegei a 'lower_layers' tömbben vannak.

• 

lower_layers: Ha a fal rendelkezik parapet fallal (pony wall), akkor annak a rétegrendjét tartalmazó tömb. A 0. elem itt is a legküls? réteg.• 

Ruby-ban objektum mez?ket a '.' operátorral lehet meghivatkozni. Tehát ha pl az 'owner' objektumnak az 'upper_layers' mez?jére vagyunk kíváncsiak,
akkor a 'owner.upper_layers' kifejezést kell beírni a Ruby konzolra, úgy hogy a falszakasz továbbra is ki van választva. A tömbök elemeire a [index]
operátorral lehet hivatkozni, tehát a legküls? réteg objektumát így kaphatjuk meg: 'owner.lower_layers[0]'.

Ha helyesen írjuk be a kifejezést a konzolra, és a meghivatkozott elem nem egy primitív típus (String, Integer, boolen), akkor a CA ki fogja írni nekünk
az objektum összes mez?jét, amikb?l így már tudunk válogatni, máshogy nagyon nehéz lenne rájönni, hogy milyen mez?k érhet?k el az adott elemnél:

Láthatjuk, hogy a 'owner.lower_layers[0]' objektum milyen további mez?ket tartalmaz. Pl. van neki 'material_data' mez?je, ami ha tovább boncolgatjuk,
láthatjuk, hogy van neki egy 'descerption' mez?je, ami már egy String típus, ebben van benne az adott fal réteg neve. Nézzük meg a példában szerepl?
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fal rétegrendjét a 'Wall type definiton' ablakban:

Láthatjuk, hogy a falunk 4 réteget tartalmaz. Ha arra vagyunk kíváncsiak, hogy hány négyzetméter homlokzati fóliára van szükségünk ehhez a
falszakaszhoz, akkor kívülr?l nézve a második rétegre van szükségünk, amit az '1'-es indexel vehetünk el? az 'upper_layers' tömbb?l, mivel 0-val indul
az indexelés. Írjuk be a Ruby konzolra: owner.upper_layers[1].material_data.description

Láthatjuk, hogy kintr?l nézve a második réteg valóban a homlokzati fóliát tartalmazza. Ha arra lennénk kíváncsiak, hogy mekkora ennek a felülete, akkor
azt kétféleképpen is megkaphatjuk:
Az adott réteg területe:

> owner.upper_layers[1].area
=> 3.40494 m² (Area)

Az adott rétegen használt anyag mennyisége.

> owner.upper_layers[1].material_data.quantity
=> 3.40494 m² (Area)

Az anyag mennyisége mindig az anyag tulajdonságoktól függ. Ha megnézzük a 'Housewrap' anyag tulajdonságait, akkor láthatjuk, hogy a mennyiséget
a terület alapján kell számolni, vagyis a komponens területét kell figyelembe venni, ezért egyezik meg fentebb a két szám:

Objektum összes attribútumának listázása

A másik módszer, hogy megtudjuk, hogy egy objektumnak milyen Ruby változói érhet?k el, ha egy beépített makró segítségével kiíratjuk az adott
objektum összes változóját egy szövegdobozba.

Hozzunk létre egy 'Leader Line'-t egy falszakaszra:

Ha megrajzoltuk a nyilat, meg fog nyílni a nyílhoz tartozó 'Rich Text Specification' dialógus.
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Ebbe el fogunk helyezni a 'object_properties' makrót, ami meg fogja jeleníteni az összes elérhet? Rubi változót. A makrók listáját a jobb fels? sarokban
lév? 'M' bet?re kattintva nyithatjuk meg:

A makrókat a szöveges mez?kben mindig két '%' jel közé kell rani, innen tudja a CA, hogy nem statikus szövegr?l van szó, hanem ki kell értékelni a
makrót. (Makrókkal a következ? alfejezetekben részletesebben is foglalkozunk).

Majd 'Ok'-al zárjuk be.

Ekkor a tervrajzon meg fog jelenni a kiválasztott objektum összes attribútuma, vagyis az összes elérhet? Ruby változó kibontva. Fala esetében ez egy
igencsak hosszú lista:
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A megjelen? "káoszban" nagyon nehéz megtalálni, hogy melyik elemet melyik szül? elem tartalmazza, de kiindulásnak jó lehet, hogy tudjuk, hogy a
Ruby konzolon merre induljunk, ha keresünk egy bizonyos attribútumot. Az alábbi képen láthatjuk a korábban már használt 'upper_layers' tömböt. A
tömböket elemeket ez a makró [index]-el jeleníti meg. Minden sor végén kiírja a makró az elem típusát. Ha itt 'NVPublisher' szerepel, akkor ez egy
összetett objektum, és az alatta lév? elemek tartoznak bele. Az alábbi képen láthatjuk, hogy a "upper_layers[0].material_data.quantity" képletet az
'object_properties' makró alapján is össze tudtuk volna rakni.

Komponens mennyiségek megadása (Component count)

Nyissuk meg újra a falszakasz specifikációs fülét, és a komponens fülön adjunk hozzá egy új komponenst a listához, és a 'Count' sor 'Formula'
mez?jébe írjuk be: =owner.upper_layers[1].material_data.quantity éréket, figyelve hogy '=' -el kezd?djön a sor. (Ha nem statikus szöveget akarunk
megadni egy 'Formula' mez?ben, hanem Ruby képletet, akkor mindig '=' kell kezdeni a sort)
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Láthatjuk, hogy itt is megjelent a fenti érték: 3.4 sq m.
{{note|Az 'owner' változó elhagyható a sor elejér?l, mert ezt alapértelmezetten hozzáteszi a CA}
Ugyan ezen falszakasz specifikációs komponensei között megtalálhatjuk a 'Housewrap' komponenst is. Ezt automatikusan hozta létre a CA a falhoz.
Ezeknek az automatikusan hozzáadott komponenseknek az az érdekessége, hogy a CA automatikusan hozzájuk rendeli a megfelel? Ruby változókat,
és el? is tölti a megfelel? Ruby kifejezésekkel a 'Formula' cellákat. Ezen komponensek esetében rövid alakkal tudunk hivatkozni a megfelel?
anyagtulajdonságokra, anélkül, hogy be kéne írni egy kilométer hosszú Ruby kifejezést.

Láthatjuk, hogy a 'Housewarp' -hez tartozó 'Formula' az alábbi: =material_data.quantity' Vagyis ezen példa esetében a =owner.upper_layers[1] rész
elhagyható.
Persze minden komponens típus esetében más és más Ruby változók érhet?k el, és beépített típusok esetében a CA mindig a megfelel? Ruby
változókkal tölti el? a 'Formula' mez?ket. Ha kézzel hozunk létre egy komponenst, akkor nincs rá mód, hogy összerendeljük azt valamelyik objektum
Ruby attribútummal vagy anyaggal az anyaggal. Ha számított értéket akarunk hozzá létrehozni, akkor mindig a teljes elérési utat ki kell írni, kezdve az
'owner' változótól.

A komponenshez tartozó mértékegységet szintén a 'Count' sorhoz tartozó 'Formula' mez?ben állíthatjuk be kétféle módon is. Ha kétszer belekattintunk
a Formula cellába, akkor megjelenik egy legördül? lista, amiben ki tudjuk választani a használni kívánt mértékegységet:

A másik lehet?ség, hogy a felugró, jobb oldali ikonra kattintunk: 'Number Formatting'.
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A felugró ablakban részlettesen is beállíthatjuk a használni kívánt mértékegységet.

Szobák alapterülete a komponens fülön

A szobák esetében, performancia okokból a CA a komponens fülön nem a valós anyagmennyiségeket jeleníti meg, hanem mindig egy 9 m2-es szobát
(100 sq f), vagy ahhoz nagyon közeli értéket vesz alapul, és arra jeleníti meg az értékeket a 'Formula' cellákban.
Az alábbi képen egy 18 m2-es szoba látható.

Nyissuk meg a specifikációs ablakát, és navigáljunk a komponens fülre.Válasszuk ki a vízszigetelést. Az ablak aljában egy kék figyelmeztetés jelenik
meg, miszerint nem a valós alapterület lesz figyelembe véve, hanem egy fiktív érték. Láthatjuk, hogy összesen 9 m2 padlóburkolat jelez ki a CA, holott
18 m2 kell a valóságban.
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Viszont ha megnyitjuk ennek a komponensnek az anyaglistáját, láthatjuk, hogy ott már a helyes érték szerepel:

Note
Ha az anyag listán is hibás érték szerepel a szoba mérethez képest, akkor általában a szoba alatti másik szint/alap/pince mérete hibás, ami a padlót
adja a szóban forgó szobának, és a mérete eltér a felette lév? szobától.

Ruby makrók használata

A makrók el?re legyártott Ruby függvények, amiket felhasználhatunk minden olyan helyen, ahol Ruby képletet is meg lehet adni. Az el?z? példákban
már láthattuk, hogy szöveget megjelenít? dobozokban hogyan lehet a % jelek között megadni a makrókat. Makrókat a komponens fülön is
használhatunk a 'Formula' cellák bármelyikében. Ehhez kattintsunk egy 'Formula' cellába, majd a megjelen? 'M' bet?re kattintva választhatunk az
elérhet? makrók listájából. Csak olyan makró fog m?ködni, ami olyan változókból van felépítve, amik elérhet?ek a kiválasztott objektumon. A makró
listában az összes elérhet? makró meg fog jelenni, nem csak az mi m?ködni fog az adott komponensen.
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Ha olyan makrót használnunk, ami olyan változóra hivatkozik, ami nem elérhet? a kiválasztott komponensen, akkor 'Evaluation Error' hibaüzenet fog
megjelenni a 'Value' oszolpban. Ha felé visszük az egeret, megjeleníti a konkrét hibát is.

Létrehozhatunk magunk is makrókat, amiket aztán ki tudunk választani a komponens fülön a 'Formula' cellákban. A makró szerkeszt?t a 'CAD' -> 'Text'
-> 'Text Macro Management' menüpontban találjuk. Itt tényleg a teljesség igénye nélkül mutatjuk be a makrószerkeszt?t, inkább csak arra szolgál ez a
fejezet, hogy ha valakinek egyedi makrókra lenne szüksége, majd emlékezzen merre induljon. A makró szerkeszt? ablakban a baloldali listában
láthatjuk a már létrehozott makrókat. A komponens fülön, a 'Formula' cellákban ha a 'User defined' lehet?séget választjuk, akkor ezeket a makrókat
listázza a CA. A makró nem más mint egy Ruby nyelven írt rövid program. Az alábbi ábrán láthatjuk a korábban már használt 'object_properties' makró
tartalmát, aki ért a Ruby-hoz az itt meg tudja nézni, hogy miért úgy jeleníti meg az objektum összes attribútumát ahogy.
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Ha új makrót akarunk készíteni, nyomjuk meg a 'New' gombot. Ekkor megnyílik a makró szerkeszt? ablak. Ha úgy nyitottuk meg a makró szerkeszt?t,
hogy a terven ki volt választva egy objektum, akkor a Ruby konzolhoz hasonlóan itt is ki tudjuk értékelni a makrónkat erre az objektumra. A példában
létrehoztuk a 'my_area' nev? makrót, ahol a makró értéke: 'owner.area'

Fontos, hogy ha a makrót a komponens fülön szeretnénk használni, akkor az 'Evaluate' mindig be kell legyen pipálva, és 'Context' értéke legyen 'Owner
Object'. Láthatjuk hogy a makrót ki is értékelte a CA a kiválasztott objektumra, aminek az értéke: 1.49 (m2)

Ha most megnyitjuk egy objektum specifikációs ablakában a komponens fület, akkor a 'User defined' makrók között már ott kell szerepeljen a 'my_area'
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nev? makró is:

Ha kiválasztjuk ezt a makrót, akkor a korábban már látott értéknek kell megjelennie:

Anyag tulajdonságok

Nagyon fontos, hogy minden a modellben használt anyag esetén helyesen legyen beállítva az anyagtulajdonság, mert aszerint lesz az anyag
beleszámolva az anyaglistába. Pl. ha a lábazati falunk tartalmaz egy zsaluk? réteget is (Blocks running bound)akkor ahhoz hogy a zsalukövek számát
helyesen tudja a CA kiszámolni, fontos, hogy a zsaluköveket olyan anyag szimbolizálja, amit darabszámban kell számolni, és olyan méret? elemekb?l
áll, ami megegyezik az általunk vásárolt zsaluk? mérettel. Erre már láthattunk példákat az #Materials_and_symbols cím? fejezetben, ezért itt csak
röviden átismételjük a lényeget.

Ha át szeretnénk konfigurálni egy beépített anyag típust, akkor els?ként másoljuk át a használni kívánt anyagot a 'User Catalog'-ba, ekkor már meg
tudjuk nyitni az anyag beállításait ('Open Object'). Az anyag tulajdonságait a 'Materials List' fülön tudjuk beállítani. Az alábbi példában láthatjuk hogy a
zsaluk? méretét beállítottam a helyben kapható méretre. Majd az alaphoz használt 'foundation wall' típusban beállítottam az új zsaluk? anyag típust a f?
rétegnek.
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Ezek után az anyaglistában, már helyes mennyiség fog megjelenni.

Anyaglista készítése a modellb?l
Generálás

Az anyaglistát nagyon egyszer? kigenerálni. Váltsunk 'plan view'-ban, majd a 'Tools -> Material list -> Calculate materials for all floors' menüpontban
tudjuk a teljes épületre legenerálni az anyaglistát.

Az almenüben található 3 további lehet?ség az anyaglista generálásához, de ez a 4 lehet?ség csak abban különbözik egymástól, hogy milyen módon
találjuk meg azon szobákat, szinteket, falakat, egyéb objektumokat, amiket az anyaglistában szerepeltetni szeretnénk. A "Calculate materials for all
floors" a teljes modellre generálja az anyaglistát, míg a többi három valamilyen módon sz?kíti azt.

Az anyaglisták mindig egy külön fülön nyílnak meg, ahányszor generálunk egy listát, mindig egy új fülön fog megnyílni. Meglév? listák már nem
frissíthet?ek, ha a model változik, új listát kell generálni. A listákat el tudjuk menteni. Ha egy anyaglista fül az aktív, akkor megváltozik a kezel? menü,
ilyenkor csak az anyaglista kezeléséhez szükséges ikonokat láthatjuk:
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'Edit active view': itt állíthatjuk be, hogy az éppen aktív anyaglistában milyen kategóriájú anyagokat láthassunk. A CA-ban 19 beépített
kategória található, minden a modellben ezek valamelyikébe van besorolva. (lásd lentebb)

1. 

A bal fels? sarokban található egy legördül? lista, amiben ki tudjuk választani, hogy a Framing és Subfloor szerkezetéhez szükséges
faanyagot milyen módon szerepeltesse a listában (lásd lentebb)

2. 

Itt tudjuk elmenteni a generált anyaglistát, ami a "Project browser -> Material list" alá fog bekerülni.3. 
'Material list management': Megnyit egy ablakot, ahol a már elmenett anyaglistákat nyithatjuk meg. Szerintem ez egyenérték? a Project
browser által nyújtott lehet?ségekkel.

4. 

Master list kezel? ???5. 
Az anyaglista szerkeszthet? táblázata6. 

Lista áttekintése

Az anyaglistában (f?)kategóriánként vannak csoportosítva az elemek (pl. Framing vagy Doors). Minden kategóriának van egy bet?jele, pl a Framing-nek
"F", míg a Doors-nak "D". Majd minden egyes sor a táblázatban egy kategórián belül megkapja a kategória prefixjét és egy futó sorszámot.

Egy külön oszlopban láthatjuk, hogy az adott sorban található anyag melyik szinten van. A CA szintenként szétválasztja az ugyanabba a kategóriába és
típusba tartozó anyagokat.

A CA nem csak szintenként, de felhasználási al-kategóriánként is szét fogja válogatni az anyagokat. Az anyaglistában külön sorban fognak megjelenni
azok az azonos anyagokat tartalmazó sorok, amik más alkategóriában vannak felhasználva. Az alábbi példában láthatjuk, hogy pl. a 50x150-es palló
több sorban is szerepel különböz? alkategóriákban, pl header és plate és így tovább.
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Arra tudtommal nincs lehet?ség, hogy ezeket a sorokat összevonva mutassa.

Ha egy al-kategóriába több elem is tartozik (a faváz elemei tipikusan ilyenek, hiszen ott rengeteg ugyanakkor stud található meg egy szinten belül) akkor
azok egy összevont sorban fognak megjelenni az anyag listában

Az ilyen összevont sorok el?tt egy kis nyíl található meg, amit lenyitva megnézhetjük az adott al-típus összes el?fordulását. Láthatjuk a fenti példában,
hogy az F4 (Framing) sorban az 50x 150 -es header szerepel. A 3. oszlopban szerepl? 1-es mutatja meg, hogy itt az 1. szintr?l van szó. Ha lenyitjuk,
láthatjuk az 1. szinten 50x150-es méretben 3 darab header-re van szükség: 1000, 1100 és 700mm-es hosszban.

Anyagok megkeresése a modellben

Minden egyes listaelemet meg tudunk keresni a modellben. Ehhez jelöljük ki a táblázat egy sorát, majd jobb klikkel felugró menüben kattintsunk a 'Find
object in plan' menüpontra. Ekkor át fogunk ugrani plan view-ba abba a nézetbe, ahol az adott objektum látható, és ki lesz jelölve a képerny?n.

Pl. ha egy framing elemet keresünk meg az anyaglistában, akkor a fal CAD részlet rajza fog megnyílni, ahol az adott framing elem ki lesz jelölve:
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Automatikusan hozzáadott anyagok

Több olyan anyagot is megtalálhatunk az anyaglistán, amit nem közvetlenül modelleztünk le, a CA adja hozzá automatikusan ha bizonyos anyag
megtalálhatók a modellben. Ilyen a beton-acél vagy a termesz háló, amit a beton alap automatikusan hoz magával. Ezek mindegyik szerepel a
'foundation wall' komponens listájában, ezért szerepelnek ezek az anyaglistában. (Részleteket lásd itt: #Anyagok és komponensek

Beton alap esetén automatikusan hozzáadott anyagok:

termesz háló• 
rögzít? csavarok• 
beton-acél• 
vasbeton-háló• 

Megjelenítend? kategóriák kiválasztása
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Egyszer?en tudjuk szabályozni, hogy mi jelenjen meg az anyaglistában. Ehhez az anyaglista feletti 'Edit active view' ( ) ikonra kell kattintani.

A megnyíló 'Material List Specification' ablakban, a 'Categories' fülön állíthatjuk be, hogy mely f?-kategóriák kerüljenek bele a listába. Ha minket csak a
framing érdekel, akkor az összes többit kapcsoljuk ki.

Foundation materials

A Default/Foundation dialógusban Options fülén be tudjuk állítani, hogy milyen vasalat kerüljünk az alapba és hogy definiáljon hozzá termesz hálót
illetve szigetel? habszivacsot a buttom plate alá. Az itt megadott anyagok kizárólag az anyaglistában jelennek meg, a 2D vagy 3D modellben nem.

Itt beállíthatjuk külön hogy a sávalapba, illetve a lábazati falba mennyi, és milyen átmér?j? vasalat kerüljön. Ezen felül, hogy a slab hálóval vagy
betonacéllal készüljön.

Bar per course: egy egységnyi alapba/falba hány szál betonvas kell. Pl sávalap esetén ha két szálat szeretnénk végigfuttatni, akkor ide 2-?t
kell írni.

• 

Course spacing: Az el?bb meghatározott szálak milyen osztásközzel kerüljenek beépítésre. Footing esetében ez nem értelmezhet?, míg
vertikális ill. horizontális vasalat esetében az egysgényi falfelületre jutó betonacél szálak milyen messze legyenek egymástól.

• 

Rebar size: Az itt megadott számmal fogja kiszámolni hogy hány nyolcad inch vastag betonacélt akarunk használni. Ha ide 4-et írunk, az 4/8",
ami ~ 1.27 cm, ez van a legközelebb a 14mm-hez.

• 

...

Materiallist egy falra
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Jelöljünk ki egy falat, majd jobb klikkel, a felugró menüb?l válasszuk a "Calculate Material List from Selection" lehet?ség:
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Ekkor az anyaglista csak annak az egy falnak az anyagszükségletét fogja tartalmazni.

H?szigetel? anyagok az anyaglistában

A CA automatikusan fog szigetel? anyagot generálni minden olyan falhoz és plafonhoz az anyaglistában, ami kondicionált helyiséget vesz körbe. Ezt a
szobák beállításaiban, a General fülön állíthatjuk be.

Ha a 'Condition' be van pipálva, akkor a szobát körbevev? falakhoz és plafonhoz fog a CA automatikusan szigetel? anyagokat generálni a ML-ben, ha a
falak ill. a plafon üreges szerkezetb?l készül.

Fontos, hogy a fal definícióban szerepl? 'Insulation' oszlopnak ehhez semmi köze, az csak azt szabályozza, hogy metszeti nézetben az 'Auto Decorate'
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funkció ( ) milyen módon dekorálja ki az adott felületet. Szigetelés esetén hullámokkal fogja kitölteni.

A wall cavity-be rakott h?szigetelés méretet állítólag nem lehet megváltoztatni, a vastagsága mindig a stud vastagsága lesz, míg a szélessége mindig a
stud kiosztás lesz, vagyis 500-as stud kiosztásnál 500 lesz, amib?l nem fogja levonni a stud szélességét, hiszen az üreg csak 450mm széles valójában
50 mm vastag stud használata esetén. A magasságát valamilyen szabványos, hardkódólt méretb?l veszi, amit nem lehet megváltoztatni, az mindig
2325 mm. A fal és plafon üreg szigetelés mindig az "Insulation" f?kategóriában van:

Azokban a helyiségekben, amik kondicionáltnak vannak megjelölve, és tet? vagy erély van felettük, a CA fog plafon szigetelést is generálni, illetve
azokban a helyiségekben, ahol nem kondicionált terület van egy szoba alatt, födém szigetelést is generálni fog. Ezen szigetelés méretét sem lehet
megváltoztatni.

Structural member reporting
Áttekintés

Ha a házunk favázas/fémvázas részeket is tartalmaz (falak, tet?, födém, tartó oszlopok, gerendák..) akkor a CA képes kiszámolni, hogy a piacon
elérhet? hosszúságú gerendákból és pallókból összesen mennyit kell vegyünk, és milyen hosszúságban, hogy optimálisan adják ki a szükséges
anyagmennyiséget. Hogy ezt ki tudja számolni a CA egyrészt be kell neki állítani, hogy milyen anyag hosszak érhet?k el a használni kívánt átmér?kb?l
(pl. 5x15 -ös pallók piacon fellelhet? hossza 4, 5, 6 és 7 méter) másrészt hogy ezek közül melyik hosszat preferáljuk jobban, ha több hosszból is kiadná
egy fal anyagszükségletét. Szerintem a végeredményt fenntartásokkal kell kezelni, kiindulásnak viszont jó lehet.
Láthattuk, hogy ha egy anyaglista fül aktív, akkor a bal fels? sarokban van egy legördül? lista:

Itt szabályozhatjuk, hogy az el?bb említett fa/fém strukturális elemeket milyen módon mutassa a CA az anyaglistában. Ez a legördül? lista kizárólag
azokra a kategóriákra lesz hatással, ahol vannak strukturális fa/fém elemek. Ilyenek tipikusan a 'Framing', 'Roofing' és 'Subflooring' kategóriák, amik
mind tartalmazhatnak gerendákat és pallókat. A legördül? lista váltása semmi másra nem lesz hatással az anyaglistában. A legördül? listában 4
lehet?ségünk van:
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Linear length: A modellben használt strukturális elemeknek típusonként fogja a teljes hosszát mutatni:

Láthatjuk a fenti példában, hogy az 1. szinthez szükséges 50x150 átmér?j? stud-okból, összesen 119 méterre van szükség. Tehát továbbra is
szintenként, és al-típusonként (pl stud, header) lesznek csoportosítva az elemek, de ott ahol értelmezett (strukturális elemek) a szükséges teljes hossz
lesz megjelenítve, ami a 9. oszlopban lesz megjelenítve méterben.

Cut list: Ha a 'Cut list'-et választjuk a legördül? listából, akkor a strukturális elemeknek nem a teljes hossza lesz megjelenítve, hanem a pontos mérete,
és hogy egy adott méretb?l hány darabra van szükség. A 9. oszlopban ilyenkor nem hossz, hanem darabszám lesz megjelenítve.

A fenti példában láthatjuk, hogy az 50x150-es stud-ból 2450 hosszban összesen 39 darab kell az els? szinten. A a kis nyíllal lenyitnánk, akkor mint a 39
el?fordulás fel lenne sorolva.

Buy list: A költségszámításhoz ez a legfontosabb nézet. Itt azt fogja a CA, hogy a piacon fellelhet? gerenda/palló hosszakból hány darabra van
szükség egy adott keresztmetszetb?l ahhoz hogy optimális legyen az anyag kihasználtság.

Láthatjuk, hogy a fenti példa esetében 25 darab 5 méter hosszú 50x150 átmér?j? pallót kell venni, ahhoz, hogy optimálisan kiadja az 1. szinten
szükséges stud anyagszükségletet (stud, king-stud, trimmer, cripple, blocking...stb). Ha lenyitjuk az F8 sort, láthatjuk, hogy mely elemeket akarja a 25
darab 5 méteres pallóból kivágni. Ezek mindegyik megkereshet? a modellben.

Note
Sajnos azt már nem mutatja meg a CA, hogy melyik elemeket akarja ugyanabból a pallóból kivágni. Így ezt már nekünk kell kisakkozni a falak gyártás
aközben. Ezen felül azt hogy milyen hosszúságú pallót választ, többé kevésbé statikus beállítás, nem a valódi optimum szerint fogja kiválasztani a
megfelel? hosszat az elérhet? hosszakból (lásd lentebb). Ennek ellenére azt mondják, hogy a framing "buy list" nagyon pontos, és hogy inkább
kevesebb mint több a valódi anyagszükséglet.

Mixed reporting: Itt keverve lesz a 'Cut list' és a 'Linear length'. Az azonos alkategóriába tartozó framing elemek ugyan úgy össze lesznek vonva
szintenként, és meg lesz adva a teljes szükséges hossz, ahogy a 'Linear length' listában láthattuk, de ha lenyitjuk a csoportosított sorokat, akkor meg
fog jelenni a részletes 'Cut list' felsorolás is.

A fenti példában láthatjuk, hogy az els? szinten az 50x150 mm-es header-b?l 2.8 méterre van szükség, de ha az F4-es sort lenyitjuk, láthatjuk hogy
összesen három fajta elemre van szükség ebb?l az altípusból, keretmetszetb?l az els? szinten.

Elérhet? gerenda/palló méretek beállítása

Ahhoz hogy a CA tudja, hogy milyen gerenda és palló hosszúságokból válogathat egy adott keresztmetszet esetében, a piacon elérhet? méreteket el?re
be kell neki állítani. Ehhez legyen aktív egy plan view, majd a Tools -> Material list -> Structural Member Riporting menüponttal nyithatjuk meg azt a
dialógust, ahol beállíthatjuk a piacon elérhet? méreteket.
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Material List Report Method

Az ablak tetején, a 'Material List Report Method' listában választhatjuk ki, hogy mi legyen az alapértelmezett lista típus, ha új anyaglistát generálunk.
Bármi is van itt kiválasztva, ett?l még az aktív anyaglistában bármikor átválthatunk másik nézetre a bal fels? sarokban lév? legördül? listában. A
gerenda/palló méret táblázatot csak akkor tudjuk szerkeszteni, ha a 'Buy list' van kiválasztva. Ha nem a Buy list van kiválasztva, akkor nem
szerkeszthet? a méret lista, ami nem igazán logikus, hiszen az anyaglista felületen bármikor átválthatunk másik lista nézetbe, és akkor az fog
érvényesülni, amit itt a méret listában beállítunk, még akkor is, ha nem a 'Buy list' az alapértelmezett.

Consolidate Unhandled Boards

A neve kicsit félrevezet?, itt állíthatjuk be, hogy hogyan kalkulálja ki a szükséges anyagmennyiséget azoknál a strukturális elemeknél, amik rövidebbek
mint a méret táblázatban megadott hosszak. Ha itt bepipáljuk a három lehet?séget, akkor úgy fogja kombinálni a rövidebb elemeket, hogy optimálisan
adják ki az elérhet? hosszúságokat. Mivel majdnem minden strukturális elem (stud, joist, header, rafter, stb) mérete tuti hogy nem lesz pont akkora mint
a piacon kapható anyag hosszak, szükség lesz arra hogy azoknál az elemeknél, amik nem adják ki a teljes méretet kombinálja az elemeket. Tehát ezt a
három checkbox-ot pipáljuk be.

Buy list board sizes

Ez a lényeg. Itt kell rögzíteni az elérhet? hosszúságokat minden strukturális elem minden a modellben használt keresztmetszetére. Ha itt nem sorolunk
fel egy adott keresztmetszetet (pl. 50x100), de a modellben szerepel, akkor az anyag listában nem fog tudni hozzá mit írni a 'Buy list' nézetben. A
listában minden keresztmetszet minden lehetséges hosszát soroljuk fel "jósági" sorrendben, külön az 'treated' és nem 'treated' változatokat:
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Láthatjuk, hogy az alábbi képen az 50x150-esb?l három méret is meg van adva: 4000, 5000, 6000 mm.

Mikor új anyagot adunk hozzá, akkor az átmér?n és a hosszon kívül meg kell adni a strukturális elem típusát:

Itt a szokásos 12 framing elemtípus közül választhatunk. Ezt is figyelembe fogja venni a CA a megfelel? hossz kiválasztásánál.

Warning
Fontos, hogy precedencia szerint sorba rendezzük az azonos átmér?j?, különböz? hosszú elemeket. Ugyanis az algoritmus úgy m?ködik, hogy minden
a modellben fellelhet? strukturális elem esetében fentr?l lefelé elindul a CA a listán, és az els? olyan hossznál megáll, amibe már belefér az adott elem.
Ha az elem kisebb mint a tejes hossz, és a 'Consolidate Unhandled Boards' dobozok be vannak pipálva, akkor a fennmaradó hosszra keres egy újabb
elemet, és ha még mindig marad fel nem használt hossz, akkor keres tovább. Ha egy szál már "betelt" akkor fogja a következ? elemet és ahhoz is
megkeresi az els? illeszked? hosszt.

Pl: Az alábbi elemekhez keressük a megfelel? szál számot:

50x150x2400 - 2db• 

A méret listában pedig az alábbi bejegyzések találhatók ehhez a keresztmetszethez az alábbi sorrendben:

50x150x4000• 
50x150x5000• 

Ekkor a fenti algoritmus alapján az els? '50x150x2400' stud-hoz fog illeszked? elemet keresni. A listában ebb?l a keresztmetszetb?l a legels? a
'50x150x4000' szál. Ezt ki is fogja választani, a fennmaradó szál hossz 1600 mm. Ezután veszi a következ? '50x150x2400' stud-ot, és megpróbálja
illeszteni a maradék helyre, de az 1600 mm-be már nem fér bele. Ezért megkeresi ehhez is a listában a legels? illeszkedést, ami szintén a
'50x150x4000' lesz. A végeredmény: 2 szál '50x150x4000'.

Ha viszont a listában felcserélnénk a 4000-es és 5000mm-es szálakat, akkor az algoritmus a következ? képen futna le: Az els? elemhez (50x150x2400)
meg fogja keresni a CA az els? illeszked? hosszt, ami ezúttal az 5 méteres szál lesz, mert az van most el?bb a listában. A fennmaradó szál hossz 2600
mm. Veszi a következ? stud-ot, ami most már belefér a maradékba, és még így is marad 200mm. A végeredmény: 1 szál '50x150x5000'.

Láthatjuk hogy a precedencia nagyon nem mindegy. Ha sok olyan elemünk van, ami kombinálva kiad egy hosszabb szálat, akkor azt a hosszúságot
mindenképpen tegyük el?bbre a listába, mert a CA sajnos ezt egyedül nem tudja kitalálni.
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Kerf Width

Mikor a CA kombinálja a különböz? hosszúságú darabokat egy szálban, akkor az itt megadott vágási vastagságot hozzá fogja adni minden elemhez,
amit egy szálba szán.

Default beállítások

A 'Structural member reporting' dialógusnak is vannak alapértelmezett beállításai. Ehhez válasszuk a 'Default settings' dialógus 'Structural member
reporting' sorát. A megnyíló ablakban hozhatunk létre új, alapértelmezett 'Structural member reporting' beállításokat. Ennek az lehet az értelme, hogy
tudjunk anyaglistát generálni különböz? fatelepekre, vagy országrészekre, ahol más hosszúság érhet? el az adott keresztmetszetekb?l. Így nem kell
mindig frissíteni a 'Structural member reporting' listát, elég átváltani egy másik default-ra.

Strukturális elemek árának beállítása

Sajnos a CA X12-ben még nincs rá lehet?ség (vagy én nem tudok róla), hogy az egyes palló/gerenda hosszaknak az árát beállítsuk a 'Structural
member reporting' dialógusban, amit így automatikusan tudna használni a CA az anyaglistában. Helyette minden egyes generált anyaglistában nekünk
kell manuálisan beírni az egyes eleme árát, ahogy az a lenti ábrán is látható.

Note
Chief Architect X13 -tól kezdve a 'Structural member reporting' dialógusban az egyes elemek ára is beállítható, amik automatikusan bekerülnek majd az
anyaglistába

Életh? kimenetek/Renderelési technikák
Fény/Nap beállítások
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Adjust Sunlightd:

Egy kamera nézetre vonatkozik• 
A nap tulajdonságait állíthatjuk be• 
Fontos, hogy legyen sun angle nyíl a tervrajzon elhelyezve• 

Sun Angle állítása:

Sun Angle specification:
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North Pointer:

Adjust Lights:

Mindig egy adott kamera nézetre vonatkozik• 
A terven szerepl? összes lámpa fényét állíthatjuk• 
A Layer Set-ek mintájára itt vannak Light Set-ek.• 

Rendelerelési technikák
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Bevezet?

Kis házikó ikon a fenti f? eszköztárban:

2D tervez?i nézetben nem elérhet?. A 2D-s metszeti és homlokzati nézetekben csak korlátozott funkcionalitással.

Physically Based

https://www.chiefarchitect.com/videos/watch/2426/physically-based-rendering-technique.html

Nem valós idej? sugárkövetés (Ray Trace)
Ray Trace Current view:

Ray Trace Assisant
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Walkthrough

Hogyan készült? (Tippek és trükkök)
Deck a küls? szigetelés el?tt
Ha olyan deck-et szeretnénk csinálni, ami nem a fal sheetingen lóg, hanem már a vakolat el?tt pár centivel véget ér, akkor egy kicsit trükközni kell:

1. A deck-et alkotó 'Room divider'-eket húzzuk kijebb a faltól, hogy legyen egy hézag a vakolat és a deck széle között:

2. Mivel most a ház fala és a láthatatlan 'Room divider' fal, ami a deck-et határolja körül nagyon közel kerültek egymáshoz, a CA úgy veszi, hogy dupla
fallal van dolga, és Plan view-ban az ablak és az ajót bele fog lógni a 'Room divider'-be. Ennek hatására a küls? burkolat meg fog szakadni az ablakok
körül, és ki fog lógni a szigetelés:
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3. Megoldás: Els? lépésben minden olyan ajtón és ablakon ami 'dupla fal' mellett van, vagyis ami a deck mellett van be kell állítani a Specification dialog
Casing fülén, hogy dupla fal esetén ne menen át a második falon:

Ennek a a hatására a plan view-ba már jól fognak az ajtók és ablakok megjelenni:

Viszont 3-ds view-ban még mindig ki fog lógni a szigetelés. Ez akkor jelentkezik, ha 36mm-nél közelebb van a deck széle a szigeteléshez. Ha 36mm-re
húzzuk, akkor rendbe jön 3D-s nézetben is az ablak széle. Most már a framing-en nézetben láthatjuk, hogy a deck nem éri el a szigetelést:

4. Tet? megjavítása: Mivel a második deck fölött még van egy kis tet?, fontos, hogy a szabadon álló deck-ben be legyen állítva, hogy nincs fölötte tet?,
különben tönkre teszi a kis ferde tet?t az erkély szélénél:

Láthatjuk, hogy elt?nt a dobozolt eresz. Hogy ezt helyre hozzuk, ki kell kapcsolni a küls? deck feletti tet?t a Specification -> Structure fülön:

Erkélyt tartó gerenda és oszlopok
Az alábbi ábrán az erkély fele a leveg?ben van, alatta terasz van:
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Ahhoz hogy megtartsuk a hosszanti irányban végigfutó I-joist-okat az erkély végére keresztbe tenni kellett egy 'beam'-et. (1-es). Ezt a beam végén alá
kellett támasztani három oszloppal (2-es). Az erkély szélét le kellett zárni egy rim-board-al mind két oldalon (3-as és 4-es).

Beam megrajzolása

A plan view-ban válasszuk ki a 'Framing, floor plane view'-t:  Majd menjünk 'Floor/Ceiling framing tool'-ba ( )

és válasszuk ki a 'Floor/Ceiling beam' eszköt: 
Kezdjük el megjrazolni a gerendát a faltól indulva az erkély széle felé:

Majd nyissuk meg a beállításait (Framing specification, floor beam), és itt állítsuk be a magasságát, szélességét és az anyagát:
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Majd a megfelel? Cross section view-k segítségével mozgassuk a helyére, ami nem lesz egyszer?. Készítsünk egy cross section-t, majd állítsuk be,
hogy a '3D framing layer set'-et használja. Ekkor láthatjuk, hogy hova kell mozgatni a gerendát, hogy pont a falra üljön rá:

Oszlopok megrajzolása

Ha a helyén van a beam, akkor alá kell tegyük a képen látható 3 oszlopot. Ehhez válasszuk a 'General framing tool' csoportot ( ), majd ott a 'Post
with footing' eszköt:

Rajzoljuk meg a post-ot a beam végére, majd nyissuk emg a beállításait (Framing specification - post)
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Maj itt a 'Size and orientation' szekcióban állítsuk be a post méret. Majd mozgassuk a megfelel? cross section view-k segítségével a helyre.

Ha ez megvan másoljuk le 3 példányban. Ehhez jelöljük ki, majd az alsó menüben válasszuk a 'Multiple copy' ( ) eszközt, és 'Joist/Post/beam'
szekcióban állítsuk be a kívánt távolságot:

Majd OK. Ha megvan, vigyük az egeret a beam fölé, ekkor meg fog jelenni három kis doboz és egy nyíl:

Kattintsunk, és lenyomva tartva az egér gombját húzzuk a másolni kívánt irányba az egeret.

Rim board

Az egér két szélén lév? rim board-ot manuálisan rajzoltam meg.
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...TODO... nem tudom hogy én hoztam e létre, minden esetre a Rim -joist rétegen van, tehát tujda hogy ez micsoda, és a típusa LVL. Lehet hogy annyi
elég hozzá?

OSB-zet erkély

Ha van egy erkélyünk parapet fallal, akkor a parapet fal által körbezárt terület egy helyiséget alkot, aminek lehet padlója. Vagyis az erkély esetében
egyszer?, hogy megfelel? padló rétegrendet alakítsunk ki. De ha az egész erkélyt le szeretnénk burkolni OSB-vel, akkor a parapet falon kívüli részb?l is
helyiséget kell csinálni, vagyis valamiféle fallal körül kell venni. Jelen esetben az erkély küls? falát körbeveszi egy 'Attic wall', ami szintén helyiség
határoló elem, így összesen két helyiségünk van, van az erkély, amit a korláttal ellátott 'Pony wall' vesz körül, és van egy másik ami a pony wall és a
küls? 'attic wall' közötti L alakú helyíség:
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Erkély bels? burkolata

Az erkélynek be van állítva (Room specification), hogy van neki egy 242 mm vastag 'Fool structure'-je és egy 307 vastag 'Floor finish' felülete. Ezen felül
be van pipálva, hogy 'Floor under this room' és ki van szedve a pipa a 'Roof over this room' pipálóból. Így nem fog tet? kerülni az erkély felé:

A 'Floor sturcture'-ben be van állítva, hogy a padlózatot 220 mm magas I-joist alkotja, amin 22 mm vastag OSB van:
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A 'Floor finish'-ben meg be van állítva, hogy 4 rétegb?l van, alul h? szigetelés, efölött víz szigetelés, thinset mortar, majd efölött csempe.

Tet? alatti burkolat

A küls? L alakú helyiségre csak egy OSB padlót szeretnénk rakni. Ezért a 'Room specification' dialógusban be van pipálva a 'General' fülön, hogy 'Floor
under this room', viszont 'Roof under this room' is be van pipálva. Ezért automatikusan tet? kerül fölé ha tet?t generálunk:
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A 'Floor sturcture'-ben ugyan az a 220mm magas I-joist található a 22mm-es borítással, ami az erkély padló esetében, azonban a 'Floor finish'-ben
semmilyen réteg nincs.
A CA által generált joist kiosztást kitörölhetjük, és manuálisan létrehozhatunk I-joist-okat, attól még a padlón az OSB jó helyre fog kerülni.

{{note|Ahhoz hogy az OSB borítás is megjelenjen a 'Framing overview'-ban, be kell kapcsoljuk a 'Floor surface' réteg megjelenítését:

Tet? síkját követ? korlát
Vannak dolgok amire nem képes beépített funkcióval a CA. Ilyenkor nekünk kell improvizálni vagy kézzel lemodellezni az adott formát. Pl az alábbi
képen látható sarok korlát elem a ferde fallal, de felette az egyenes korláttal nem megoldható a beépített eszközökkel. Bold text

A képen látható erkély korlátok a ferde falat leszámítva két komponens? falból épülnek fel, vagyis a Specification dialog-ban a General fülön be ban
pipálva hogy ez a fal els?dlegesen railing, és be van pipálva Wall type fülön a pony wall:
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Három típusú fal nincs a CA-ban, a falak maximum két típusból állnak el? és az osztás mindig horizontális, de meg lehet mondani, hogy milyen
magasan legyen. A korlátos fal is pont ilyen, az alja fal típus, a teteje korlát (a korlát is fal).

Viszont a két komponensb?l felépül? falak teteje nem lehet ferde, azt csak homogén falakkal tudjuk megcsinálni. A képen látható kis ferde falat úgy
csináltam, hogy rajzoltam oda egy homogén falat, majd Cross section view-ban kijelöltem. Ekkor a négy sarkában megjelenik négy pici gyémánt azokkal
lehet a ferdeséget beállítani:

Fogjuk meg valamelyik gyémántot és húzzuk lefelé.

A fal tetején lév? fehér párkányt többféle képen is csinálhatjuk. Vagy egy 3D-s boxot forgatunk oda, vagy beállítjuk a Specification dialog-ban a Wall cap
fülön, hogy legyen wall cap. Wall cap-nek válasszunk egy egyszer?, téglatest formát:

A korlát darabjait pedig egyenként meg kell rajzolni 3D dobozokból.  ->  3D dobozt csak plan view-ban vagy 3D-es orthognal view-ban
lehet rajzolni, section -ökben nem. Majd méretezéssel section view-kban mozgassuk a helyére az elemeket.

Ha már minden a helyén van, akkor a 'Material eyedropper'_el ( ) másoljuk le a korlát anyagát és tegyük rá az új 3D-s dobozokra

És íme a végeredmény:
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Még a framin-et kell rendbe rakni. Legyen kiszedve a pipa a fal Specification dialog/Structure fülén a Retain wall framing-b?l, hogy ha újra generáljuk a
framin-get, akkor ezt a falat is legenerálja.

A framin generálás mindig az összes olyan falra le fog futni, aminek a szerkezetében van framing layer és amiben nincs kikapcsolva az újra generálás a

'retain wall framing' kapcsolóval. Nyissuk meg a Build framing dialógust:  Majd menjünk a Wall fülre, és itt pipáljuk be, hogy Build
wall framing:

Ekkor a teljes framin-et újra fogja gyártani, és minden korábbi változtatás el fog veszni, ha csak nem pipáljuk be, hogy Retain wall framing az adott
falra.

Ha most megnyitjuk a kis ferde fal framing Wall detail a fal kijelölése után a az Open Wall details gombbal ( ) akkor láthatjuk hogy dupla top plate-t
kapott, holott az erkély másik három pony fala csak egyet:

Töröljük ki az alsó top-plate-et majd növeljük meg a stud-okat. Íme a végeredmény:

Tet? egyedi truss kiosztása
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Pince lejáró

A pince lejárat titka az úgynevezett "Retaining wall" vagyis támfal. A pince lejárót ezzel a fallal kell körbevenni. A támfalat a "Terrain Configuration"
eszközkészletben találjuk a "Terran Wall and Curb Tools"-on belül:

Rajzoljuk meg "L" alakban a támfalakat (retaining walls):

Metszeti nézetben állítsuk be a falak mélységét. Fontos, hogy mélyebbre menjenek a föld alá mint a tervezett lejáró alsó szintje:
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Láthatjuk hogy a fal alja túllóg lefelé a sávalap tetején.

Rajzoljunk egy "Elevation Region"-t ( ) a falak bels? oldalára, úgy hogy enyhén rálógjanak a falkra:

Ha nem lóg rá eléggé a támfalra az "Elevation region", akkor a gödör alja nem lesz egyenes, ha meg túlságosan rálóg, akkor meg a fal túloldalán
keletkeznek dombok:

Majd helyezzünk egy "Slab" ( ) objektumot a lejáró aljára, mert a lépcs?t csak "slab" elemr?l indíthatjuk. Ehhez le kell menni az alaksorba,

vagyis a 0. szintre ( ) és ott kell a "Slab"-et megrajzolni
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A "Slab" pince padlószintt?l számított magasságát a "Slab specification" dialógusban állíthatjuk be:

Ezután a "Draw Stairs" ( ) eszközzel lentr?l felfelel rajzoljuk meg a lépcs?t. Fontos, hogy a lépcs?t is a 0. szinten rajzoljuk meg. A
csempézett betonlécs? eléréséhez az alábbi változtatásokra van még szükség:
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Ha a lépcs? nem a pince padlószintjér?l indul, akkor nem a 0. szinten rajzoltuk meg.

K?kerítés kertkapuval
Itt van a teljes leírás lépésr?l lépésre: https://www.chiefarchitect.com/support/article/KB-00874/placing-a-gate-in-a-terrain-wall.html

És itt a végeredmény:

Kerítés lábazattal,vízszintes deszkázattal

A cél itt az volt, hogy el?állítsunk egy olyan kerítést, ami tipikusan az utcafrontra kerül. K? lábazat, k? oszlopok és vízszintesen futó deszkázat beleértve
az utca fronti kaput is.

Terrain wall mint lábazat

A lábazatot egy "terrain wall"-al ( ) kell kialakítani. Fontos, hogy a terrain wall csak a 'terrain perimeter'-en belül rajzolható meg, és meg
kell szakítsuk a kocsibeállítónál, mert ha az 'elevation region'-el van kialakítva, és a 'terrain wall' követi a domborzatot, akkor meg fog ugrani a beállóhoz
érve. Ezért két darabból kell kialakítani a beálló jobb és bal oldalán, úgy, hogy a mer?leges kerítéshez sem érhet hozzá.

A terrain wall követi a domborzatot, erre tudjuk majd kés?bb ráültetni a kerítést. Állítsuk a vastagságát 156mm-re és a magasságát pedig 300mm-re:
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Az anyagnak válasszunk ki egy vakolat típust, pl 'Sand finish Cream' anyagot.

Ekkor a terrain falunk így fog kinézni:

Kerítés nyomvonala

A 'Straight fencing' eszközzel tudunk a fel tetejére kerítést rakni.

Keressük meg a fal középvonalát felülnézetben és jelöljük ki a kerítés helyét. Itt nagyon kell rá figyelni, valamivel a fal két vége el?tt véget érjen a
kerítés, mert ha eléri a fal végét, akkor 45°-ban bele fog fúródni a kerítés vége a földbe. Ha akár 1mm-el a fal vége el?tt megáll, akkor a fal tetején fog
állni a teljes hosszában:

Nyissuk meg a kerítés beállításait, és menjünk a "Wall Types" szekcióba. Itt definiáljunk egy olyan falat, ami CMU-ból épül fel és a teljes vastagsága
megegyezik a korábban készített "Terrain wall" vastagságával (156mm)
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A "Pony wall" szekciót hagyjuk üresen. A "Ray style" fülön állítsuk be a "Specify Railing" szekciót "Panel"-re és a "Build From" szekciót állítsuk "Step
Terrain"-re.

Ezzel azt érjük el, hogy a kerítés lépcs?zése mentén a lépcs?ket fel fogja tölteni az imént definiált lábazati fallal, aminek a szélessége megegyezik a
"Terrain wall"-al, ezért egybe fognak olvadni. Most itt tartunk:

Vízszintes deszkázatú panelek

Alapértelmezetten nem található a CA-ban vízszintes deszkázat, ezért ezt nekünk kell legyártani. Ehhez létre fogunk hozni egy "Millwork" típusú egyedi
szimbólumot. 'Polyline Solid'-ból rajzoljuk meg egy vízszintes deszkát. Legyen a vastagsága 25mm, a magassága pedig 140mm. A 'Multiple Copy'
eszközzel sokszorozzuk.

Jelöljük ki az összes vízszintes deszkát, és az alsó menüben válasszuk a 'Convert Selected to Symbol' lehet?séget ( ) A megjelen? ablakban
nevezzük el az új szimbólumot (pl Fence, Horizontal panel), és kategóriának válasszuk a 'Millwork' (megmunkált faipari termék).
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Pipáljuk be az 'Add to library' lehet?séget. Ekkor az új kerítés panel be fog kerülni a 'User library' mappába:

Nyissuk meg újra a kerítés beállításait, és a 'Newels/Balusters' fülön, a 'Newels/Post' blokkban állítsuk a vastagságot 156mm-re és a típust (formát)
'Squere'-re.

A 'Panels' szekcióban a típushoz válasszuk ki a most létrehozott 'Fence, horizontal panel' típust: A 'Materials' fülön a 'Fence, horizontal panel'-nek
állítsuk be a nekünk megfelel? anyag típust:

A 'Newel' sorba állítsuk be ugyan azt a vakolat típust, amit a kerítés falnál is használtunk.
Ezzel a kerítés elkészült:
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Vízszintes deszkázatú kertkapu

A kertkapu paneljét a kerítés panelekhez hasonlón le kell gyártani. Ehhez 'Polyline Solid' dobozokkal modellezzük le a kertkapu deszkáit a kerítés
deszkákhoz hasonlóan, majd a 'Multiple Copy' eszközzel sokszorosítjuk.

Jelöljük az összes kapu deszkát, és megint kattintsunk a 'Convert Selected to Symbol' eszközre az alsó menüben. Névnek adjuk a 'Gate, horizontal
panel' nevet és 'Symbol category'-nak állítsuk be a 'Door' (ajtó) lehet?séget.

Pipáljuk be, hogy 'Add to library' majd nyomjunk rá a 'OK' gombra. Ekkor a 'Gate, horizontal panel' is be fog kerülni a 'User catalog' alá.
A beálló helyére rajzolunk egy kerítés szakaszt a 'Straight Fence' eszközzel, úgy hogy ne érjen hozzá se a 'Terrain' falhoz, se a rajta lév? kerítéshez. A
kerítés részleteiben állítsuk be a kerítés póznák méretét és anyagát ugyanakkorára, mint a 'Terrain Wall' tetejére ültetett kerítés esetében tettük. Állítsuk
be a póznák magasságát a mellett lév? kerítés póznamagasságra.
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Az így megrajzolt kerítés szakaszba rakjunk egy kert kaput. A kapu beállításaiban, a 'General' fülön a 'Door type' mez?be állítsuk be a most létrehozott
'Gate, horizontal panel'-t, típusnak állítsuk be, hogy 'Slider' vagyis tolókapu.

. Állítsuk a kerítés magasságát olyan magasra mint a mellett
lév? kerítés póznák és a kerítés anyagát állítsuk be ugyan arra a faanyagra, amib?l a kerítés paneleket készítettük:

A kertkapu és a kerítés pózna közötti rést töltsük ki egy 'Polyline Solid'-al, aminek az anyagát állítsuk a kerítés vakolat anyagára. A 'Make Paralel' és
'Make Center' eszközökkel állítsuk be a szöget és rakjuk pont a kerítés középvonalába.

Ha a kaput tartó kerítés póznákat kisebbre méretezzük, akkor a kaput közelebb tudjuk vinni a'Terrain Wall' széléhez. Ekkor a létrehozott 'Polyline Solid'
magába fogja foglalni a kaput tartó kerítés póznákat.
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Acél I-gerenda + párnafák
A képen látható acél I-gerenda felett végig fut egy párnafa (nailing board) és a bejárati ajtónál alatta is van egy párnafa. Így készült:

Bármi nem? gerendát a Floor/ceiling framing tools'-ban a Floor/ceiling beam eszközzel csinálhatunk valamelyik plan view-ban.

A gerendát mindig az adott plafon magasságába fogja rakni. Alapértelmezetten fából lesz. Nyissuk meg a specifikációs dialógusát, itt be tudjuk állítani,
hogy a típusa 'Steel-I' legyen, valamint a szélességét és a magasságát.
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Azt is be tudjuk itt állítani, hogy milyen magasan legyen. Ezt akár 'Cross section' nézetekben is beállíthatjuk.

Ha egy olyan falra kigeneráljuk a framing-et amin keresztül megy a beam, automatikusan alá fogja támasztani a CA, és a beam pocket-eket is le fogja
gyártani:

A tetején és alján végigfutó párnafák (szögel? lécek) pont ugyan így készületek, azok is beam-ek csak fából vannak és más a méret?k és a
magasságuk:
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A fal küls? borítása ne lógjon lejjebb a button plate-nél
Mit szeretnénk

A fal küls? burkolata, tehát minden ami a main layer-en kívül van addig fog lelógni, amíg a falhoz tartozó szoba padló szerkezete tart.

Ha a 'Floor structure' 100 mm vastag, akkor a framing rá fog ülni erre a 100mm beton slab-re, viszont a CA a fal küls? burkolatát le fogja lógatni a
100mm vastag slab aljáig.

Ez azért van így, mert a CA abból indul ki, hogy fából lesz minden szint födémje, és ilyenkor nagyon helyesen a küls? szigetelésnek le kell lógnia a fa
födémet tartó beton falig.
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Megoldás ha csak alap van alatta

Azokban a szobákban, ami alatt 'Foundation wall'-van, vagyis olyan alap fal, ami nem szoba, vagyis nem alaksori helyiség, a megoldás nagyon
egyszer?.

A 'Floor structure'-t át kell rakni a szoba alatti alap által kijelölt helyiségbe. Az alap által kijelölt helyiség specifikációs dialógusában, a 'Structure' fülön az
alábbiakat kell bejelölni:

Absolute elevation/Floor: legyen 0, vagyis a padló szintje legyen az épület 0 magasságában, így a slab nem fog felfelé kilógni a 'steam wall'
felett.

• 

Room supplies for the room above.• 
Floor structure: legyen 100mm vastag beton• 

Ekkor a képen látathó beton a steam falak közé fog beülni. Azt nem tudtam elérni, hogy a falak fölött legyen rálógva a falakra, ahogy a valóságban lesz.
Ezt csak úgy lehet elérni, ha a padló struktúrát a fels? szoba adná, de akkor meg a fal burkolat lóg lentebb mint kéne, szóval e a kisebb
kompromisszum.

Az ilyen alap feletti szoba esetében a CA automatikusan át fogja állítani a padló beállításait, a 'Structure' fülön be fogja pipálni, hogy: Room supplied
by the foundation room below és ezáltal a Floor structure inaktívvá fog válni jelezve, hogy a padló szerkezete már nem ebb?l a szobából jön.
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Ett?l függetlenül a 'Floor finish'-t már itt kell definiálni, azt nem veszi figyelembe a CA a küls? szigetelés túllógásában.

Megoldás ha alaksori szoba van alatta

Ha az alagsorban van szoba is, akkor nem használhatjuk föl annak a padlóját a fels? szint padlójaként. Viszont mivel ez egy valódi szoba, ezért van
plafonja. A plafon legfels? rétegébe tegyünk be egy 100mm vastag beton réteget

A felette lév? szoba padlójában pedig a 'Floor structure'-t vegyük 0 vastagságúra:
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És íme a végeredmény:

Bejárat feletti ejtett plafon és kövezett bejárat
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Note
Nem kell mindent CA 'okos' objektumokból megcsinálni. Használjunk egyszer? dobozokat ha elakadunk, aztán majd a CAD részlet rajzon kipimplejük az
ábrát. Ezzel szenvedtem a legtöbbet, mert az egészet CA ceiling-el akartam megoldani. Az I-gerenda alsó burkolata végül simán egy 3D-s doboz!

A bejárati ajtó el?tti tér feletti plafont le kell valahogy burkolni, ráadásul a plafont le kell hozni az I-gerenda alá, ami ott fut keresztbe, és az I-gerendát
el?röl is le kell burkolni.

Padló definiálása

A bejárat el?tti kockát egy 'Room divider'-el leválasztottam, így egy külön helyiség keletkezett a beugróban, aminek már lehet padlója meg plafonja:

A 'room divider' létre fog hozni egy láthatatlan 'attic' falat, ez fogja el?röl lezárni a helyisgét:
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Az újonnan létrejött helyiségben a specifikációs dialógusban beállítom a 'Structure' fülön az alábbiakat:

Padló magassága: 0 (hogy egy szintben legyen a bels? padlóval)• 
Floor under this room• 
beállítom a rétegrendet a 'Floor finish'-re• 
100 mm -es betont rakok a 'Floor structure'-be• 

A plafon szerkezete nem érdekes, mert azt egy ceiling plan-el fogjuk definiálni.

Plafon definiálása

A plafonnak 3 fontos része van.
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El kell érjük, hogy a plafon rétegrendje ne menjen bele az ajtó feletti falba.1. 
A beugróba létre kell hozni egy olyan rétegrendet, amiben van szigetelés is2. 
Az I-gerendát alulról le kell burkolni.3. 

Els? lépésként létre kell hozni egy ceiling plane-t amivel az ajtó el?tti tér (beugró) feletti plafon rétegrendjét kialakítjuk. Erre a célra azért nem
használhatjuk a helyiség saját plafonját, mert az belelógni az ajtó feletti fal küls? szigetelésébe, mivel az mindig a fal 'main layer'-égi megy. Ha ennek a
helyiségnek a plafonját használnánk (bal oldal) akkor a plafon rétegrendje keresztezné az ajtó feletti fal rétegrendjét (jobb oldal)

Ezért hogy ezt elkerüljük, a képen látható helyiség plafonját 0 vastagságúra fogjuk venni, és elé berakunk egy 'ceiling plane'-t amiben meg fogjuk
csinálni a kívánt rétegrendet. Ez a ceiling plane az ajtó vonalától a gerenda vonaláig fog tartani. (

Note
A ceiling plane mindig felülírja azon a területen a helyiség alapértelmezett plafonját ahol azt kitakarja. A mi esetünkben ki fogja takarni az ajtótól a
gerendáig, ezért ezzel létrehozhatjuk a megfelel? rétegeket, és mivel az ajtó fölött nem takarja ki, ott az eredeti plafon lesz az érvényes, aminek 0 lesz a
vastagásga

Hozzuk létre az alábbi képen látható 'ceiling plane'-t, a gerendától pontosan 25 mm-re álljon meg, mivel a bels? oldalon a burkolat ilyen vastag lesz:
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Els? lépésben állítsuk be a magasságát. Alapértelmezetten a 'ceiling plane' mindig az alapértelmezett tet? d?lésszögével jön létre (mivel általában a
tet? bels? leburkolására való). Ezért állítsuk be 0 fokra a d?lést, majd 'lock'-oljuk a d?lésszöget, hogy be tudjuk állítani a kívánt magasságot. Mivel a
d?lésszög 0 fok, ezért minden magasság érték ugyan az lesz:

Majd a struktúra fülön állítsuk be a kívánt rétegrendet. Ehhez els?ként vegyük ki a pipát a 'use room ceiling finish' checkbox-ból, hogy egyedi plafon
rétegrendet alakíthassunk ki. Majd a 'Roof layers / Ceiling' szekcióban alakítsuk ki a kívánt rétegrendet. A magasságot ennek megfelel?en kell beállítani.
A magasság helyes meghatározásához használjunk 'Backclipped cross section' view'-t.

Töröljünk ki minden réteget az eredeti helyiség plafon rétegrendjéb?l:

Végül burkoljuk le alulról a gerendát egy 3D 'box' típusú elemmel.
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A magasság és mérete is állítható a specifikációs dialógusában:

Állítsuk a vastagságot 13mm-re, ez fogja a vakolatot szimbolizálni, és pozicionáljuk 20 mm-el a gerenda párnafája alá, hogy aláférjen a légrést biztosító
párnafa. Azt majd csak a cross-section view-ban rajzoljuk rá 'kézzel'

Warning
Nagyon nagy hiba volt, hogy 'Ceiling plane'-el akartam a gerenda alját leburkolni. Azonban a 'Ceiling plane' nem hagyhatja el a fal 'main layer'-ének a
küls? síkját, és mivel közel 20 cm küls? szigetelés van a falon, ezért a ceiling palne-el nem lehet a fal küls? szigetelése alá burkolatot tenni, hiába
próbáljuk meg kihúzni, mindi vissza fog ugrani a felette lév? fal main layer-nek a küls? síkjáig

Utolsó lépésként állítsuk be a burkoló 'box' anyagának a 'Sand

I-gerenda burkolása fallal

Most hogy a gerenda alsó része már le van burkolva, nincs más dolgunk, mint hogy elölr?l és hátúról is leburkoljuk.
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Ehhez felhasználhatnánk a 'room divider' által létrehozott láthatatlan attic falat, vagy lehúzhatjuk a fels? falat is, ezt fogjuk alkalmazni.

Note
Azért tudjuk lehúzni a fels? falat az I-gerendára, mert az I-gerenda is 150mm széles és pont egysíkban van a fels? fal 'main layer'-ével. Mivel az
I-gerenda framing-nek min?sül, ézért a CA nem fog vázat generálni a lehzútt falhoz, csak a szigetelést fogja rárakni az I-gerendára

Jelöljük ki a bejárat felett falat, majd a nyíllal bejelölt helyeken 'Break' eszközzel tegyünk bele két töréspontot:

Ezután már le tudjuk húzni a kivágott falrészt egészen a korábban létrehozott 'box' tetejéig:

A bejárat feletti fal típusa két réteg gipszkartont definiál a main layer bels? oldalán, így ugyan ez kerül az I-gerende bals? oldalára is.

Ha nagyon pontosak akarunk lenni, akkor a fels? falon a lelógó ficakra definiálunk külön egy 'Pony wall' típust, aminek a bels? oldalán nem gipszkarton
lesz, hanem egy 'backerboard'.

Jelöljük ki a fels? falat, majd a specifikációs dialógusában, a 'Wall type' fülön pipáljuk be hogy 'Pony wall', majd definiáljunk rá egy egyedig fal típust, ami
a bels? oldalon backerboard-ot tartalmaz a gipszkaroton helyett, valamint a bels? oldalon is van 'house wrap'. A legbels? rétege pedig 'Sand finish'
vagyis vakolat.
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Bejárat el?tti lépcs?

Itt az a nehézség, hogy csempézett legyen a felület csak 2 képcs?fokkal, valamint hogy hozzáérjen a falhoz.

Deck létrehozása

A felület egy deck, amit a 'Room divider' ( ) eszközzel hoztam létre.

Fontos, hogy a fal és a deck között legyen legalább 50 mm távolság (piros nyilak jelzik), különben az ablakok körül meg fog zavarodni a CA és az ablak
keret körül ki fog lógni a szigetelés:
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Note
A slap ne rontja el az ablakot akkor sem ha hozzá ér a falhoz. Azért nem csinálhattuk az egész placcot slab-b?l, mert a lépcs? nem tud slab-hez
kapcsolódni csak helyiség típusú objektumhoz.

A deck-ben állítsuk be, a 'General' szekcióban, hogy a helyiség típusa 'Undefined' és hogy 'Exclude from total living area calculation'

A 'Structure' fülön állítsuk be, hogy 0 legyen a padló magassága, a struktúra legyen 100 mm beton, és a 'Floor' finish legyen a képen látható rétegrend.
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A deck és a fal közötti kis rést egy 'Slab' csíkkal tudjuk betömi. A Slab eszközzel rajzoljunk egy csíkot a fal és a deck közé:

A slab specifikációs dialógusában állítsuk be a slab magasságát, hogy ne lógjon ki, és a 'Materials' fülön állítsuk be ugyan azt a csempét, amivel a
deck-t burkoltuk:

Lépcs? létrehozása

A lépcs?k megrajzolása el?tt a lépcs? köré együnk 'Terrain/Elevation region'-t, amivel be tudjuk állítani el?re azt a szintet, ahonnan a lépcs?t szeretnénk
indítani:
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Majd a lécs?t a kert szintjér?l húzzuk a deck oldaláig mind el?l mint oldalt. Fontos, hogy mindig az emeledés irányába húzzuk a lépcs?t, ezt az 'Up'
felirat is jelzi:
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Majd nyissuk meg mind két lécs? specifikációs dialógusát, és nyomjunk rá a 'General' fülön az 'Optimal high' gombra:

Majd addig kell a két lépcs?t egymás átfedésérben húzogatni, amíg a CA magától nem alakítja ki a sarkot:

Most már csak át kell állítani a lépcs? minden porcikáját, hogy úgy nézzen ki mint fent:
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Lépcs?ház

Az alaksor és a földszint közötti lépcs?ház elég trükkös volt, ugyanis a korlátot alkotó fal, illetve a fürd?szoba és a lépcs?ház közös fala mindig lement
az alaksorba, nem ért véget az els? szint padlóján. Els? lépésként rajzoljuk be az összes lépcs?t, és ne aggódjunk még a plafon nyílásokon.

Majd menjünk az alaksorba, és jelöljük azt a lépcs?t, ami felhoz a földszintre, ami nekimegy a földszint plafonjának:
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Ekkor az alsó menüben meg fog jelenni az 'Auto stairwell' funkció:

Kattintsunk rá. Ekkor a lépcs? default beállításokban meghatározott headroom-al ki fogja vágni a plafont, és létre fogja hozni a képen látható L alakú
kivágást:

Láthatjuk, hogy az L alakú kivágásnak a típusa 'Open below', vagyis nincs padló. Ezt manuálisan is létrehozhattuk volna, az 'Auto stairwell' funkció ezt
azonban megcsinálta nekünk:
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Egy 'Room divider'-el válasszuk le a nappaliról, és az 'Auto stairwell' alatt létrehozott falat cseréljük ki igazi falra:

Erre azért van szükség, hogy másféle padló struktúrát tudjunk neki adni mint a nappalinak van.

A falak lefutnak az alaksorba
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Orvosolni kell, hogy a képen látható három fal ne menjen le egészen a pincébe, csak a földszint padlójáig. Ehhez csináljunk két 'Cross section'-t, majd
fogjuk meg a falak alját, és húzzuk ?ket a kívánt magasságba a földszint padló szintjéig:

Ezt a megfelel? szögb?l mind a három falra el kell játaszni.

Ferde fal a lécs? tetején

A CA tudja követni a fallal a lécs?t a lépcs? széleken, de nem a két lépcs? között. Ezért a háromszöget egy 3D dobozból raktam a tetejére, amit
bevontam a fal anyagával.

CAD rajzok
Anchor bolts layout

TODO: az 1. szint floor plan-b?l készíteni kell egy CAD view-t és azon bejelölni, hogy hova fog kerülni.

CAD detail drawing

TODO: valamelyik cross section-b?l kell csinálni egy CAD veiw-t és mindent letörölni ami nem kell. Majd szépen kiszínezni és felcímkézni. Ezt is úgy
csináltam:
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Break line

TODO: sajnos itt nincs még beépített funkció erre, kézzel kell megcsinálni így:
https://www.homedesignersoftware.com/support/article/KB-00439/creating-a-cross-section-detail.html

Floor plan
A layout legfontosabb rajza a floor plan:
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Ehhez a legjobb, ha a plan-en valamelyik Floor plan view-ból indulunk ki:

1. Auto Exterior Dimensions: itt az a baj, hogy alapértelmezetten a main layer-t?l fogja megrajzolni, nem az insulation küls? részér?l. Ezt az adott falon
belül, a Wall Type specifikációjában tudjuk átállítani:
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Itt a Wall settings szekcióban a "Dimension to exterior layer" legördül?ben az adott fal összes rétege fel van sorolva. Itt kiválaszthatjuk, hogy melyikt?l
rajzolja be a küls? dimenziót. Itt válasszuk a legküls? réteget.

2. Fal mintájában azt szeretnénk, ha a main layer szürke lenne, és a küls? szigetelés meg sraffozott. Ezt is a fal típus beállításaiban tudjuk átállítani, az
adott layer melletti "Fill" cellára kattintva:
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A szigeteléshez állítsuk be a sraffozást, még a f? réteghez a szürke színt.

3. Az Elevation callout-ok megjelenítése:

Be kell kapcsolni a Camera réteget.

Az "Exterior Dimensions" ( ) a bels? szobák méretét nem fogja berajzolni, ezt manuálisan mi hozzáadhatjuk.

Interior dimensions

Ez minden bels? falat és tárgyat bekottáz.
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Troubleshooting
A fal framing belelóg az I-joist-ba

Ha a fal belelóg az I-joist-okban, de csak egy fal ilyen, a szoba többi fala nem ilyen, akkor a fal beállításaival van a baj.

Láthatjuk, hogy a képen látható fal a következ? szint padlójáig megy. Több mint valószín?, hogy a Wall specification / Structure szekcióban van a hiba
a Platform intersection dobozban:

Vagy a Balloon through... vagy a Hang floor... be van kapcsolva. Ha ez sem segít, akkor külön kapcsoljuk be a Stop at ... lehet?ségeket, hogy biztos
hogy padlótól plafonig menjen.

A fal nem éri el a plafont

Ez az el?bbi ellentettje. A fal nem éri el a plafont és az I-joist-ok nem ülnek rá.

Ezen nem segít a room specification-ben a magassági beállítások módosítása, azok feltehet?leg jók, azért került jó helyre a ceiling. Viszont ezt egy
vagy több fal feltehet?leg azért nem követte le, mert korábban kézzel módosítottunk a magasságukon, ezzel kikapcsolva rajtuk az automatizmust. A
legjobb amit tehetünk hogy egy elevation vagy section view-ban beállítjuk kézzel a méretet.

Note
Figyeljünk rá, hogy elevation view-ban a floor vastagságát is beleszámolja. Tehát ha nekünk a framing magasság a mérvadó, a padló vastagságát
hozzá kell az elevation view-ban adni

Az alábbi képen látható, hogy Elevation view-ban rákattintok az adott fal szakaszra, majd a függ?leges méretez?re, ekkor megjelenik a Dimension, ahol
már át tudom írni.
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A tet? alatti eresz nem zárt doboz

Ha zárt dobozos ereszt szeretnénk, de a doboz még sincs zárva, hanem követi a tet? hajlásszögét:

Ennek két oka lehet.

1. A tet? alatti szobában a room specification / Structure -> Ceiling szekcióban be van pipálva, hogy Use soffit surface for ceiling. Lásd Ceiling plain
fejezet.

Vegyük ki a pipát. Ez azt jelentené, hogy a ceiling plain (ami a plafon formáját határozza meg) követi a tet? alakját, vagyis sátor tet? esetén a plafon is
csúcsos lenne.

Note
Az alábbi hibaüzenetet kaphatjuk ha 'truss'-t akarunk rakni egy olyan tet?be, ahol a plafon követi a tet? alakját: Roof and ceiling planes cannot be
found or they are too close together, so cannot make truss

2. A tet?nek a beállításaiban (roof specifications) Options fülén az Eaves szekcióban nincs bepipálva a Boxed Eves:

Plafon egy csíkban túl lóg

https://chieftalk.chiefarchitect.com/topic/30381-celling-doesnt-follow-the-deck/?tab=comments#comment-240420

Ennek a túllógásnak az oka mindig a helyiséget határoló falak találkozásának a pontatlansága, hibája. Jelen esetben az volt a hiba, hogy a két deck kert
fel?li oldala egy darab 'Room divider'-el volt megrajzolva. Vagyis ez a fal nem ért véget az erkély alatt, hanem ment tovább a deck másik széle felé.
Miután két külön deck-re szétválasztottam a két szobát + egy 'Room divider' beiktatásával, a hiba elmúlt.
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Terasz feletti plafon hiányzik

Itt valójában nem hiányzik a burkolat, csak a hiányzó részen túl magasan van, ezért nem látszik.

Itt meg túl alacsonyan van a burkolat, mert a felett lév? helyiségnek túl alacsony a plafonja.

Ennek az az oka, hogy a fels? szinten két helyiség van, amiknek eltér? a magassága. A fels? szinten lév? ez esetben erkély és az erélyt körülvev? L
alakú csíknak kell a plafon magasságát úgy beállítani, hogy az alatta lév? plafon minden darabja egy magasságban legyen.

Truss tüskével végz?dik

Ha a rafter-nek a képen látható nyúlvány van, akkor ezt elég trükkös leszerkeszteni róla.
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Nyissuk meg a rafter-t szerkesztésre az 'Open Truss detail' ( ) gombbal.

Láthatjuk, hogy ha kijelöljük a Truss kontúrját, akkor az megfelel? helyen van, tehát a kontúr mozgatásával nem lehet orvosolni a problémát. (A kontúrt
úgy lehet kijelölni, hogy a Truss szélére kattintunk. Ha egy web elem jelöl?dne ki, akkor a TAB ismételt nyomogatásával el?bb utóbb ki kell hogy jelöljük
a körvonalat)

Jelöljük ki az alsó lécet, amin a túlnyúlás van, és tegyünk egy break -et ( ) a még egyenes részre.

Ekkor a vége külön darabot fog alkotni, amit már külön le tudunk törölni:
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Ezután az alsó lécet már átméretezhetjük úgy hogy pont jó helyen érjen véget a léc végén lév? kis négyzet húzásával.

Ne feledjük el a truss beállításaiban bekapcsolni a 'Lock truss envelop...' beállítást, hogy nehogy újragenerálja a truss-t, és kezdeni kelljen elölr?l:

Nem jelennek meg a dimension vonalak szerkesztés közben
Ha valamelyik elevation vagy CAD view-ban a vonalakon lév? kis négyzetekre kattintva nem jelennek meg a segéd dimension vonalak és számok:

Ennek az lehet az oka, hogy a segéd dimenziós vonalak is a 'CAD, Default' rétegen vannak megjelenítve, és ha ez a réteg el van rejtve, akkor a segéd
vonalak sem fognak megjelenni. Ha a CAD,Default réteg be van kapcsolva, akkor a fels? ábra így néz ki:
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